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1.1 The SCIOPTA System

1.1.1 SCIOPTA System

SCIOPTA System is the name for a SCIOPTA framework which includes design objects such as SCIOPTA mod-
ules, processes, messages and message pools. SCIOPTA is designed on a message based architecture allowing di-
rect message passing between processes. Messages are mainly used for interprocess communication and
synchronization. SCIOPTA messages are stored and maintained in memory pools. The kernel memory pool man-
ager is designed for high performance and memory fragmentation is avoided. Processes can be grouped in SCI-
OPTA modules, which allows you to design a very modular system. Modules can be static or created and killed
during run-time as a whole. SCIOPTA modules can be used to encapsulate whole system blocks (such as a com-
munication stack) and protect them from other modules in the system.

1.1.2 SCIOPTA Real-Time Kernels

SCIOPTA System Framework together with specific SCIOPTA scheduler results in very high performance real-
time operating systems for many CPU architectures. The kernels and scheduler are written 100% in assembler.
SCIOPTA is the fastest real-time operating system on the market. The SCIOPTA architecture is specifically de-
signed to provide excellent real-time performance and small size. Internal data structures, memory management,
interprocess communication and time management are highly optimized. SCIOPTA Real-Time kernels will also
run on small single-chip devices without MMU.

1.1.3 SCIOPTA Simulator and API for Windows

The SCIOPTA System is available on top of Windows. SCSIM is a SCIOPTA simulator including SCIOPTA
scheduling together with the Windows scheduler. This allows realistic system behaviour in a simulated environ-
ment.

SCAPI is a SCIOPTA API allowing message passing in a windows system. SCAPI is mainly used to design dis-
tributed systems together with CONNECTOR processes. Scheduling in SCAPI is done by the underlying operating
system.

1.2 About This Manual

The purpose of this SCIOPTA - Real-Time Kernel, User’s Manual is to give all needed information how to use
SCIOPTA Real-Time Kernel in an embedded project. Also the SCIOPTA SCSIM Simulator product is covered
in this manual.

After a description of the installation procedure, detailed information about the technologies and methods used in
the SCIOPTA Kernel are given. Descriptions of Getting Started examples will allow a fast and smooth introduction
into SCIOPTA. Furthermore you will find useful information about system design and configuration. Also target
specific information such as an overview of the system building procedures and a description of the board support
packages (BSP) can be found in the manual.

Please consult also the SCIOPTA - Kernel, Reference Manual which contains a complete description of all sys-
tem calls and error messages.

SCIOPTA - Real-Time Kernel
1-2 Manual Version 4.1 User’s Manual



1 SCIOPTA System

-
SCIOPTA

—-

1.3 Supported Processors

1.3.1 Architectures

SCIOPTA - supports the following processor architectures. Architectures are referenced in this document as

<arch>):

e am

e ppc (power pc)
« coldfire

e win32 (SCIOPTA SCSIM Simulator and SCAPI SCIOPTA API, Windows Host)

1.3.2 CPU Families

SCIOPTA - Kernel supports the following CPU families. CPU families are referenced in this document as <cpu>):

Architecture CPU Family Description
<arch> <cpu>
arm at9lsam7 Atmel AT91SAM7 (ARM7)
Atmel AT91SAMTS, AT91SAMTSE, ATILSAMTX, AT91SAM7A3 and
all other derivatives of the Atmel AT91SAM7 family.
at91sam9 Atmel AT91SAM9 (ARM9)
Atmel AT91SAM9260, AT91SAM9I261, AT91SAMI263 and all other de-
rivatives of the Atmel AT91SAM9 family.
Ipc21xx NXP LPC21xx/22xx (ARMT7)

Ipc24xx_lIpc23xx

str7

str9

stm32

NXP LPC21xx and NXP LPC22xx and all other derivatives of the NXP
LPC21xx/22xx family.

NXP LPC23xx/24xx (ARMT7)
NXP LPC21xx and NXP LPC22xx and all other derivatives of the NXP
LPC21xx/22xx family.

STMicroelectronics STR710 (ARM7)
STMicroelectronics STR71x and all other derivatives of the STMicroelec-
tronics STR710 family.

STMiicroelectronics STR910 (ARM9)
STMicroelectronics STR91x and all other derivatives of the STMicroelec-
tronics STR910 family.

STMuicroelectronics STM32 (ARM Cortex M3)
All derivatives of the STMicroelectronics STM32 family.

SCIOPTA - Real-Time Kernel
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Architecture CPU Family Description
<arch> <cpu>
arm imx27 Freescale i. MX2x (ARM9)

Freescale i.MX21, i.MX23, i.MX25, i.MX27 and all other derivatives of
the Freescale i.MX2x family.

imx35 Freescale i.MX3x (ARM1136JF)
Freescale i.MX31, i.MX35, i.MX37 and all other derivatives of the Frees-
cale i.MX3x family.

stellaris Texas Instrument Stellaris (ARM Cortex M3)

All derivatives of the Texas Instrument Stellaris family.
tms570 Texas Instrument TMS570 (ARM Cortex R4F)

All derivatives of the Texas Instrument TMS570 family.
stm32 STMuicroelectronics STM32 (ARM Cortex M3)

All derivatives of the STMicroelectronics STM32 family.
pxa270 Marvell PXA270 (XScale)

All derivatives of the Marvell PXA270 family.
pxa320 Marvell PXA320 (XScale)

All derivatives of the Marvell PXA320 family.

ppc MpPX5xX Freescale PowerPC MPC500
MPC53x, MPC55x, MPC56x and all other derivatives of the Freescale
MPC500 family.

mpc5500 Freescale PowerPC MPC55xx
MPC5516, MPC5534, MPC5554, MPC5567 and all other derivatives of
the Freescale MPC55xx family.

mpc8xx Freescale PowerPC PowerQUICC |
MPC823, MPC850, MPC852T, MPC855T, MPC857, MPC859, MPC860,
MPC862, MPC866 and all other derivatives of the Freescale MPC8xx fam-
ily.

mpc82xx Freescale PowerPC PowerQUICC Il

MPC8250, MPC8255, MPC8260, MPC8264, MPC8265, MPC8266 and all
other derivatives of the Freescale MPC82xx family.

mMpPCc83xx Freescale PowerPC PowerQUICC Il Pro
MPC8313, MPC8314, MPC8315 and all other derivatives of the Freescale
MPC83xx family.

mMpPC52xx Freescale PowerPC MPC5200
MobileGT MPC5200 and all other derivatives of the Freescale MPC52xx
and 51xx family.

ppcaxx AMCC PowerPC 4xx
PowerPC 405, 440, 460 and all other derivatives of the AMCC PowerPC
4xx family.
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Architecture CPU Family
<arch> <cpu>

Description

coldfire mcf521x

mcf523x

mcf525x

mcf532x

mcf548x

mcf5223

mcf5272

mcf5282

mcf54455

win32

Freescale Coldfire MCF521x (V2)
MCF5213 and all other derivatives of the Freescale ColdFire MCF521x
family.

Freescale Coldfire MCF523x (V2)
MCF5235 and all other derivatives of the Freescale ColdFire MCF523x
family.

Freescale Coldfire MCF525x (V2)
MCF5253 and all other derivatives of the Freescale ColdFire MCF525x
family.

Freescale Coldfire MCF532x (V3)
MCF5329 and all other derivatives of the Freescale ColdFire MCF532x
family.

Freescale Coldfire MCF548x (V4e)
MCF5485 and all other derivatives of the Freescale ColdFire MCF548x
family.

Freescale Coldfire MCF5223x (V2)
MCF52233 and all other derivatives of the Freescale ColdFire MCF5223x
family.

Freescale Coldfire MCF527x (V2)
MCF5272 and all other derivatives of the Freescale ColdFire MCF527x
family.

Freescale Coldfire MCF528x (V2)
MCF5282 and all other derivatives of the Freescale ColdFire MCF528x
family.

Freescale Coldfire MCF54455x (V4)
MCF54455 and all other derivatives of the Freescale ColdFire MCF54455x
family.

For Windows based PCs and workstations

SCIOPTA - Real-Time Kernel
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2 Installation

2.1 Introduction

This chapter describes how to install SCIOPTA. Topics such as system requirements, installation procedure and
uninstallation are covered herein.

2.2 The SCIOPTA Delivery

Before you start the installation please check the SCIOPTA delivery. The following items should be included:

« CD-ROM containing SCIOPTA for your CPU family.
 Installation password.
e Manuals of your installed products:

e SCIOPTA - Kernel, User’s Manual (this document).

¢ SCIOPTA - Kernel, Reference Manual.

* SCIOPTA - Device Driver, User’s and Reference Manual.

* SCIOPTA - DRUID, User’s and Reference Manual.

e SCIOPTA - IPS Internet Protocols, User’s and Reference Manual.

e SCIOPTA - IPS Internet Protocols Applications, User’s and Reference Manual.
e SCIOPTA - FAT File System, User’s and Reference Manual.

e SCIOPTA - FLASH Safe File System, User’s and Reference Manual.

* SCIOPTA - USB Device, User’s and Reference Manual.

e SCIOPTA - USB Host, User’s and Reference Manual.

* SCIOPTA - PEG+, User’s and Reference Manual.

e SCIOPTA - SMMS Memory Protection, User’s and Reference Manual.
* SCIOPTA - CONNECTOR, User’s and Reference Manual.

2.3 System Requirements

2.3.1 Windows

Personal Computer or Workstation with:

e Intel® Pentium® processor

* Microsoft® Windows XP Professional
e 64 MB of RAM

e 20 MB of available hard disk space

2.3.2 Linux

e Linux® 2.2 kernel on X86 computer
* 64 MB of RAM
» 20 MB of available hard disk space

SCIOPTA - Real-Time Kernel
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2.4 Installation Procedure Windows Hosts

24.1 Main Installation Window

SCIOPTA is using a sophisticated software product delivery system which allows to supply you with a customized
and customer specific delivery. You will find a customer number and the name of the licensee on the CD and the
installation window.

Insert the CD-ROM into an available CD drive. This should auto-start the SCIOPTA installation. If auto-start does
not execute you can manually start the installation by double clicking the file setup.exe on the CD.

The following main installation window will appear on your screen:

SCIOPTA

x|

| This installation is password pratected. Please enter
i the inztallation pazsword into the field below.

Version 1.9.6.9 Illjassword:

Click the OF. button to continue.
Click Cancel to abort the inztallation.

el _|

Figure 2-1: Main Installation Window

To install SCIOPTA you must enter a password which was delivered by email or on paper.

The program will guide you through the installation process.

SCIOPTA - Real-Time Kernel
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2.4.2 Product Versions

Each SCIOPTA product release is identified by a version number consisting of a four field compound number of
the format:

“XY.ZF”

The first digit, X, is used for the major release number which will identify a major increase in the product func-
tionality and involves usually a total rewrite or redesigning of the product including changes in the SCIOPTA ker-
nel API. This number starts at 1.

The second digit, Y, is used for a release number which is used to identify important enhancements. This number
is incriminated to indicate new functionality in the product and may include changes in function calls without mod-
ifications in the SCIOPTA kernel API. This number starts at 0.

The third digit, Z., stands for feature release number. The feature release number is iterated to identify when func-
tionality have been increased and new files, board support packages or CPUs have been added. This requires also
changes in the documentation. This number starts at 0.

The fourth digit, F, is called the build number and changes if modifications on the examples or board support pack-
ages have been made. This number starts at 0.

2.4.3 Installation Location

The SCIOPTA products will be installed at the following location:

<Destination Folder>\sciopta\<version>\ (in this manual also referred as <install_folder>\sciopta\<version>)
The expression <version> stands for the SCIOPTA four digit version number (e.g. 1.9.6.9)

If you are not modifying the Destination Folder SCIOPTA will be installed at: c:\sciopta\<version>\

Please make sure that all SCIOPTA products of one version are installed in the same destination folder.

2.4.4 Release Notes

This SCIOPTA Kernel delivery for your CPU family includes a text file named RN_<cpu_family>_ KRN.txt which
contains a description of the changes of the actual version compared to the last delivered version. It allows you to
decide if you want to install and use the new version.

You will also find a file revisions.txt which contains a list of all installed files including the following information
for each file: file name, document number, file version and file description.

File location: <installation_folder>\sciopta\<version>\doc\

2.45 Short Cut

The program will install the SCONF short-cut (to run the SCIOPTA configuration program sconf.exe) in the folder
Sciopta under the Windows Programs Menu.

If you are also installing the DRUID System Debugger the druid short-cut (to run druid.exe) and the druid server
short-cut (to run druids.exe) will be installed in the folder Sciopta under the Windows Programs Menu and on the
desktop.

SCIOPTA - Real-Time Kernel
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246 SCIOPTA_HOME Environment Variable

The SCIOPTA system building process needs the SCIOPTA_HOME environment variable to be defined.

Please define the SCIOPTA_HOME environment variable and set it to the following value:
<install_folder>\sciopta\<version>

The expression <version> stands for the SCIOPTA four digit version number.

2.4.7  Setting SCIOPTA Path Environment Variable

If you are using makefiles to build your system, the SCIOPTA delivery includes the GNU Make utility. The fol-
lowing file are installed in the SCIOPTA bin\win32 directory:

e gnu-make.exe

* rm.exe
* rm.exe

e libiconv2.dll
e libintl3.dll

Please include
<install_folder>\sciopta\<version>\bin\win32

in your path environment variable.

2.4.8 Uninstalling SCIOPTA

Each SCIOPTA product is listed separately on the “currently installed programs” list in the “Add or Remove Pro-
grams” window of the Windows® “Control Panel”.

For each SCIOPTA product use the following procedure:

From the Windows start menu select settings -> control panel -> add/remove programs.
Choose the SCIOPTA product which you want to remove from the list of programs.

Click on the Change/Remove button.

1

2

3

4. Select the Automatic button and click Next>.

5. Click on the Finish button in the next windows.
6

Windows will now automatically uninstall the selected SCIOPTA product.

Please Note:

There might be (empty) directories which are not removed from the system. If you want you can remove it manu-
ally.

SCIOPTA - Real-Time Kernel
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2.4.9 GNU Tool Chain Installation

SCIOPTA for the ARM, PowerPC and ColdFire architectures is supporting the GNU Tool Chain. The Sourcery
G++ Lite Edition from CodeSourcery is directly supported. The Lite Edition contains only command-line tools and
is available at no cost. A ready to install version is available from SCIOPTA.

The Sourcery G++ Lite Edition GNU Tool Chain Package for SCIOPTA delivery consists of:
¢ GNU C & C++ Compilers for the specific CPU family

*  GNU Assembler and Linker

¢ GNU C & C++ Runtime Libraries

Run the compiler installation file which can be found on the SCIOPTA CD.

The installer does just unpack the compiler into your selected folder. No settings into Windows Registry will be
done. Enter a suitable folder into the “Extract to:” line. You can also use the browse button.

7-Zip self-extracting archive |

Extract to:

IE:\opt\gcc I:I
Entract C% Cancel |

The installer asks for password. Please enter “sciopta”.

Enter password x|

Enter pazzword:

Isciopta

¥ Show paszword

oK IE I Cancel |

The compiler structure will be installed in a separate folder under your above selected unpacking folder. You can
also copy the compiler structure at any suitable place.

Define the compiler “bin” directory for compiler call in your project IDE and/or include this directory in
the path environment variable.

SCIOPTA - Real-Time Kernel
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2.4.10 Eclipse IDE for C/C++ Developers.

The Eclipse IDE for C/C++ Developers project provides a fully functional C and C++ Integrated Development
Environment (IDE).

Please consult http://www.eclipse.org/ for more information about Eclipse. You can download Eclipse IDE for C/
C++ Developers from the download page of this site.

Please consult http://www.eclipse.org/cdt for more information about Eclipse CDT (C/C++ Development Tools)
project.

For all delivered SCIOPTA examples for the ARM, PowerPC and ColdFire architectures there are Makefiles in-
cluded. Eclipse is easy to configure for working with external makefiles. Please consult chapter 3 “Getting Started”
on page 3-1 for a detailed description how to setup Eclipse to build SCIOPTA systems.

The Eclipse IDE requires that a Java Run-Time Environment (JRE) be installed on your machine to run. Please
consult the Eclipse Web Site to check if your JRE supports your Eclipse environment. JRE can be downloaded
from the SUN or IBM Web Sites.

2.4.11 SCIOPTA SCSIM Simulator (win32) DLL

To run the SCIOPTA SCSIM Simulator in the Microsoft® Visual C++ development environments the SCIOPTA
Kernel Simulator DLL (scwin32.dll) must be accessible. A suitable way would be to append the path where the
DLL is located to the PATH environment variable. Another but less comfortable possibility is to copy the SCI-
OPTA Kernel Simulator DLL in the directory where your project executable file resides.

The DLL for the Microsoft® Visual C++ 2005 Version 8.0 environment can be found at:
File location: <install_folder>\sciopta\<version>\lib\scsim\win32\vs80\

SCIOPTA - Real-Time Kernel
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3 Getting Started

3.1 Introduction

These is a small tutorial example which gives you a good introduction into typical SCIOPTA systems and products.
It would be a good starting point for more complex applications and your real projects.

3.2 Example Description

hello STRING_MSG_ID display

prio = 16 prio = 17
ACK_MSG_ID

Figure 3-1: Process-Message Diagram of a Simple Hello World Example

Process hello sends four messages (STRING_MSG_ID) containing a character string to process display. For each
transmitted message, process hello waits for an acknowledge message (ACK_MSG _ID) from process display be-
fore the next string message is sent.

After all four messages have been sent process hello sleeps for a while and restarts the whole cycle again for ever.
Each message is received, displayed and freed by process display. Process display sends back an acknowledge
message (ACK_MSG_ID) for every received message.

SCIOPTA - Real-Time Kernel
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3.3 Getting Started Eclipse and GNU GCC

This is a getting started project including a step-by-step tutorial for the SCIOPTA Real-Time Kernels
(<arch>=arm, <arch>=ppc and <arch>=coldfire).

3.3.1 Equipment

For architectures ARM, PowerPC and ColdFire the following equipment is used to run this getting started example:

» Microsoft® Windows Personal Computer or Workstation.
» Compiler package:
For ARM CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ARM.
Architecture (arch): arm

For PowerPC  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for Power PC.
Acrchitecture (arch): ppc

For ColdFire  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ColdFire.
Acrchitecture (arch): coldfire

These packages can be found on the SCIOPTA CD.

» A debugger/emulator for the CPU on your target board which supports GNU GCC such as the iSYSTEM wi-
nIDEA Emulator/Debugger or the Lauterbach TRACE32 debugger.

e Target board which is supported by SCIOPTA examples. For each supported board there is a directory in the
example folder: <install_folder>\sciopta\<version>\exp\krn\<arch>\hello\.

» SCIOPTA - Real-Time Kernel for your selected architecture.

» Eclipse IDE for C/C++ Developers. You can download Eclipse from here http://www.eclipse.org/.

* In order to run the Eclipse Platform you also need the Sun Java 2 SDK, Standard Edition for Microsoft Win-
dows.

» This getting started example is sending some specific example messages to a selected UART of the board. To
display these messages on your host PC you can optionally connect a serial line from a COM port of your host
PC to an UART port of your selected target board. The selected UART port can be found in chapter 14 “Board
Support Packages” on page 14-1 where the Log Port for each board is given. If you want to change the port
you may modify the files system.c, simple_uart.c, simple_uart.h and config.h.

3.3.2  Step-By-Step Tutorial

This is a step-by-step tutorial for the SCIOPTA Real-Time Kernels (<arch>=arm, <arch>=ppc and <arch>=cold-
fire)

1. Check that the environment variable SCIOPTA_HOME is defined as described in chapter 2.4.6
“SCIOPTA_HOME Environment Variable” on page 2-4.

2. Besure that the GNU GCC compiler bin directory is included in the PATH environment variable as described
in chapter 2.4.9 “GNU Tool Chain Installation” on page 2-5.

3. Be sure that the SCIOPTA \win32\bin directory is included in the PATH environment variable as described
in chapter 2.4.7 “Setting SCIOPTA Path Environment Variable” on page 2-4.

4. Create a project folder to hold all project files (e.g. d:\myprojects\sciopta) if you have not already done it for
other getting-started projects.

SCIOPTA - Real-Time Kernel
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Launch Eclipse. The Workspace Launcher window opens.
Select your created project folder (e.g. c:\myproject\sciopta) as your workspace (by using the Browse button).
Click the OK button. The workbench windows opens.

Close the “Welcome” window.

© ©® N o v

Deselect “Build Automatically” in the Project menu.
10. Open the New Project window (menu: File -> New -> C Project). We will create Makefile project.
11. Click the Finish button. You will see the krn_hello project folder in the Project Explorer window.
12. The next steps we will executed outside Eclipse.
13. Copy the script copy_files.bat from the example directory of your selected target board:
<install_folder>\sciopta\<version>\exp\krn\<arch>\hello\<board>\

to your project folder.

14. Open a command window (windows cmd.exe) and go to your project folder.

15. Type copy_files to execute the copy_files.bat batch file. All needed project files will be copied from the de-
livery to your project folder.

16. Close the command window and return to Eclipse.

17. Swap back to the Eclipse workbench. Make sure that the kernel hello project (krn_hello) is highlighted.
18. Type the F5 key (or menu: File > Refresh) to refresh the project.

19. Expand the project by clicking on the [+] button and make sure that the krn_hello project is highlighted.
20. Now you can see all files in the Eclipse Navigator window.

21. Get the board number (<board_number>) for the makefile. This number (BOARD_SEL) can be found in
chapter 14 “Board Support Packages” on page 14-1 where it is given for each board.

22. Click on the krn_hello project in the Project Explorer window to make sure that the kernel hello project
(krn_hello) is highlighted.

23. Open the Properties window (menu: File -> Properties or Alt+Enter button).
24. Click on “C/C++ Build.

25. Deselect “Use default build command” in the Builder Settings Tab. Now you can enter a customized Build
command.

26. Enter the following Build command: gnu-make BOARD_SEL=<board_number> V=1

Enter the retrieved board number (<board_number>) as option of the make call.
For example: gnu-make BOARD_SEL=5 V=1 will build the project for board number 5.

27. Click the OK button.
28. Activate the Console window at the bottom of the Eclipse workbench to see the project building output.

29. Be sure that the project (krn_hello) is high-lighted and build the project (menu: Project > Build Project or
Build button).

30. The executable (sciopta.elf) will be created in the debug folder of the project.

SCIOPTA - Real-Time Kernel
User’'s Manual Manual Version 4.1 3-3



SCIOPTA

31.
32.
33.

34.
35.

¢

3 Getting Started

¢

Launch your source-level emulator/debugger and load the resulting sciopta.elf.

If you have connected a serial line from the COM port of your host PC to the UART of your target board, open
a terminal window on your PC and connect it to your selected PC COM port. Parameters are 115200Bd, 8 Bit,
no parity, 1 stop bit, no flow-control.

For some emulators/debuggers specific project and board initialization files can be found in the created project
folder or in other example directories.

Now you can start the system and check the log messages on your host terminal window.
You can also set breakpoints anywhere in the example system and watch the behaviour.

3.3.3 Please Note

Study carefully the makefile to get a good understanding of the whole build process and the needed files in a
specific SCIOPTA project.

The makefile calls the SCIOPTA configuration utility directly (command line version, see chapter 16.19 “Com-
mand Line Version” on page 16-33). In a standard project you will rather use the normal GUI version as the
utility is not used very often and you should not directly edit the sconf.xml file.

The V=1 switch in the build call is just used to show you the full build information.

SCIOPTA - Real-Time Kernel
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3.4 Getting Started iISYSTEM winIDEA

This is a getting started project including a step-by-step tutorial for the SCIOPTA Real-Time Kernels
(<arch>=arm, <arch>=ppc and <arch>=coldfire).

3.4.1 Equipment

For architectures ARM, PowerPC and ColdFire the following equipment is used to run this getting started example:

* Microsoft® Windows Personal Computer or Workstation.
» Compiler package:
For ARM CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ARM.
Architecture (arch): arm

For PowerPC  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for Power PC .
Architecture (arch): ppc

For ColdFire  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ColdFire.
Acrchitecture (arch): coldfire

These packages can be found on the SCIOPTA CD.
* iISYSTEM winIDEA Emulator/Debugger for your selected target processor.

» Target board which is supported by SCIOPTA examples. For each supported board there is a directory in the
example folder: <install_folder>\sciopta\<version>\exp\krn\<arch>\hello\.

» SCIOPTA - Real-Time Kernel for your selected architecture.

» This getting started example is sending some specific example messages to a selected UART of the board. To
display these messages on your host PC you can optionally connect a serial line from a COM port of your host
PC to an UART port of your selected target board. The selected UART port can be found in chapter 14 “Board
Support Packages” on page 14-1 where the Log Port for each board is given. If you want to change the port
you may modify the files system.c, simple_uart.c, simple_uart.h and config.h.

3.4.2  Step-By-Step Tutorial
1. Check that the environment variable SCIOPTA_HOME is defined as described in the chapter 2.4.6
“SCIOPTA_HOME Environment Variable” on page 2-4.

2. Besure that the GNU GCC compiler bin directory is included in the PATH environment variable as described
in the chapter 2.4.9 “GNU Tool Chain Installation” on page 2-5.

Create an example working directory at a suitable place.
4. Copy the script copy_files.bat from the example directory for your selected target boards:
<install_folder>\sciopta\<version>\exp\krn\<arch>\hello\<board>\
to your project folder.

5. Double click copy_files.bat to execute the batch file. All needed project files will be copied from the delivery
to your project folder.
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6. Launch the SCIOPTA configuration utility SCONF from the desktop or the Start menu.

7. Load the SCIOPTA example project file hello.xml from your project folder into SCONF.
File > Open

8.  Click on the Build All button or press CTRL-B to build the kernel configuration files.
The following files will be created in your project folder:

e sciopta.cnf
e sconf.c
e sconf.h.

9. Launch the iISYSTEM - winIDEA Emulator/Debugger.

10. Open the example workspace (menu: File > Workspace > Open Workspace...). Browse to your example
project directory and select the workspace file <project_file_name>.jrf.

11. Make the project (menu: Project > Make) or type the F7 button.
12. The executable (sciopta.elf) will be created in the debug folder of the project.
13. Download the sciopta.elf file into the target system (menu: Debug > Download) or type the Ctrl+F3 button.

14. If you have connected a serial line from the COM port of your host PC to the UART of your target board, open
a terminal window on your PC and connect it to your selected PC COM port. Parameters are 115200Bd, 8 Bit,
no parity, 1 stop bit, no flow-control.

15. Run the system (menu: Debug > Run) or type the F5 button.
16. Now you can check the log messages on your host terminal window.
17. You can also set breakpoints anywhere in the example system and watch the behaviour.

SCIOPTA - Real-Time Kernel
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3.5 Getting Started IAR Systems Embedded Workbench

This is a getting started project including a step-by-step tutorial for the SCIOPTA Real-Time Kernels (<arch>=arm
and <arch>=coldfire).

3.5.1 Equipment

For architectures ARM and ColdFire the following equipment is used to run this getting started example:

Microsoft® Windows Personal Computer or Workstation.
Compiler package:
For ARM IAR Embedded Workbench for ARM.
Architecture (arch): arm
For ColdFire  IAR Embedded Workbench for ColdFire.
Architecture (arch): coldfire
IAR CSpy Debugger for your selected target processor.

Target board which is supported by SCIOPTA examples. For each supported board there is a directory in the
example folder: <install_folder>\sciopta\<version>\exp\krn\<arch>\hello\.

SCIOPTA - Real-Time Kernel for your selected architecture.

This getting started example is sending some specific example messages to a selected UART of the board. To
display these messages on your host PC you can optionally connect a serial line from a COM port of your host
PC to an UART port of your selected target board. The selected UART port can be found in chapter 14 “Board
Support Packages” on page 14-1 where the Log Port for each board is given. If you want to change the port
you may modify the files system.c, simple_uart.c, simple_uart.h and config.h.

3.5.2  Step-By-Step Tutorial

Check that the environment variable SCIOPTA_HOME is defined as described in chapter 2.4.6
“SCIOPTA_HOME Environment Variable” on page 2-4.

Be sure that the SCIOPTA \win32\bin directory is included in the PATH environment variable as described
in chapter 2.4.7 “Setting SCIOPTA Path Environment Variable” on page 2-4. This will give access to the
sconf.exe utility. Some IAREW examples might call sconf.exe directly from the workbench to do the SCI-
OPTA configuration.

Be sure that the IAR Embedded Workbench is installed as described in the IAREW user manuals.

Create an example working directory at a suitable place.

Copy the script copy_files_iar.bat from the example directory for your selected target boards:
<install_folder>\sciopta\<version>\exp\krn\<arch>\hello\<board>\

to your project folder.

Double click copy_files.bat to execute the batch file. All needed project files will be copied from the delivery
to your project folder.

SCIOPTA - Real-Time Kernel
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7. Launch the SCIOPTA configuration utility SCONF from the desktop or the Start menu.

8. Load the SCIOPTA example project file hello.xml from your project folder into SCONF.
File > Open

9. Choose the Build All button or press CTRL-B to build the kernel configuration files.
The following files will be created in your project folder:

e sciopta.cnf
e sconf.c
e sconf.h.

10. Launch the IAR Embedded Workbench.
11. Click on the Open existing workbench button in the Embedded Workbench Startup window.

12. Browse to your example project directory and select the IAR Embedded Workbench file for your selected
board: <file_name>.eww.

13. Select the project in the Workspace and Make the project (menu: Project > Make) or type the F7 button.
14. The executable (sciopta.elf) will be created in the Output folder of the project.

15. Download and debug the sciopta.elf file into the target system (menu: Project > Debug) or type the Ctrl+D
button.

16. If you have connected a serial line from the COM port of your host PC to the UART of your target board, open
a terminal window on your PC and connect it to your selected PC COM port. Parameters are 115200Bd, 8 Bit,
no parity, 1 stop bit, no flow-control.

17. Run the system (menu: Debug > Go) or type the Go button.
18. Now you can check the log messages on your host terminal window.

19. You can also set breakpoints anywhere in the example system and watch the behaviour.

SCIOPTA - Real-Time Kernel
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3.6 Getting Started SCIOPTA SCSIM Simulator

This is a getting started project including a step-by-step tutorial for the SCIOPTA SCSIM Simulator
(<arch>=win32) architecture.

3.6.1 Equipment

The following equipment is used to run this getting started example:

* Microsoft® Windows Personal Computer or Workstation.

* Microsoft® Visual C++ 2005 Version 8.0 development environment.

3.6.2  Step-By-Step Tutorial
1. Check that the environment variable SCIOPTA_HOME is defined as described in chapter 2.4.6
“SCIOPTA_HOME Environment Variable” on page 2-4.

2. Check that the correct SCIOPTA Kernel Simulator DLL is located in a directory where Windows® can access
it. Please consult chapter 2.4.11 “SCIOPTA SCSIM Simulator (win32) DLL” on page 2-6.

3. Create a project folder to hold all project files (e.g. d:\myprojects\sciopta) if you have not already done it for
other getting-started projects.

4. Copy the script copy_files.bat from the example directory:
<install_folder>\sciopta\<version>\exp\krn\win32\hello\
to your project folder.

5. Double click copy_files.bat to execute the batch file. All needed project files will be copied from the delivery
to your project folder.

6. Launch the SCIOPTA configuration utility SCONF from the desktop or the Star menu.

7. Load the SCIOPTA example project file hello.xml from your project folder into SCONF
(menu: File > Open).

8.  Click on the Build All button or press Ctrl-B to build the kernel configuration files.
The following files will be created in your project folder:

e sciopta.cnf
e sconf.c
* sconf.h.

9. Launch the Microsoft® Visual C++ Environment
10. Open the solution file which was copied into your working directory (hello.sIn).
11. Build the example hello.exe.

12. Now you can run the system and set breakpoints anywhere in the example system and watch the behaviour.

SCIOPTA - Real-Time Kernel
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4 Modules

4.1 Introduction

SCIOPTA allows you to group processes into functional units called modules. Very often you want to decompose
a complex application into smaller units which you can realize in SCIOPTA by using modules. This will improve
system structure. A SCIOPTA process can only be created from within a module.

A typical example would be to encapsulate a whole communication stack into one module and to protect it against
other function modules in a system. Modules can be moved and copied between CPUs and systems

When creating and defining modules the maximum number of pools and processes must be defined. There is a
maximum number of 128 modules per SCIOPTA system possible.

4.2 System Module

There is always one static system module in a SCIOPTA system.

This module is called system module (sometimes also named module 0) and is automatically created by the kernel
at system start.

4.3 Module Priority

SCIOPTA modules contain a (module) priority.

For process scheduling SCIOPTA uses a combination of the module priority and process priority called effective
priority. The kernel determines the effective priority as follows:

Effective Priority = Module Priority + Process Priority

The effective priority has an upper limit of 31which will never be exceeded even if the addition of module priority
and process priority is higher. This technique assures that the process with highest process priority (0) cannot dis-
turb processes in modules with lower module priority (module protection).

4.4 Module Memory

The module start address and the module size must be given when declaring a static module in the SCIOPTA con-
figuration utility (SCONF) or as parameters when dynamically creating a module.

The best method to handle module addresses is to use the linker script to calculate the module address boundaries.
Please consult chapter 15.7.2.2 “Module Sizes” on page 15-11 for more information.

SCIOPTA - Real-Time Kernel
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4.5 System Protection

In bigger systems it is often necessary to protect certain system areas to be accesses by others. In SCIOPTA the
user can achieve such protection by grouping processes into modules creating sub-systems which can be protected.

Full protection is achieved if memory segments are isolated by a hardware Memory Management Unit (MMU). In
SCIOPTA such protected memory segments would be laid down at module boundaries.

System protection and MMU support is optional in SCIOPTA and should only be used and configured if you need
this feature.

4.6 SCIOPTA Module Friend Concept

SCIOPTA supports also the “friend” concept. Modules can be “friends” of other modules. This has mainly conse-
guences on whether message will be copied or not at message passing. Please consult chapter 6.9 “Messages and
Modules” on page 6-8 for more information.

A module can be declared as friend by the sc_moduleFriendAdd system call. The friendship is only in one direc-
tion. If module A declares module B as a friend, module A is not automatically also friend of Module B. Module
B would also need to declare Module A as friend by the sc_moduleFriendAdd system call.

Each module maintains a 128 bit wide bit field for the declared friends. For each friend a bit is set which corre-
sponds to its module ID.

SCIOPTA - Real-Time Kernel
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4.7 Creating Modules

47.1 Static Module Creation

Static modules are modules which are automatically created when the systems boots up. They are defined in the
SCONF configuration tool.

&4 Sciopta System Configuration C:/P/titi.xml

File Edit PowerPcTarget Help

D w
Configuration Tree Structure |
sc@raTES Pon
SR INewT a

- 3 N el arge Create Module 3
Delete Target

Build Temporary File

Change Build Directory

Figure 4-1: Module Creation by SCONF

Please consult chapter 16.10 “Creating Modules” on page 16-15 for more information about module creation by
the SCONF tool.

4.7.2 Dynamic Module Creation

Another way is to create modules dynamically by the sc_moduleCreate() system call.

sc_moduleid_t sc_moduleCreate (

const char *name,
void (*init) (void),
sc_bufsize t stacksize,
sc_prio_t moduleprio,
char *start,

sc_modulesize_t size,

sc_modulesize_t initsize,
unsigned int max_pools,
unsigned int max_procs

Figure 4-2: Dynamic Module Creation
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4.8 Module Layout Examples

48.1 Small Systems

Small or simple system can be put into one module. This keeps the system and memory map on a very neat level.

e sciopta System Configuration  D:'\Manualsdummy’,ppc400tihello.zml - Elljl

File Edit Module Help

JsN==

Configuration Tree Stiucture I

=cigrn HelloS ciopta

213 HelloS ciopta I~ Losd Madule
HelloS ciopta

_ Module Name HellaSciopta
=
. é default M arimum Processes 16

Wb SC1_sysTick Masimum Pools 2
i 38 hell

3 display Pricrity i} o
¥ Symbolic ¥alues

Start Address aystern_mod stark
hemory Size syztem_mod size
Init. Size system_mod initsize

Apply Cancel |

Figure 4-3: One-Module System
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In larger or more complex system it is good design practice to partition the system up into more modules.

o sciopta System Configuration  D:\Manuals),dummy’ppc400'ipsthello.zml

Fle Edit PowerPcSystem Help

=10l x|
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Configuration Tree Structure
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3 init
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- 3% so_procd
-~ 0 SCP_logd
- 4§ SCP_devman
3 SCP_netrnan
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- 38 dev
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4§ SCP_loopback
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E-#E i
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5 inpPaal
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B * user
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5 default
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Inter-taodule
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Figure 4-4: Multi-Module System

Above example system consists of four modules.

HelloSciopta

dev

ips

user

This is the system module and contains the daemons (kernel daemon sc_kerneld, process dae-
mon sc_procd and log daemon SCP_logd), the SDD managers (device manager SCP_devman
and network device manager SCP_netman) and other system pools and system processes.
The system module gets automatically the name of the system.

This module holds the device driver processes and device driver pools.

This example includes the SCIOPTA IPS TCP/IP stack. The processes of this communication
stack are located in the ips module.

In this user module the application processes and pools are placed.
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4.9 Module System Calls

Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the SCIOPTA system calls.
sc_moduleCreate Creates a module.

sc_moduleFriendAdd Adds a module to the friends of the caller.

sc_moduleFriendAll  Defines all existing modules in a system as friend.

sc_moduleFriendGet Informs the caller if a module is a friend.

sc_moduleFriendNone Removes all modules as friends of the caller.

sc_moduleFriendRm Removes a module of the friends of the caller.

sc_moduleldGet Returns the ID of a module.
sc_modulelnfo Returns a snap-shot of a module control block.
sc_moduleKill Kills a module.

sc_moduleNameGet  Returns the full name of a module.

sc_modulePrioGet Returns the priority of a module.

SCIOPTA - Real-Time Kernel
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An independent instance of a program running under the control of SCIOPTA is called process. SCIOPTA is as-
signing CPU time by the use of processes and guarantees that at every instant of time, the most important process
ready to run is executing. The system interrupts processes if other processes with higher priority must execute (be-

come ready).

All SCIOPTA processes have system wide unique process identities.

A SCIOPTA process is always part of a SCIOPTA module. Please consult chapter 4 “Modules” on page 4-1 for

more information about SCIOPTA modules.

5.2 Process States

A process running under SCIOPTA is always in the RUNNING, READY or WAITING state.

5.2.1  Running

If the process is in the running state it ex-
ecutes on the CPU. Only one process can
be in running state in a single CPU sys-
tem.

5.2.2 Ready

If a process is in the ready state it is ready
to run meaning the process needs the
CPU, but another process with higher pri-
ority is running.

5.2.3  Waiting

If a process is in the waiting state it is
waiting for events to happen and does not
need the CPU meanwhile. The reasons to
be in the waiting state can be:

» The process tried to receive a mes-
sage which has (not yet) arrived.

» The process called the sleep system
call and waits for the delay to expire.

e The process waits on a SCIOPTA
trigger.

e The Process waits on a start system
call if it was previously stopped.

READY

N

tx (transmit)

dispatch preemption

RUNNING

stop process

tx (transmit) sleep
rx (receive)
start process

(higher priority)

WAITING

start process (lower or same priority)

1
o

Figure 5-1: State Diagram of SCIOPTA Kernel
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5.3 Static Processes

Static processes are created by the kernel at start-up. They are designed inside a configuration utility by defining
the name and all other process parameters such as priority and process stack sizes. At start-up the kernel puts all
static created processes into READY or WAITING (stopped) state.

Static processes are supposed to stay alive as long as the whole system is alive. But nevertheless in SCIOPTA static
processes can be killed at run-time but they will not return their used memory.

=1l =]
Congua st Toes Sliuctn
B TS
L T;S Py Procass Nams s——
L@
T Pricety Process Funchion  [Mestroiiocms:1
A ket Sisck Size f="
haiph -
2 = Pty e
5 et Process Stat I
& wyspodt
18 Chanbes
e )
.
Sove
g drvver
£ contsuller
PSR
o Crambeoal

Figure 5-2: Process Configuration Window for Static Processes

54 Dynamic Processes
Dynamic processes can be created and killed during run-time. Often dynamic processes are used to run multiple

instances of common code. The number of instances is only limited by system resources and does not to be known
before running the system.

Another advantage of dynamic processes is that the resources such as stack space will be given back to the system
after a dynamic process is killed.

sc_pid_t sc_procPrioCreate (

const char
void (*entry)
sc_bufsize_t
sc_ticks_t
sc_prio_t

int
sc_poolid_t

*name,
(void),
stacksize,
slice,
prio,
state,
plid

Figure 5-3: Create Process System Call

5-2
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5.5 Process ldentity

Each process has a unique process identity (process ID) which is used in SCIOPTA system calls when processes
need to be addressed.

The process ID will be allocated by the operating system for all processes which you have entered during
SCIOPTA configuration (static processes) or will be returned when you are creating processes dynamically. The
kernel maintains a list with all process names and their process IDs.

The user can get Process IDs by using a sc_procldGet system call including the process name.

5.6 Prioritized Processes

2%

In SCIOPTA a process can be seen as an independent program which executes as if it has the whole CPU available.
The operating systems guarantees that always the most important process at a certain moment is executing. In a
typical SCIOPTA system prioritized processes are the most common used process types. Each prioritized process
has a priority and the SCIOPTA scheduler is running ready processes according to these priorities. The process
with higher priority runs (gets the CPU) before the process with lower priority.

If a process has terminated its job for the moment by for example waiting on a message which has not yet been sent
or by calling the kernel sleep function, the process is put into the waiting state and is not any longer ready.

Most of the time in a SCIOPTA real-time system is spent in prioritized processes. It is where collected data is an-
alysed and complicated control structures are executed.

Prioritized processes respond much slower than interrupt processes, but they can spend a relatively long time to
work with data.
5.6.1 Creating and Declaring Prioritized Processes

Static prioritized processes are defined in the SCIOPTA configuration utility (SCONF) and created by the kernel
automatically at system startup. See also chapter 16.12 “Creating Processes and Pools” on page 16-18.

Dynamic prioritized process are created by using the sc_prioProcCreate system call and killed dynamically with
the sc_procK:ill system call.

5.6.2 Process Priorities

Each SCIOPTA process has a specific priority. The user defines the priorities at system configuration or when cre-
ating the process. Process priorities can be modified during run-time.

By assigning a priority the user designs groups of processes or parts of systems according to response time require-
ments. Ready processes with high priority are always interrupting processes with lower priority. Subsystems with
high priority processes have therefore faster response time. Priority values for prioritized processes in SCIOPTA
can be from 0 to 31. 0 is the highest and 31 the lowest priority level.

SCIOPTA - Real-Time Kernel
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For process scheduling SCIOPTA uses a combination of the module priority and process priority called effective
priority. The kernel determines the effective priority as follows:

Effective Priority = Module Priority + Process Priority

See also chapter 4.3 “Module Priority” on page 4-1.

5.6.3  Writing Prioritized Processes

5.6.3.1 Process Declaration Syntax

All prioritized processes in SCIOPTA must contain the following declaration:
SC_PROCESS (<proc_name>)
for (3)

/* Code for process <proc_name> */
¥

5.6.3.2 Process Template

#include <sciopta.h> /* SCIOPTA standard prototypes and definitions */
SC_PROCESS (proc_name) /* Declaration for prioritized process proc_name */
{

/* Local variables */
/* Process initialization code */

for (53) /* “for-ever”-loop declaration. */
/* A SCIOPTA prioritized process may never return */

/* 1t is an error to terminate a prioritized process */

/* If a prioritized process terminates and returns */

/* the SCIOPTA kernel will produce an error condition */
/* and call the SCIOPTA error hook */

/* Code for process proc_name */

SCIOPTA - Real-Time Kernel
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An interrupt is a system event generated by a hardware device. The CPU will suspend the actually running program
and activate an interrupt service routine assigned to that interrupt.

The programs which handle interrupts are called interrupt processes in SCIOPTA. SCIOPTA is channelling inter-
rupts internally and calls the appropriate interrupt process.

Interrupt process is the fastest process type in SCIOPTA and will respond almost immediately to events. As the
system is blocked during interrupt handling interrupt processes must perform their task in the shortest time possi-
ble.

A typical example is the control of a serial line. Receiving incoming characters might be handled by an interrupt
process by storing the incoming arrived characters in a local buffer returning after each storage of a character. If
this takes too long characters will be lost. If a defined number of characters of a message have been received the
whole message will be transferred to a prioritized process which has more time to analyse the data.

In some SCIOPTA systems there might be two type of interrupt processes. Interrupt processes of type Sciopta are
handled by the kernel and may use (not blocking) system calls while interrupt processes of type User are handled
outside the kernel and may not use system calls.

5.7.1 Creating and Declaring Interrupt Processes

Static interrupt processes are defined in the SCIOPTA configuration utility (SCONF) and created by the kernel au-
tomatically at system startup. See also chapter 16.12 “Creating Processes and Pools” on page 16-18.

Dynamic interrupt process are created by using the sc_proclntCreate system call and killed dynamically with the
sc_procKill system call.

5.7.2  Interrupt Process Priorities

The priority of an interrupt process is assigned by hardware of the interrupt source. Whenever an interrupt occurs

the assigned interrupt process is called, assuming that no other interrupt of higher priority is running. If the interrupt
process with higher priority has completed his work, the interrupt process of lower priority can continue.

5.7.3  Writing Interrupt Processes

5.7.3.1 Interrupt Process Declaration Syntax

All interrupt processes in SCIOPTA must contain the following declaration:
SC_INT_PROCESS (<proc_name>, <irq_src>)

/* Code for interrupt process <proc_name> */

SCIOPTA - Real-Time Kernel
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5.7.3.2 Interrupt Source Parameter

The interrupt process declaration has beside the process name a second parameter (<irq_src> see chapter 5.7.3.1
“Interrupt Process Declaration Syntax” on page 5-5) which defines the interrupt source. This parameter is set by
the kernel depending on the interrupt source.

Interrupt Source Parameter Values

0 The interrupt process is activated by a real hardware interrupt.
1 The interrupt process is activated by a message sent to the interrupt process.
2 The interrupt process is activated by a trigger event.

-1 The interrupt process is activated when the process is created. This allows the interrupt process to execute some
initialization code.

-2 The interrupt process is activated when the process is Killed. This allows the interrupt process to execute some
exit code.

5.7.3.3 Interrupt Process Template

In this chapter a template for an interrupt process in SCIOPTA is provided.

#include <sciopta.h> /* SCIOPTA standard prototypes and definitions */
SC_INT_PROCESS (proc_name, irg_src)/* Declaration for interrupt process proc_name */
¢ /* Local variables */
if (irg_src == 0) /* Generated by hardware */
/* Code for hardware interrupt handling */
else if (irg_src == -1) /* Generated when process created */
/* Initialization code */
else if (irg_src == -2) /* Generated when process killed */
/* Exit code */
else if (irg_src == 1) /* Generated by a message sent to this interrupt process */
/* Code for receiving a message */

¥
else if (irg_src == 2) /* Generated by a SCIOPTA trigger event */

/* Code for trigger event handling */
}
}

SCIOPTA - Real-Time Kernel
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5.8 Timer Processes

A timer process in SCIOPTA is a specific interrupt process connected to the tick timer of the operating system.
SCIOPTA is calling each timer process periodically derived from the operating system tick counter.

When configuring or creating a timer process, the user defines the number of system ticks to expire from one call
to the other individually for each process.

Timer processes will be used for tasks which need to be executed at precise cyclic intervals. For instance checking
a status bit or byte at well defined moments in time can be performed by timer processes.

Another example is to measure a voltage at regular intervals. As timer processes execute on the interrupt level of
the timer interrupt it is assured that no voltage measurement samples are lost.

As the timer process runs on interrupt level it is as important as for normal interrupt processes to return as fast as
possible.
5.8.1 Creating and Declaring Timer Processes

Static timer processes are defined in the SCIOPTA configuration utility (SCONF) and created by the kernel auto-
matically at system startup. See also chapter 16.12 “Creating Processes and Pools” on page 16-18.

Dynamic timer process are created by using the sc_procTimCreate system call and killed dynamically with the
sc_procKill system call.

5.8.2 Timer Process Priorities

The priority of an interrupt process is assigned by hardware of the interrupt source which is used for the timer proc-
ess. Whenever a timer interrupt occurs the assigned timer interrupt process is called, assuming that no other inter-
rupt of higher priority is running.

5.8.3  Writing Timer Processes

Timer processes are written exactly the same way as interrupt processes. Please consult chapter 5.7.3 “Writing In-
terrupt Processes” on page 5-5 for information how to write interrupt processes.
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The init process is the first process in a module. Each module has at least one process and this is the init process.

At module start the init process gets automatically the highest priority (0). After the init process has done some its
work it will change its priority to a specific lowest level (32) and enter an endless loop.

The init process acts therefore also as idle process which will run when all other processes of a module are in the
waiting state.

5.9.1 Creating and Declaring Init Processes

In static modules the init process is written, created and started automatically. Static modules are defined and con-
figured in the SCONF configuration utility. The code of the init process is generated automatically by the SCONF
configuration tool and included in the file sconf.c. The init process function name will be set automatically by the
kernel in sconf.c to: <module_name>_init. The init process of the system module will create all static SCIOPTA
objects such as other modules, processes and pools.

In dynamic modules the init process is also created and started automatically. But the code of the init process must
be written by the user. The entry point of the init process is given as parameter of the sc_moduleCreate2 system
call. Please see below for more information how to write init processes for dynamic modules.

5.9.2 Init Process Priorities

At start-up the init process gets the highest priority (0).

After the init process has done its work it will change its priority to a specific lowest level (32) and enter an endless
loop.

Priority 32 is only allowed for the init process. All other processes are using priority 0 - 31.

5.9.3  Writing Init Processes

Only init processes of dynamic modules must be written by the user. The entry point of the init process is given as
parameter of the sc_moduleCreate2 system call. At start-up the init process gets the highest priority (0). The user
must set the priority to 32 at the end of the init process code.

Template of a minimal init process of a dynamic module:
SC_PROCESS(dynamicmodule_init)

/* Important init work on priority level 0 can be included here */
sc_procPrioSet(32);
for(;;) ASM_NOP; /* init is now the idle process */
}

SCIOPTA - Real-Time Kernel
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5.10 Daemons

Daemons are internal processes in SCIOPTA and are structured the same way as ordinary processes. They have a
process control block (pcb), a process stack and a priority.

Not all SCIOPTA daemons are part of the standard SCIOPTA delivery.

5.10.1 Process Daemon

The process daemon (sc_procd) is identifying processes by name and supervises created and killed processes.

Whenever you are using the sc_procldGet system call you need to start the process daemon.

Configuration Tree Structure
scigeta HelloS ciopta

= # HelloS ciopta Pricrity Process Mame Isc_pn:u:d
=1~ 3 HelloSciopta
9 it Priority Process Function Isc_plncd
- g default Stack Size [512
-y SC1_sysTick Eh —
- 35k sc_kemeld Tionty ? —

B Process State I started "I
- 3 5CP_logd A Y

- 30 SCP_rcsman ™

- 33 SCP_devman \

- 30 SCP_netman

- 3 SCP_link Process Daemon
B~ HE dev
- ips
- 3 user

Figure 5-4: Process Daemon Declaration in SCONF

The process daemon is part of the kernel. But to use it you need to define and declare it in the SCONF configuration
utility.

The process daemon can only be created and placed in the system module.
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5.10.2 Kernel Daemon

The Kernel Daemon (sc_kerneld) is creating and killing modules and processes. Some time consuming system
work of the kernel (such as module and process killing) returns to the caller without having finished all related
work. The Kernel Daemon is doing such work at appropriate level.

Whenever you are using process or module create or kill system calls you need to start the kernel daemon.

Configuration Tree Structure I
scigrtaHellaSciopta

E- # HeloSciopta Friority Process Mame Isc_kemeld
=1- 34 HelloS ciopta
9 it Friarity Process Function Isc_kemeld
- g default Stack Size 512
SCI_spsTick . -
Pricrity 2 =
rreld
#sc_ploc:d \ Process State I started 'I
- 43 SCP_logd
# SCP_rceman
# SCP_dewman
# SCP_netman
- 338 SCP_link Kernel Daemon
- P dev
- ips
[+ # uger

Figure 5-5: Kernel Daemon Declaration in SCONF

The kernel daemon is part of the kernel. But to use it you need to define and declare it in the SCONF configuration
utility.

The kernel daemon can only be created and placed in the system module.

SCIOPTA - Real-Time Kernel
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5.11  Supervisor Processes

In SCIOPTA systems which include MMU protection prioritized processes can be defined to be user or supervisor
processes. Supervisor processes have full access rights to system resources. Supervisor processes are often used in
device drivers.

SCIOPTA - Real-Time Kernel
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512 Process Stacks

When creating processes either statically in the SCONF configuration tool or dynamically with the
sc_procPrioCreate, sc_proclntCreate or sc_procTimCreate system calls you always need to give a stack size.
All process types (init, interrupt, timer, prioritized and daemon need a stack).

The stack size given must be big enough to hold the call stack and the maximum used local data in the process.

When you start designing a system it is good design practice to define a the stack as big as possible. In a later stage
you can measure the used stack with the SCIOPTA DRUID system level debugger and reduce the stacks if needed.

5.12.1 Unified Interrupt Stack for ARM Architecture

For the ARM architecture a unified interrupt stack can be used in interrupt and timer processes. In this case all in-
terrupt and timer processes share the same stack.

The “unified IRQ stack” checkbox must be selected in the system configuration window of the SCONF utility to
enable this feature. See chapter 16.9 “Configuring Target Systems” on page 16-8.

The stack size given must be big enough to hold the stacks of the interrupt processes with the biggest stack needs
taken in account the interrupt nesting.

5.12.2 Interrupt Nesting for ARM Architecture

If interrupt process nesting is used in the ARM architecture, the maximum nesting level of interrupt processes must
be declared in the system configutation (SCONF). See chapter 16.9 “Configuring Target Systems” on page 16-8.

SCIOPTA - Real-Time Kernel
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5.13 Addressing Processes

5.13.1 Introduction

In a typical SCIOPTA design you need to address processes. For example you want to

« send SCIOPTA messages to a process,
« Kill a process

e get astored name of a process

» observe a process

e get or set the priority of a process
 start and stop processes

In SCIOPTA you are addressing processes by using their process ID (pid). There are two methods to get process
IDs depending if you have to do with static or dynamic processes.

5.13.2 Get Process IDs of Static Processes

Static processes are created by the kernel at start-up. They are designed with the SCIOPTA SCONF configuration
utility by defining the name and all other process parameters such as priority and process stack sizes.

You can address static process by appending the string
_pid

to the process name if the process resides in the system module. If the static process resides inside another module
than the system module, you need to precede the process name with the module name and an underscore in be-
tween.

For instance if you have a static process defined in the system module with the name controller you can address
it by giving controller_pid. To send a message to that process you can use:

sc_msgTx (mymsg, controller_pid, myflags);

If you have a static process in the module tcs (which is not the system module) with the name display you can
address it by giving tcs_display_pid. To send a message to that process you can use:

sc_msgTx (mymsg, tcs_display_pid, myflags);

5.13.3 Get Process IDs of Dynamic Processes

Dynamic processes can be created and killed during run-time. Often dynamic processes are used to run multiple
instances of common code.

The process IDs of dynamic processes can be retrieved by using the system call sc_procldGet.

The process creation system calls sc_procPrioCreate, sc_proclntCreate and sc_procTimCreate will also return
the process IDs which can be used for further addressing.

SCIOPTA - Real-Time Kernel
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5.14 Process Variables

Each process can store local variables inside a protected data area. Process variables are variables which can only
be accesses by functions within the context of the process.

The process variable are usually maintained inside a SCIOPTA message and managed by the kernel. The user can
access the process variable by specific system calls.

Process Control Block
PCB

Process Variable Message

Pointer | Message ID

Reserved by the kernel

TAG 1 A
Variable 1
TAG 2
Variable 2
TAG 3
Variable 3
TAG 4
Variable 4
TAGn
Variable n v

Process Variables

Figure 5-6: SCIOPTA Process Variables

There can be one process variable data area per process. The user needs to allocate a message to hold the process
variables. Each variable is preceded by a user defined tag which is used to access the variable. The tag and the proc-
ess variable have a fixed size large enough to hold a pointer.

It is the user’s responsibility to allocate a big enough message buffer to hold the maximum needed number of proc-
ess variables. The message buffer holding the variable array will be removed from the process. The process may
no longer access this buffer directly. But it can retrieve the buffer if for instance the number of variables must be
changed.
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5.15 Process Observation

Communication channels between processes in SCIOPTA can be observed no matter if the processes are local or
distributed over remote systems. The process calls sc_procObserve which includes the pointer to a return message
and the process ID of the process which should be observed.

If the observed process dies the kernel will send the defined message back to the requesting process to inform it.
This observation works also with remote process lists in connectors. This means that not only remote processes can
be observed but also connection problems in communication links if the connectors includes the necessary func-

tionality.

Registration of observation of
process B requesting the mes- Kernel
sage B_Kkilled as returned in-

formation. /( /

process B
process A B_Killed

Message B_killed is returned
sc_procObserve() by the kernel to inform process
- A of the killing of process B.

.
0.. "‘
., .

P

Tteea..,,.,  Observedlink = .-

Figure 5-7: SCIOPTA Observation
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5.16  Process System Calls

Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the SCIOPTA system calls.

sc_procPrioCreate
sc_procintCreate

sc_procTimCreate

sc_procDaemonRegister

sc_procDaemonUnregister

sc_procHookRegister
sc_procldGet
sc_procKill
sc_procNameGet
sc_procObserve
sc_procUnobserve
sc_procPathCheck
sc_procPathGet
sc_procPpidGet
sc_procPrioGet
sc_procPrioSet
sc_procSchedLock
sc_procSchedUnlock
sc_procSliceGet
sc_procSliceSet
sc_procStart

sc_procStop

Requests the kernel daemon to create a prioritized process.
Requests the kernel daemon to create a interrupt process.

Requests the kernel daemon to create a timer process.

Registers a process daemon which is responsible for pid get request.
Unregisters a process daemon.

Registers a process hook.

Returns the process ID of a process.

Requests the kernel daemon to kill a process.

Returns the full name of a process.

Request a message to be sent if the given process pid dies (process supervision).
Cancels the observation of a process.

Checks if the construction of a path is correct.

Returns the path of a process.

Returns the process ID of the parent of a process.

Returns the priority of a process.

Sets the priority of a process.

Locks the scheduler and returns the number of times it has been locked before.
Unlocks the scheduler by decrementing the lock counter by one.
Returns the time slice of a prioritized or timer process.

Sets the time slice of a timer process.

Starts a process.

Stops a process.

5-16
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sc_procVarDel
sc_procVarGet
sc_procVarlnit
sc_procVarRm
sc_procVarSet
sc_procVectorGet
sc_procWakeupEnable
sc_procWakeupDisable

sc_procYield

Deletes a process variable.

Returns a process variable.

Initializes a process variable area.

Removes a process variable area.

Sets a process variable.

Returns the interrupt vector of an interrupt process.
Enables the wakeup of a timer or interrupt process.
Disables the wakeup of a timer or interrupt process.

Yields the CPU to the next ready process within the current priority group.

SCIOPTA - Real-Time Kernel
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6 Messages

6.1 Introduction

SCIOPTA is a so called Message Based Real-Time Operating System. Interprocess communication and coordina-
tion is done by messages. Message passing is a very fast, secure, easy to use and good to debug method.

Messages are the preferred tool for interprocess communication in SCIOPTA. SCIOPTA is specifically designed
to have a very high message passing performance. Messages can also be used for interprocess coordination or syn-
chronization duties to initiate different actions in processes. For this purposes messages can but do not need to carry
data.

A message buffer (the data area of a message) can only be accessed by one process at a time which is the owner of
the message. A process becomes owner of a message when it allocates the message by the sc_msgAlloc system
call or when it receives the message by the sc_msgRx system call.

Message passing is also possible between processes on different CPUs. In this case specific communication proc-
ess types on each side will be needed called SCIOPTA Connector Processes.

6.2 Message Structure

Every SCIOPTA message has a message identity and a range reserved for message data which can be freely ac-
cessed by the user. Additionally there are some hidden data structure which will be used by the kernel. The user
can access these message information by specific SCIOPTA system calls. The following message system informa-
tion are stored in the message header:

» Process ID of message owner
» Message size
» Process ID of transmitting process

* Process ID of addressed process

DATA
owner J
size message 1D
transmitter )
addressee user accessible end mark
internal use

Figure 6-5: SCIOPTA Message Structure
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When a process is allocating a message it will be the owner of the message. If the process is transmitting the mes-
sage to another process, the other process will become owner. After transmitting, the sending process cannot access
the message any more. This message ownership feature eliminates access conflicts in a clean and efficient way.

Every process has a message queue where all owned (allocated or received) messages are stored. This message
queue is not a own physically separate allocated memory area. It consists rather of a double linked list inside mes-
sage pools.

6.3 Message Sizes

If a process allocates a message there is also the size to be given. The user just gives the number of bytes needed.
SCIOPTA is not returning the exact amount of bytes requested but will select one of a list of buffer sizes which is
large enough to contain the requested number. This list can contain 4, 8 or 16 sizes which will be defined when a
message pool is created.

The difference of requested bytes and returned bytes can not be accessed by the user and will be unused. It is there-
fore very important to select the buffer sizes to match as close as possible those needed by your application to waste
as little memory as possible.

This pool buffer manager used by SCIOPTA is a very well known technique in message based systems. The SCI-
OPTA memory manager is very fast and deterministic. Memory fragmentation is completely avoided. But the user
has to select the buffer sizes very carefully otherwise there can be unused memory in the system.

As you can have more than one message pool in a SCIOPTA system and you can create and kill pools at every
moment the user can adapt message sizes very well to system requirements at different system states because each
pool can have a different set of buffer sizes.

By analysing a pool after a system run you can find out unused memory and optimise the buffer sizes.

6.3.1 Example

A message pool is created with 8 buffer sizes with the following sizes: 4, 10, 20, 80, 200, 1000, 4048, 16000.

If a message is allocated from that pool which requests 300 bytes, the system will return a buffer with 1000 bytes.
The difference of 700 bytes is not accessible by the user and is wasted memory.

If 300 bytes buffer are used more often, it would be good design to modify the buffer sizes for this pool by changing
the size 200 to 300.

6.4 Message Pool

Messages are the main data object in SCIOPTA. Messages are allocated by processes from message pools. If a
process does not need the messages any longer it will be given back (freed) by the owner process.

Please consult chapter 7 “Pools” on page 7-1 for more information about message pools.

SCIOPTA - Real-Time Kernel
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6.5 Message Passing

Message passing is the favourite method for interprocess communication in SCIOPTA. Contrary to mailbox inter-
process communication in traditional real-time operating systems SCIOPTA is passing messages directly from
process to process.

Only messages owned by the process can be transmitted. A process will become owner if the message is allocated
from the message pool or if the process has received the message. When allocating a message by the sc_msgAlloc
system call the user has to define the message ID and the size.

The size is given in bytes and the sc_msgAlloc function of SCIOPTA chooses an internal size out of a number of
4, 8 or 16 fixed sizes (see also chapter 6.3 “Message Sizes” on page 6-2).

The sc_msgAlloc or the sc_msgRx call returns a pointer to the allocated message. The pointer allows the user to
access the message data to initialize or modify it.

The sending process transmits the message by calling the sc_msgTx system call. SCIOPTA changes the owner of
the message to the receiving process and puts the message in the queue of the receiver process. In reality it is a
linked list of all messages in the pool transmitted to this process.

If the receiving process is blocked at the sc_msgRx system call and is waiting on the transmitted message the ker-
nel is performing a process swap and activates the receiving process. As owner of the message the receiving proc-
ess can now get the message data by pointer access. The sc_msgRx call in SCIOPTA supports selective receiving
as every message includes a message 1D and sender.

If the received message is not needed any longer or will not be forwarded to another process it can be returned to
the system by the sc_msgFree and the message will be available for other allocations.

sc_msgAlloc

sc_msgTx '

sc_msgRx

sc_msgFree

Figure 6-6: Message Sequence Chart of a SCIOPTA Message Passing
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6.6 Message Declaration

The following method for declaring, accessing and writing message buffers minimizes the risk for bad message
accesses and provides standardized code which is easy to read and to reuse.

Very often designers of message passing real-time systems are using for each message type a separate message file
as include file. Every process can use specific messages by just using a simple include statement for this message.
You could use the extension .msg for such include files.

The SCIOPTA message declaration syntax can be divided into three parts:

» Message number definition
e Message structure definition

» Message union declaration

6.6.1 Message Number

6.6.1.1 Description
The declaration of the message number is usually the first line in a message declaration file. The message number

can also be described as message class. Each message class should have a unique message number for identification
purposes.

We recommend to write the message name in upper case letters.

6.6.1.2 Syntax

#define MESSAGE_NAME (<msg_nr>)

6.6.1.3 Parameter

msg_nr Message number (ID)

Message number which should be unique for each message class.

SCIOPTA - Real-Time Kernel
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6.6.2 Message Structure

6.6.2.1 Description

Immediately after the message number declaration usually the message structure declaration follows. We recom-
mend to write the message structure name in lower case letters in order to avoid mixing up with message number
declaration.

The message ID (or message number) id must be the first declaration in the message structure. It is used by the
SCIOPTA kernel to identify SCIOPTA messages. After the message ID all structure members are declared. There
is no limit in structure complexity for SCIOPTA messages. It is only limited by the message size which you are
selecting at message allocation.

6.6.2.2 Syntax

struct <message_name>

{
sc_msgid_t id;
<member_type> <member>;

6.6.2.3 Parameter

message_name Name of the message

id This the place where the message number (or message 1D) will be stored.

member Message data member.

SCIOPTA - Real-Time Kernel
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6.6.3 Message Union

6.6.3.1 Description

All processes which are using SCIOPTA messages should include the following message union declaration.

The union sc_msg is used to standardize a message declaration for files using SCIOPTA messages.

6.6.3.2 Syntax

union  sc_msg

{
sc_msgid_t id;
<message_type_1> <message_name_1>
<message_type 2> <message_name_2>
<message_type 3> <message_ name_3>
};

6.6.3.3 Parameter

id Message 1D

Must be included in this union declaration. It is used by the SCIOPTA kernel to identify SCI-
OPTA messages.

message_name_nMessages which the process will use.

SCIOPTA - Real-Time Kernel
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6.7 Message Number (ID) organization

Message numbers (also called message 1Ds) should be well organized in a SCIOPTA project.

6.7.1 Global Message Number Defines File

All message IDs greater than 0x8000000 are reserved for SCIOPTA internal modules and functions and may not
be used by the application. These messages are defined in the file defines.h. Please consult this file for managing
and organizing the message IDs of your application.

defines.h System wide constant definitions.
File location: <installation_folder>\sciopta\<version>\include\ossys\

6.8 Example

This is a very small example showing how to handle messages in a SCIOPTA process. The process “keyboard”
just allocates a messages fills it with a character and sends it to a process “display”.

#define CHAR_MSG )
typedef struct char_msg_s
sc_msgid_t id;

char character;
} char_msg_t;

union sc_msg
{
sc_msgid_t id;
char_msg_t char_msg;
};
SC_PROCESS (keyboard)
{
sc_msg_t msg; /* Process message pointer */
sc_pid_t to; /* Receiving process ID */
to = sc_procldGet (“display”, SC_NO_TMO); /* Get process ID */
/* for process display */
for (55)
{

msg = msgAlloc(sizeof (char_msg_t), CHAR_MSG, SC_DEAFULT_POOL, SC_NO_TMO);
/* Allocates the message */

msg->char_msg.character = 0x40 /* Loads 0x40 */
sc_msgTx (&msg, to, 0); /* Sends message to process display */
sc_sleep (1000); /* Waits 1000 ticks */

SCIOPTA - Real-Time Kernel
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6.9 Messages and Modules

A process can only allocate a message from a pool inside the same module.
Messages transmitted and received within a module are not copied, only the pointer to the message is transferred.

Messages which are transmitted across modules boundaries are always copied if the Inter-Module setting in the
system configuration utility is set to “always copy”. If it set to never copy, messages between modules are not cop-
ied (see chapter 16.9.1 “General System Configuration Tab” on page 16-8).

A module can be declared as friend of another module. The message which was transmitted from the module to its
declared friend will not be copied. But in return if the friend sends back a message it will be copied. To avoid this
the receiver needs to declare the sender also as friend.

To copy such a message the kernel will allocate a buffer from the default pool of the module where the receiving
process resides. It must be guaranteed that there is a big enough buffer in the receiving module available to fit the
message.

System Module Module Module

(=) (=) | (=)
- Simt &

Pool| |Pool Pool| [Pool| [Pool ' Pool

MMU Segment A MMU Segment B

Figure 6-7: SCIOPTA Messages and Modules

SCIOPTA - Real-Time Kernel
6-8 Manual Version 4.1 User’s Manual



¢

6 Messages SCIOPTA

0

6.10 Message Passing and Scheduling

SCIOPTA uses the preemptive prioritized scheduling for all prioritized process types. Timer process are scheduled
on a cyclic base at well defined time intervals.

The prioritized process with the highest priority is running (owning the CPU). SCIOPTA is maintaining a list of
all prioritized processes which are ready. If the running process becomes not ready (i.e. waiting on at a message
receive which has not yet arrived) SCIOPTA will activate the next prioritized process with the highest priority. If
there are more than one processes on the same priority ready SCIOPTA will activate the process which became
ready in a first-in-first-out methodology.

Interrupt and timer process will always preempt prioritized processes. The intercepted prioritized process will be
swapped in again when the interrupting system on the higher priority has terminated.

Timer processes run on the tick-level of the operating system.

The SCIOPTA kernel will do a re-scheduling at every, receive call, transmit call, process yield call, trigger wait
call, sleep call and all system time-out which have elapsed.

Prioritized Prioritized Prioritized Timer Interrupt
Process 1 Process 2 Process 3 Process Process
" priority 10 " priority 11 T priority 12 Vinterrupt Vinterrupt
| | priority 8 | priority 6

| Will be activated |

sc_msgRx | every third tick.

L
Message not in input

I
I |
queue. Prbcess now sc_sleep(3) | | |
swapped out rmd Waiting. Sleeping for 3 ticks. Process ‘ | ‘ . | | .
. __________ nowswapped outand waiting. _ _ interrupt .~ ¥ ] tick
| | ! return | ! | |
I I I I I
interrupt .
o _I ______________ e L[| empt | — = _| _____ tick+1
| | [ ] 1
| Sleepind of three tick expired. | | |
Message an arrived Process [eady and swapped in. | | 9 | tick+2
and received. Process @ e o -_E_ ___________________
ready and swapped in. | [ [ 1" ™ |
I I I I I
) | | interrupt | | V ________ o tick+3
| ! return ! | | | |
I I I I |
| | ! | | tick+4
| | [ 1 |
| | I I |
L1 | | | |

Figure 6-8: Scheduling Sequence Example
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6 Messages

Message System Calls

Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the SCIOPTA system calls.

sc_msgAlloc

sc_msgAllocClr

sc_msgTx
sc_msgTxAlias
sc_msgRx
sc_msgFree
sc_msgAcquire
sc_msgAddrGet
sc_msgHookRegister
sc_msgOwnerGet
sc_msgPoolldGet
sc_msgSizeGet
sc_msgSizeSet

sc_msgSndGet

Allocates a memory buffer of selectable size from a message pool.

Allocates a memory buffer of selectable size from a message pool and initializes the mes-
sage data to 0.

Sends a message to a process.

Sends a message to a process by setting any process ID.
Receives one ore more defined messages.

Returns a message to the message pool.

Changes the owner of the message. The caller becomes the owner of the message.
Returns the process ID of the addressee of the message.
Registers a message hook.

Returns the process ID of the owner of the message.
Returns the pool ID of a message.

Returns the size of the message buffer.

Modifies the size of a message buffer.

Returns the process ID of the sender of the message.

6-10
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7 Pools

7.1 Introduction

Messages are the main data object in SCIOPTA. Messages are allocated by processes from message pools. If a
process does not need the messages any longer it will be given back (freed) by the owner process.

There can be up to 127 pools per module for a standard kernel (32-bit) and up to 15 pools for a compact kernel (16-
bit). Please consult chapter 4 “Modules” on page 4-1 for more information about the SCIOPTA module concept.
The maximum number of pools will be defined at module creation. A message pool always belongs to the module
from where it was created.

The size of a pool will be defined when the pool will be created. By killing a module the corresponding pool will
also be deleted.

Pools can be created, killed and reset freely and at any time.

The SCIOPTA kernel is managing all existing pools in a system. Messages are maintained by double linked list in
the pool and SCIOPTA controls all message lists in a very efficient way therefore minimizing system latency.

7.2 Message Pool size

The minimum message pool size is the size of the maximum number of messages which ever are allocated at the
same time plus the pool control block (pool_cb).

The pool control block (pool_ch) can be calculated according to the following formula:

pool cb=68 + n*20 + stat*n* 20

where:
n Number of buffer sizes (4, 8 or 16)
stat process statistics or message statistics are used (1) or not used (0)
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7.3 Pool Message Buffer Memory Manager

If a process allocates a message there is also the size to be given. The user just gives the number of bytes needed.
SCIOPTA is not returning the exact amount of bytes requested but will select one of a list of buffer sizes which is
large enough to contain the requested number. This list can contain 4, 8 or 16 sizes which will be defined when a
message pool is created.

The difference of requested bytes and returned bytes can not be accessed by the user and will be unused. It is there-
fore very important to select the buffer sizes to match as close as possible those needed by your application to waste
as little memory as possible.

The pool buffer manager used by SCIOPTA is a very well known technique in message based systems. The SCI-
OPTA memory manager is very fast and deterministic. Memory fragmentation is completely avoided. But the user
has to select the buffer sizes very carefully otherwise there can be unused memory in the system.

As you can have more than one message pool in a SCIOPTA system and you can create and Kill pools at every
moment the user can adapt message sizes very well to system requirements at different system states because each
pool can have a different set of buffer sizes.

By analysing a pool after a system run you can find out unused memory and optimise the buffer sizes.

7.3.1 Example

A message pool is created with 8 buffer sizes with the following sizes: 4, 10, 20, 80, 200, 1000, 4048, 16000.

If a message is allocated from that pool which requests 300 bytes, the system will return a buffer with 1000 bytes.
The difference of 700 bytes is not accessible by the user and is wasted memory.

If 300 bytes buffer are used more often, it would be good design to modify the buffer sizes for this pool by changing
the size 200 to 300.

7.3.2 Message Administration Block

Each SCIOPTA message contains a hidden data structure which will be used by the kernel. The user can access
these message information only by specific SCIOPTA system calls. Information such as the process ID of the mes-
sage owner, the message size, the process ID of the transmitting process and the process ID of the addressed proc-
ess are included in the message header administration block. Please consult chapter 5.3 “Messages” on page 5-7
for more information about SCIOPTA messages. The size of the message header is 32 bytes.

Each SCIOPTA message can contain an end-mark. This end-mark is used for the kernel message check if the mes-
sage check option is enabled at kernel configuration. Please consult the configuration chapter of the SCIOPTA tar-
get manual for more information about message check. The size of the end-mark is 4 bytes.

Please consult chapter 6 “Messages” on page 6-1 for more information about message sizes and message memory
management.
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7.4 Creating Pools

7.4.1 Static Pool Creation

Static pools are pools which are automatically created when the systems boots up. They are defined in the SCONF
configuration tool.

&4 Sciopta System Configuration C:/P/titi.xml

File Edit Module Help

===

Configuration Tree Structure |
sc@wﬁ TCS
23 TCS

B- T s

Create Pool
Create Interrupk Process
Create Timer Process

Create Priority Process

Delete Module

Figure 7-2: Pool Creation by SCONF

Please consult chapter 16.12 “Creating Processes and Pools” on page 16-18 for more information about module
creation by the SCONF tool.

7.4.2 Dynamic Pool Creation

Another way is to create modules dynamically by the sc_poolCreate system call.

static const sc_bufsize_t bufsizes[8]=

{

};

myPool_plid = sc_poolCreate(
/* start-address */ 0,
/* total size */ 4000,
/* number of buffers */ 8,
/* buffersizes */ bufsizes,
/* name */ "myPool™

Figure 7-3: Dynamic Module Creation
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7.5 Pool System Calls

Please consult the SCIOPTA - Kernel V2, Reference Manual for detailed description of the SCIOPTA system calls.

sc_poolCreate Creates a message pool.

sc_poolDefault Sets a message pool as default pool.
sc_poolHookRegister Registers a pool hook.

sc_poolldGet Returns the ID of a message pool.
sc_poolinfo Returns a snap-shot of a pool control block.
sc_poolKill Kills a whole message pool.

sc_poolReset Resets a message pool in its original state.

SCIOPTA - Real-Time Kernel
7-4 Manual Version 4.1 User’s Manual



¢

8 SCIOPTA Trigger SCIOPTA

0

8 SCIOPTA Trigger

8.1 Description

The trigger in SCIOPTA is a method which allows to synchronise processes even faster as it would be possible
with messages. With a trigger a process will be notified and woken-up by another process. Trigger are used only
for process coordination and synchronisation and cannot carry data. Triggers should only be used if the designer
has severe timing problems and are intended for these rare cases where message passing would be to slow.

Each process has one trigger available. A trigger is basically a integer variable owned by the process. At process
creation the value of the trigger is initialized to one.

Process waiting
on the trigger

Trigger Process issuing a
trigger event

sc_triggerWait()

_trigger()

Figure 8-1: SCIOPTA Trigger

8.2 Using SCIOPTA Trigger

There are four system calls available to work with triggers. The sc_triggerWait call decrements the value of the
trigger and the calling process will be blocked and swapped out if the value gets negative or equal zero. Only the
owner process of the trigger can wait for it. An interrupt process cannot wait on its trigger. The process waiting on
the trigger will become ready when another process triggers it by issuing a sc_trigger call which will make the
value of the trigger nonnegative.

The process which is waiting on a trigger can define a time-out value. If the time-out has elapsed it will be triggered
(become nonnegative) by the operating system (actually: The previous state of the trigger is restored). If the now
ready process has a higher priority than the actual running process the operating system will preempt the running
process and execute the triggered process.

The sc_triggerValueSet system calls allows to sets the value of a trigger. Only the owner of the trigger can set the
value. Processes can also read the values of trigger by the sc_triggerValueGet call.

Also interrupt processes have a trigger but they cannot wait on it. If a process is triggering an interrupt process, the
interrupt process gets a software event. This is the same as if an interrupt occurs. The user can investigate a flag
which informs if the interrupt process was activated by a real interrupt or woken-up by such a trigger event.

SCIOPTA - Real-Time Kernel
User’'s Manual Manual Version 4.1 8-1



¢

SCIOPTA 8 SCIOPTA Trigger

¢

8.3 Trigger Example

This is a very small example how triggers can be used in SCIOPTA processes. A prioritized process is waiting on
its trigger and will be executed when another process (in this case an interrupt process) is activating the trigger.

/* This is the interrupt process activating the trigger of process trigproc */
extern sc_pid_t trigproc_pid

0S_INT_PROCESS (myint, 0)
{

sc_trigger (trigproc_pid); /* This call makes process trigproc ready */

}

/* This is the prioritized process trigproc which waits on its trigger */

SC_PROCESS (trigproc)

{
/* At process creation the value of the trigger is initialized */
/* to zero. If this is not the case you have to initialize it with */
/* the sc_triggerValueSet() system call */
for (3)
{
sc_triggerWait(l,SC_ENDLESS_TMO); /* Process waits on the trigger */
/* Trigger was activated by process myint */
¥
}

SCIOPTA - Real-Time Kernel
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8.4 Trigger System Calls

Please consult the SCIOPTA - Kernel V2, Reference Manual for detailed description of the SCIOPTA system calls.
sc_trigger Signals a process trigger.

sc_triggerValueGet  Returns the value of a process trigger.

sc_triggerValueSet Sets the value of a process trigger.

sc_triggerWait Waits on its process trigger.
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9 Time Management

9.1 Introduction

Time management is one of the most important tasks of a real-time operating system. There are many functions in
SCIOPTA which depend on time. A process can for example wait a specific time for a message to arrive from an-
other process or process can be suspended for a specific time or timer processes can be defined which are activated
at specific time intervals.

9.2 System Tick

Time is managed by SCIOPTA by a tick timer which can be selected and configured by the user.

Typical time values between two ticks range between one and then milliseconds. It is important to define the tick
value to small as at every tick the kernel has some system work to perform, such as checking time-out and sched-
uling timer processes.

System tick should only be used for time-out and timing functions higher than one system tick. For very precise
timing tasks it is better to use SCIOPTA interrupt processes connected to a CPU hardware timer.
9.2.1 Configuring the System Tick

The system tick is configured by the sciopta configuration utility (see chapter 16.9.2 “Timer and Interrupt Config-
uration Tab” on page 16-11).

FPowerPC Settlings Buitd Diccto:  [D:\Manual\dummympcite: | 23]

General | Timer /Intsmupt | Hooks | Debug |
Timer
Soucs Deciementer  *
Tick inus fom™
Frequency in Hz lmnnn—

Apply Cance/

Figure 9-1: Tick Timer Configuration

You can use either an internal specific timer for tick or configure an external timer. If an external timer is used a
tick interrupt process must be specified which will call sc_tick at regular intervals.
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9.2.2  External Tick Interrupt Process

An external tick interrupt process is usually included in the board support package.

systick.S System tick interrupt process.
File location: <installation_folder>\sciopta\<version>\bsp\<arch>\<cpu>\

9.3 Timing System Calls

Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the SCIOPTA system calls.

sc_sleep Suspends a process for a defined time.

sc_tick Calls the kernel tick function. Advances the kernel tick counter by 1.
sc_tickGet Returns the actual kernel tick counter value.

sc_tickLength Returns/sets the current system tick-length.

sc_tickMs2Tick Converts a time from milliseconds into ticks.

sc_tickTick2Ms Converts a time from ticks into milliseconds.

SCIOPTA - Real-Time Kernel
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9.4 Timeout Server

9.4.1 Introduction

SCIOPTA has a built-in message based time-out server. Processes can register a time-out job at the time-out server.
This done by the sc_tmoAdd system call which requests a time-out message from the kernel after a defined time.

9.4.2 Using the Timeout Server

The caller needs to allocate a message and include the pointer to this message in the call. The kernel will send this
message back to the caller after the time has expired.

A time-out is requested by the sc_tmoAdd system call.
This is an asynchronous call, the caller will not be blocked.

The registered time-out can be cancelled by the sc_tmoRm call before the time-out has expired.

9.5 Timeout Server System Calls

Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the SCIOPTA system calls.
sc_tmoAdd Request a time-out message after a defined time.

sc_tmoRm Remove a time-out job.

SCIOPTA - Real-Time Kernel
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10 Error Handling

10.1 Introduction

SCIOPTA has many built-in error check functions. The following list shows some examples.

« When allocating a message it is checked if the requested buffer size is available and if there is still enough mem-
ory in the message pool.

* Process identities are verified in different kernel functions.

» Ownership of messages are checked.

» Parameters and sources of system calls are validated.

» The kernel will detect if messages and stacks have been over written beyond its length.

Contrary to most conventional real-time operating systems, SCIOPTA uses a centralized mechanism for error re-
porting, called Error Hook. In traditional real-time operating systems, the user needs to check return values of sys-
tem calls for a possible error condition. In SCIOPTA all error conditions will end up in the Error Hook. This
guarantees that all errors are treated and that the error handling does not depend on individual error strategies which
might vary from user to user.

10.2  Error Sequence

In SCIOPTA all error conditions will end up in an Error Hook. This guarantees that all errors are treated and that
the error handling does not depend on individual error strategies which might vary from user to user.

There are two error hooks available:
A) Module Error Hook
B) Global Error Hook

If the kernel detect an error condition it will first call the module error hook and if it is not available call the global
error hook. Error hooks are normal error handling functions and must be written by the user. Depending on the type
of error (fatal or nonfatal) it will not be possible to return from an error hook.

If there are no error hooks present the kernel will enter an infinite loop (at label SC_ERROR) and all interrupts
are disabled.
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10.3 Error Hook

In SCIOPTA all error conditions will end up in the error hook. As already stated there are two error hooks availa-

10 Error Handling

ble: the Module Error Hook and the Global Error Hook.

An error hook can only use the following system calls:

(Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the SCIOPTA system calls.)

sc_miscCrc
ssc_miscCrcContd
sc_miscErrnoGet
sc_moduleldGet
sc_modulelnfo
sc_moduleNameGet
sc_poolldGet
sc_poolinfo
sc_procPpidGet
sc_procPrioGet
sc_procSliceGet
sc_procVarDel
sc_procVarGet
sc_procVarSet
sc_tickGet
sc_tickLength
sc_tickMs2Tick
sc_tickTick2Ms
sc_triggerValueGet

Calculates a 16 bit CRC over a specified memory range.
Calculates a 16 bit CRC over an additional memory range.
Returns the process error number (errno) variable.

Returns the ID of a module.

Returns a snap-shot of a module control block (mcb).
Returns the name of a module.

Returns the ID of a message pool.

Returns a snap-shot of a pool control block.

Returns the process ID of the parent (creator) of a process.
Returns the priority of a prioritized process.

Returns the time slice of a timer process.

Removes a process variable from the process variable data area.
Returns a process variable.

Defines or modifies a process variable.

Returns the actual kernel tick counter value.

Sets the current system tick length in micro seconds.
Converts a time from milliseconds into system ticks.
Converts a time from system ticks into milliseconds.
Returns the value of a process trigger.

10-2
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10.3.1 Error Information

When an error hook is called from the kernel, all information about the error are transferred in 32-bit error word
(parameter errcode). Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the
SCIOPTA error word. There is also an additional 32-bit extra error word available to the user.

Function Code Error Code Error Type
< 8 Bits > < 12 Bits > 12 Bits >
< 32 Bits >

Figure 10-1: 32-bit Error Word (Parameter: errcode)

The Function Code defines from which SCIOPTA system call the error was initiated.
The Error Code contains the specific error information.

The Error Type informs about the source and type of error.

There are three error types in a SCIOPTA kernel.

e SC_ERR_SYSTEM_FATAL, system wide fatal error.
e SC_ERR_MODULE_FATAL, module wide fatal error.
» SC_ERR_PROCESS_FATAL, process wide fatal error.

There are three error warnings in a SCIOPTA kernel.

* SC_ERR_SYSTEM_WARNING, system wide warning.
« SC_ERR_MODULE_WARNING, module wide warning.
» SC_ERR_PROCESS_WARNING, process wide warning.

10.3.2 Error Hook Registering

An error hook is registered by using the sc_miscErrorHookRegister system call.

If the error hook is registered from within the system module it is registered as a global error hook. In this case the
error hook registering will be done in the start hook.

If the error hook is registered from within a module which is not the system module it will be registered as a module
error hook.
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10.3.3 Error Hook Declaration Syntax

10.3.3.1 Description

For each registered error hook there must be a declared error hook function.

10.3.3.2 Syntax

int <err_hook_name> (sc_errcode_t errcode, sc_extra_t extra, int user, sc_pcb_t *pcb)

{

. error hook code

¥

10.3.3.3 Parameter

errcode Error word.

Error word containing the function code which defines from which SCIOPTA system call the er-
ror was initiated, the error code which contains the specific error information and the error type
which informs about the source and type of error.

extra Error extra word.

Gives additional information depending on the error code.

user User/system error flag.

1=0 User error.
== System error.

error Error word.

Error word containing the function code which defines from which SCIOPTA system call the er-
ror was initiated, the error code which contains the specific error information and the error type
which informs about the source and type of error.

pcb Process control block.

Pointer to process control block of the process where the error occurred. Please consult pch.h for
more information about the module control block structure.
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10.3.4 Error Hook Example

#include "sconf.h"
#include <sciopta.h>
#include <ossys/errtxt.h>

#if SC_ERR_HOOK ==
int error_hook(sc_errcode_t err,void *ptr,int user,sc_pcb_t *pcb)
{
kprintf(9,"Error\n %08Ix(%s,line %d in %s) %08Ix %8Ix %08Ix %08Ix\n",
(int)pcb>1 ? pcb->pid:0,
(int)pcb>1 ? pcb->name:"'xx",
(int)pcb>1 ?pcb->cline:0,
(int)pcb>1 ?pcb->cfile:""xx",
pcb,
err,
ptr,
user);
if Cuser I=1 &&
((err>>12)&0xfff) <= SC_MAXERR &&
(err>>24) <= SC_MAXFUNC )

kprintf(0,"Function: %s\nError: %s\n",
func_txt[err>>24],
err_txt[(err>>12)&0xfff]);

}

return O;

b
#endif
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10.3.5 Error Hooks Return Behaviour

The actions of the kernel after returning from the module or global error hook depend on the error hook return val-
ues and the error types as described in the following table.

Global Error Module Error Error Action
Hook Hook Type
. return . return Module
exists exists
value value | Error Fatal
No - No - X Endless loop.
0 Yes Endless loop.
No Endless loop.
Yes No _
1 Yes Kill module and swap out.
No Return & continue.
0 0 Yes Endless loop.
No Endless loop.
1 0 Yes Kill module and swap out.
No Return & continue.
Yes Yes _
0 L Yes Kill module and swap out.
No Return & continue.
1 L Yes Kill module and swap out.
No Return & continue.
0 Yes Endless loop.
No Endless loop.
No Yes _
L Yes Kill module and swap out.
No Return & continue.

10-6
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10.4 The errno Variable

Each SCIOPTA process has an errno variable. This variable is used mainly by library functions to set the errno
variable. The errno variable can only be accessed by some specific SCIOPTA system calls.

The errno variable will be copied into the observe messages if the process dies.
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11 System Start and Setup

11.1  Start Sequence

After a system hardware reset the following sequence will be executed from point 1.

In the SCIOPTA SCSIM Simulator after Windows has started the SCIOPTA application by calling the
sciopta_start function inside the WinMain function the sequence will be executed from point 4.

1. The kernel calls the function reset_hook.

2. The kernel performs some internal initialization.

3. The kernel calls cstartup to initialize the C system.
4. The kernel calls the function start_hook.
5

The kernel calls the function TargetSetup. The code of this function is automatically generated by the
SCONF configuration utility and included in the file sconf.c. TargetSetup creates the system module.

6. The kernel calls the dispatcher.
7. The first process (init process of the system module) is swapped in.

The code of the following functions is automatically generated by the SCONF configuration utility and included
in the file sconf.c.

8. The init process of the system module creates all static modules, processes and pools.

9. The init process of the system module calls the system module start function. The name of the function cor-
responds to the name of the system module.

10. The process priority of the init process of the system module is set to 32 and loops for ever.

11. Theinit process of each created static module calls the user module start function of each module. The name
of the function corresponds to the name of the respective module.

12. The process priority of the init process of each created static module is set to 32 and loops for ever.

13. The process with the highest system priority will be swapped-in and executed.
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11.2 Reset Hook

In SCIOPTA a reset hook must always be present and must have the name reset_hook.
The reset hook must be written by the user.
After system reset the SCIOPTA kernel initializes a small stack and jumps directly into the reset hook.

The reset hook is mainly used to do some basic chip and board settings. The C environment is not yet initialized
when the reset hook executes (stackpointer not yet initialized). Therefore the reset hook should be written in as-
sembler. For some C environments it might be written in C.

There is no reset hook in the SCIOPTA SCSIM Simulator.

11.2.1 Syntax

int reset_hook (void);

11.2.2 Parameter

None.

11.2.3 Return Value

If it is set to =0 then the kernel will immediately call the dispatcher. This will initiate a warm start.

If it is set to O then the kernel will jump to the C startup function. This will initiate a cold start.

11.2.4 Location

Reset hooks are compiler manufacturer and board specific. Reset hook examples can be found in the SCIOPTA
Board Support Package deliveries.

resethook.S Very early hardware initialization code written in assembler.
The extension .S is used in GCC for assembler source files. For other compiler packages the ex-
tensions for assembler source files might be different.
File location: <installation_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\src
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11.3 C Startup

After a cold start the kernel will call the C startup function. The C startup function is written in assembler and has
the name cstartup. It initializes the C system and replaces the library C startup function. C startup functions are
compiler specific.

For IAR Embedded Workbench there is no C startup function needed.
There is no C startup function needed in the SCIOPTA SCSIM Simulator.

11.3.1 Location

Reset hooks are compiler manufacturer and board specific. Reset hook examples can be found in the SCIOPTA
Board Support Package deliveries.

cstartup.S C System initialization.
The extension .S is used in GCC for assembler source files. For other compiler packages the ex-
tensions for assembler source files might be different.
File location: <installation_folder>\sciopta\<version>\bsp\<arch>\src\

11.4  Starting the SCIOPTA SCSIM Simulator

Only for the SCIOPTA SCSIM Simulator:

You need to write the WinMain method and include the sciopta_start system call to implement a SCIOPTA
WIN32 application.

Please consult the SCIOPTA - Kernel, Reference Manual for more information about the sciopta_start system
call.

In the delivered SCIOPTA examples the WinMain method and the whole startup code is usually included in the
file system.c.

system.c SCIOPTA SCSIM Simulator setup including the WinMain method.
File location: <installation_folder>\sciopta\<version>\exp\krn\win32\hello\

11.4.1 Module Data RAM

In SCIOPTA system running in a real target CPU the module RAM memory map is defined in the linker scripts.

In the SCIOPTA SCSIM Simulator you need to declare the module RAM by a character array of the size of the
module.

Please consult chapter 15.7.6.1 “Module Data RAM” on page 15-17.
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The start hook must always be present and must have the name start_hook. The start hook must be written by the
user. If a start hook is declared the kernel will jump into it after the C environment is initialized.

The start hook is mainly used to do chip, board and system initialization. As the C environment is initialized it can
be written in C. The start hook would also be the right place to include the registration of the system error hook
(see chapter 10.3.2 “Error Hook Registering” on page 10-3) and other kernel hooks.

11.5.1 Syntax

void start_hook (void);

11.5.2 Parameter

None.

11.5.3 Return Value

None.

11.5.4 Location

In the delivered SCIOPTA examples the start hook is usually included in the file system.c

system.c System configuration file including hooks (e.g. start_hook) and other setup code.
File location:
<installation_folder>\sciopta\<version>\exp\<product>\<arch>\<example>\<board>\

11.6 Init Processes

The init process is the first process in a module. Each module has at least one process and this is the init process.
At module start the init process gets automatically the highest priority (0). After the init process has done some
important work it will change its priority to the lowest level (32) and enter an endless loop.

Priority 32 is only allowed for the init process. All other processes are using priority 0 - 31. The INIT process acts
therefore also as idle process which will run when all other processes of a module are in the waiting state.

The init process of the system module will first be swapped-in followed by the init processes of all other modules.

The code of the module init Processes are automatically generated by the SCONF configuration utility and placed
in the file sconf.c. The module init Processes will automatically be named to <module_name>_init and created.

Please consult chapter 5.9 “Init Processes” on page 5-8.

11.7 Module Start Functions

Please consult chapter 4 “Modules” on page 4-1 for general information about SCIOPTA modules.
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11.7.1 System Module Start Function

After all static modules, pools and processes have been created by the init Process of the system module the kernel
will call a system module start function. This is function with the same name as the system module and must be
written by the user. Blocking system calls are not allowed in the system module start function. All other system
calls may be used.

In the delivered SCIOPTA examples the system module start function is usually included in the file system.c:

system.c System configuration file including hooks (e.g. start_hook) and other setup code.
File location:
<installation_folder>\sciopta\<version>\exp\<product>\<arch>\<example>\<board>\

11.7.2 User Module Start Function

All other user modules have also own individual module start functions. These are functions with the same name
of the respective defined and configured modules which will be called by the init Process of each respective mod-
ule.

After returning from the module start functions the init Processes of these modules will change its priority to 32
and go into sleep. These user module start functions can use all SCIOPTA system calls.
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12 Additional Functions

12.1 Introduction

In this chapter we are listing some additional functions of the kernel which are used for specific needs and projects.

12.2 Hooks

Hooks are user written functions which are called by the kernel at different location. They are only called if the
user defined them at configuration. User hooks are used for a number of different purposes and are target system
dependent.

Hooks need to be declared in the SCIOPTA kernel configuration (SCONF).

win32 Settings Build Directory: |. =
General | Hooks | Debug I
W Pre| Coldfire Settings Build Directory: |- =
7 1| General | Hooks IDebucl |
Pt ¥ ProcessHooks [ M| Arm Settings Buid Directory: | =
f ¢ Hook
¥ Create I General | ooks I Debug I I
v Kil I V¥ Process Hooks v = —
B S PowerPC Seﬂings Biuild Drirectary: ID:\Manuals\dummy\mpcSSxx EF"I
v Create
General | Timer £ Intemupt | Hooks I Debug |
¥ Kil
¥ Swap ¥ Process Hooks W Message Hooks W PoolHooks W Ermor Hook
I MU V' Create V' MzgRx V' Create
I kil ¥ MsgTx I kil
V' Swap
™ MMU

Lpply Lancel

Figure 12-1: Hook Configuration

Please consult chapter 16.9.3 “Hooks Configuration Tab” on page 16-12 for more information.

Additionally you need also need to declare hooks by using specific system calls.
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12.3 Error Hook

The error hook is the most important user hook function and should normally be included in most of the systems.
An error hook can be used to log the error and additional data on a logging device if the kernel has detected an error
condition.

The error hook has been described in chapter 10.3 “Error Hook” on page 10-2.

12.4 Message Hooks

In SCIOPTA you can configure Message Transmit Hooks and Message Receive Hooks. These hooks are called
each time a message is transmitted to any process or received by any process. Transmit and Receive Hooks are
mainly used by user written debugger to trace messages.

12.4.1 Registering Message Hooks

Message hooks must be registered by specific system calls. Please consult the SCIOPTA - Kernel, Reference Man-
ual for detailed description of the SCIOPTA system calls.

sc_msgHookRegister Registers a message hook.

12.5 Process Hooks

If the user has configured Process Create Hooks and Process Kill Hooks into the kernel these hooks will be called
each time if the kernel creates or Kills a process.

SCIOPTA allows to configure a Process Swap Hook. The Process Swap Hook is called by the kernel each time a
new process is about to be swapped in. This hook is also called if the kernel is entering idle mode.

12.5.1 Registering Process Hooks

Process hooks must be registered by specific system calls. Please consult the SCIOPTA - Kernel, Reference Man-
ual for detailed description of the SCIOPTA system calls.

sc_procHookRegister Registers a process hook.

12.6 Pool Hooks

Pool Create Hooks and Pool Kill Hooks are available in SCIOPTA mainly for debugging purposes. Each time a
pool is created or killed the kernel is calling these hooks provided that the user has configured the system accord-

ingly.

12.6.1 Registering Pool Hooks

Pool hooks must be registered by specific system calls. Please consult the SCIOPTA - Kernel, Reference Manual
for detailed description of the SCIOPTA system calls.

sc_poolHookRegister Registers a pool hook.

SCIOPTA - Real-Time Kernel
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12.7 Exception Handling

12.7.1 Introduction

Exception handling for SCIOPTA is mainly done inside the kernel. Depending on the CPU family there might be
some external functions needed. They are usually supplied by SCIOPTA and included in the board support package
of the delivery.

12.7.2 SCIOPTA ARM Exception Handling

12.7.2.1 ARM Architecture Exception Handler Files

cortexm3_exception.<ext>Exception handler for Cortex-M3.
cortexm3_vector.<ext>  Vector table for Cortex-M3.
exception.<ext> Global exception handler for all ARM except Cortex-M3.

File extensions <ext>: S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\arm\src\gnu\

s79  1AR Version 4.x
File location: <install_folder>\sciopta\<version>\bsp\arm\src\iar\

S IAR Version 5.x
File location: <install_folder>\sciopta\<version>\bsp\arm\src\iar\

S ARM RealView
File location: <install_folder>\sciopta\<version>\bsp\arm\src\arm\

Usually there is no need to modify the exception handlers.

12.7.2.2 ARM CPU Family Interrupt Handler Files

irg_handler.<ext> Interrupt handler.
irg_handler_mmu.<ext> Interrupt handler including MMU support only for XScale
<file_name>_irqg.<ext> Interrupt handler for specific CPUs (LPC2000).

File extensions <ext>: S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\gnu\

s79  1AR Version 4.x
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\iar\

S IAR Version 5.x
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\iar\

s ARM RealView
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\arm\

Usually there is no need to modify the interrupt handlers. The interrupt handler safes the cpu context and calls the
kernel with the interrupt vector number.

The interrupt controller is initialized in the resethook (see also chapter 11.2 “Reset Hook™” on page 11-2).

SCIOPTA - Real-Time Kernel
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12.7.2.3 ARM Architecture Interrupt Vectors Files

The interrupt vectors are usually defined in the resethook (see also chapter 11.2 “Reset Hook™ on page 11-2). For
some CPUs the vectors are defined in specific vector definition file or in the interrupt handler.

cortexm3_vector.<ext>  Vector table for Cortex-Ma3.

File extensions <ext>: S GNU GCC

File location: <install_folder>\sciopta\<version>\bsp\arm\src\gnu\
s79  1AR Version 4.x

File location: <install_folder>\sciopta\<version>\bsp\arm\src\iar\
S IAR Version 5.x

File location: <install_folder>\sciopta\<version>\bsp\arm\src\iar\
S ARM RealView

File location: <install_folder>\sciopta\<version>\bsp\arm\src\arm\

Usually there is no need to modify the vector table.

SCIOPTA - Real-Time Kernel
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12.7.3 SCIOPTA PowerPC Exception Handling

12.7.3.1 PowerPC CPU Family Exception Handling Files
exception.<ext> PowerPC kernel - exception handling.

File extensions <ext>: S GNU GCC and Windriver
File location: <install_folder>\sciopta\<version>\bsp\ppc\<cpu>\src\

Usually there is no need to modify the exception handlers.
The vector table is included int the file exception.<ext>.

Interrupt handling is included int the file exception.<ext>.

12.7.3.2 PowerPC Interrupt Macros

The file exception.<ext> uses some specific interrupt macros which are defined in irg.S.

irq.S Interrupt macros.
File location: <installation_folder>\sciopta\<version>\include\machine\ppc\

12.7.4 SCIOPTA ColdFire Exception Handling

Exception handling in SCIOPTA ColdFire is completely done in the kernel. The structure of the vector table for
ColdFire systems is always the same. The vector table is initialized by the reset hook.

SCIOPTA - Real-Time Kernel
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12.8 Trap Interface

In a typical monolithic SCIOPTA systems the kernel functions are directly called.

In more complex dynamic systems using load modules or MMU protected modular systems the kernel functions
cannot be accessed any more by direct calls.

SCIOPTA offers a trap interface. In such systems you need to assemble the CPU dependent file syscall.S.

syscall.S SCIOPTA kernel trap interface trampoline functions.
The extension .S is used in GCC for assembler source files. For other compiler packages the ex-
tensions for assembler source files might be different.
File location: <installation_folder>\sciopta\<version>\include\machine\<arch>\

This file includes another file with the same name containing CPU independent trap interface functions.

syscall.S SCIOPTA kernel trap interface trampoline functions, not CPU dependent.
The extension .S is used in GCC for assembler source files. For other compiler packages the ex-
tensions for assembler source files might be different.
File location: <installation_folder>\sciopta\<version>\include\machine\

SCIOPTA - Real-Time Kernel
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12.9 Distributed Systems

12.9.1 Introduction

SCIOPTA is a message based real-time operating system and therefore very well adapted for designing distributed
multi-CPU systems. Message based operating systems where initially designed to fulfil the requirements of dis-
tributed systems.

12.9.2 CONNECTORS

CONNECTORS are specific SCIOPTA processes and responsible for linking a number of SCIOPTA Systems.
There may be more than one CONNECTOR process in a system or module. CONNECTOR processes can be seen
globally inside a SCIOPTA system by other processes. The name of a CONNECTOR process must be identical to
the name of the remote target system.

SCIOPTA System B

SCIOPTA System A Pratese
CONNECTOR | List

Process
Remote CONNECTOR B o2
Process Process’
List [ 4 BOL
% ' Process
B 03
Process
AO01
Process’
B 04
Process \
A03
Process
\ BO1
Process
B 02
Process Process s
iy

Process

A12
Process
Process A22
A13

Process
A02

>
. -
s

Figure 12-2: SCIOPTA Distributed System

A connector process can be defined as default connector process. There can be only one default connector process
in a system and it can have any name.
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User’'s Manual Manual Version 4.1 12-7



¢

SCIOPTA 12 Additional Functions

¢

12.9.3 Transparent Communication

If a process in one system (CPU) wants to communicate with a process in another system (CPU) it first will search
for the remote process by using the sc_procldGet system call. The parameter of this call includes the process name
and the path to where to find it in the form: system/module/procname.The kernel transmits a message to the con-
nector including the inquiry.

All connectors start communicating to search for the process. If the process is found in the remote system the con-
nector will assign a free process ID for the system, add it in a remote process list and transmits a message back to
the kernel including the assigned process ID. The kernel returns the process ID to the caller process.

The process can now transmit and receive messages to the (remote) process ID as if the process is local. A similar
remote process list is created in the connector of the remote system. Therefore the receiving process in the remote
system can work with remote systems the same way as if these processes where local.

If a message is sent to a process on a target system which does not exist (any more), the message will be forwarded
to the default connector process.

SCIOPTA - Real-Time Kernel
12-8 Manual Version 4.1 User’s Manual
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13 SCIOPTA Design Hints and Tips

13.1 Introduction

SCIOPTA is a preemptive multi-tasking high performance real-time operating system (rots) for using in embedded
systems. SCIOPTA is a so-called message based rtos that is, interprocess communication and coordination are re-
alized by messages.

A typical system controlled by SCIOPTA consists
of a number of more or less independent programs
called processes. Each process can be seen as if it
had the whole CPU for its own use. SCIOPTA
controls the system by activating the correct proc-
esses according to their priority assigned by the
user. Occurred events trigger SCIOPTA to imme-
diately switch to a process with higher priority.
This ensures a fast response time and guarantees
the compliance with the real-time specifications of
the system.

SCIOPTA
Process

In SCIOPTA processes communicate and cooper-
ate by exchanging messages. Messages can have a
content to move data from one process to the other
or can be empty just to coordinate processes. Of-
ten, process switches can occur as a result of a
message transfer.

SCIOPTA
Message

Besides data and some control structures messages
contain also an identity (number).

This can be used by a process for selecting specific
messages to receive at a certain moment. All other
messages are kept back in the message queue of
the receiving process.

SCIOPTA
Process

Messages are dynamically allocated from a mes-
sage pool. Messages in SCIOPTA include also
ownership. Only messages owned by a process
can be accessed by the process. Therefore only
one process at a time may access a message (the
owner). This automatically excludes access con-
flicts by a simple and elegant method.

SCIOPTA - Real-Time Kernel
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13.2 Some SCIOPTA Design Rules

As already stated in this document, SCIOPTA is a message based real-time operating system. Interprocess com-
munication and synchronization is done by way of message passing. This is a very powerful and strong design tech-
nology. Nevertheless the SCIOPTA user has to follow some rules to design message based systems efficiently and
easy to debug.

o Correct designed SCIOPTA systems should use
SCIOPTA only a few priority levels. When designing a sys-

\ tem avoid to control it with priorities. A system
should be controlled by message passing and mes-
sage flow. Priorities should be used to guarantee

fast response time to external events.

If you identify work which is
concurrent do not try to place
the code in one process. Simul-
taneous work should be placed Avoid to send a lot of messages from a
in different processes. process without waiting for reply mes-
sages. The receiving process might not
be activated until the sender process be-
comes not ready.

Methods and functions which will be accessed from more than
one process must be re-entrant while executing. There are sys-

tem calls to handle per-process local data (sc_procVar®). To simplify the calcu-
lation of stack require-
/ \ \ ments, try to avoid
using of large auto ar-
I/0-ports must be encap- As itis true for all well designed systems, rays in processes writ-
sulated in a SCIOPTA it is strongly recommended to not using ten in C. Rather
process. Otherwise they global variables. If it cannot be avoided allocate a buffer froma
must be treated the same you must disable interrupts or lock the message pool.
way as global variables. scheduler while accessing them.

Always include an Error-
hook in your system. Setting
a breakpoint there allows
you to track down system er-
rors easily.

Do not modify message data (buffers) after you have sent it.

SCIOPTA - Real-Time Kernel
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14 Board Support Packages

14.1 Introduction

A SCIOPTA board support package (BSP) consists of number of files containing device drivers and project files
such as makefiles and linker script for specific boards.

The BSPs are included in the delivery in a specific folder and organized in different directory levels depending on
CPU dependency:

1. General System Functions

2. Architecture System Functions

3. CPU Family System Functions

4. Board System Functions

All BSP files can be found at the following top-level location after you have installed SCIOPTA:

File location: <install_folder>\sciopta\<version>\bsp\

Please consult also the SCIOPTA - Device Driver, User’s and Reference Manual for information about the
SCIOPTA device driver concept.

14.2  General System Functions

General System Functions are functions which are common to all architectures, all CPUs and all boards.
It contains mainly include and source device drivers files for external (not on-chip) controllers.
Generic debugger files might also be placed here.

File location: <install_folder>\sciopta\<version>\bsp\common\include\
File location: <install_folder>\sciopta\<version>\bsp\common\src\

14.3  Architecture System Functions

Architecture System Functions are functions which are architecture (<arch>) specific (please consult chapter 1.3.1

“Architectures” on page 1-3 for the list of supported architectures) and are common to all CPUs and all boards.

It contains generic linker script include files (module.ld), C startup files (cstartup.S) and other architecture files.

File location: <install_folder>\sciopta\<version>\bsp\<arch>\include\
File location: <install_folder>\sciopta\<version>\bsp\<arch>\src\
File location: <install_folder>\sciopta\<version>\bsp\<arch>\src\<compiler>\

SCIOPTA - Real-Time Kernel
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14.4  CPU Family System Functions

CPU Family System Functions are functions which are architecture (<arch>) specific and CPU family specific
(please consult chapter 1.3.2 “CPU Families” on page 1-3 for the list of supported CPU families) and are common
to all boards.

It contains mainly include and source device drivers files for on-chip controllers.

File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\include\
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\src\
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\src\<compiler>\

14.5 Board System Functions

Board System Functions are functions which are architecture (<arch>) specific, CPU family specific and board
specific.

It contains mainly include, source and project files for board setup.
Debugger initialization files and linker scripts might also placed here.

File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\src\
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\src\<compiler>\

SCIOPTA - Real-Time Kernel
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14.6 Standard ARM7 Boards

Please note that we are supporting many ARM7 based boards. The boards listed here are included in the standard
delivery and maintained within the shipped versions.

14.6.1 ATMEL AT91SAM7AS-EK Board

oo e
J8 Yeft vTAC I

iy

HRL

.STUDIEL.FR

CPU Atmel AT91SAM7A3
BOARD_SEL Makefile board selection number.
22 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =22)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\at91sam7a3-ek\

Log Port Log message port.

J2 DBGU The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.6.2 Atmel AT91SAM7S-EK Board
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f*:':::::::::::::::::: ~an _
. !“;a;a;a‘l.l‘ltdl alals - =
CPU Atmel AT91SAMTS
BOARD_SEL Makefile board selection number.
9 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =9)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\at91sam7s-ek\

Log Port Log message port.

J3 DBGU The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.6.3 Atmel AT91SAM7SE-EK Board
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CPU Atmel AT91SAM7SE
BOARD_SEL Makefile board selection number.
15 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 15)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\at91sam7se-ek\

Log Port Log message port.

J11 SERIAL DEBUG PORT The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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o

14.6.4 Atmel AT91SAM7X-EK Board
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CPU Atmel AT91SAM7X
BOARD_SEL Makefile board selection number.
9 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =9)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\at91sam7se-ek\

Log Port Log message port.

J25 SERIAL DEBUG PORT The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.6.5 Phytec phyCORE-LPC2294 Board

oz

RE HOZ@@ 5V

CPU NXP LPC2294
BOARD_SEL Makefile board selection number.
3 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 3)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\phyCore2294\

Log Port Log message port.

P2 (Lower) The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.6.6 Embedded Artists LPC2468 OEM Board
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CPU NXP LPC2468
BOARD_SEL Makefile board selection number.
17 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =17)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\EA_LPC2468_16_OEM\

Log Port Log message port.

UART #1 The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.6.7 IAR STR711-SK Board

CPU STMicroelectronics STR711

BOARD_SEL Makefile board selection number.

10 To be used as parameter when calling the makefile from Eclipse or from a shell.
(Example: gnu_make BOARD_SEL = 10)
Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\str711-sk\

Log Port Log message port.

RS232 1 The getting started examples are sending some specific example log messages to

a selected UART of the board. Also log daemon message are sent to this port.
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14.7 ARM9 Boards
Please note that we are supporting many ARM9 based boards. The boards listed here are included in the standard

delivery and maintained within the shipped versions.

14.7.1 Atmel AT91SAM9261-EK Board
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CPU Atmel AT91SAM9261
BOARD_SEL Makefile board selection number.
11 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 11)
Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\at91sam9261-ek\

Log Port Log message port.

SERIAL DEBUG PORT The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.7.2 Atmel AT91SAM9263-EK Board
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CPU Atmel AT91SAM9261
BOARD_SEL Makefile board selection number.
20 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 20)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\at91sam9263-ek\

Log Port Log message port.

SERIAL DEBUG PORT The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.7.3 IAR STR912-SK Board
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CPU STMuicroelectronics STR912
BOARD_SEL Makefile board selection number.
12 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =12)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\str912-sk\

Log Port Log message port.

UARTO The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.7.4 LOGIC i.MX27 LITEKIT
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CPU Freescale i.MX27
BOARD_SEL Makefile board selection number.
24 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 24)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\mcimx27lite\

Log Port Log message port.

UARTO The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.8 Standard ARM11 Boards

Please note that we are supporting many ARM11 based boards. The boards listed here are included in the standard
delivery and maintained within the shipped versions.

14.8.1 Phytec phyCORE-iMX35 Board

CPU Freescale i.MX356
BOARD_SEL Makefile board selection number.
24 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 24)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\phyCorei.MX35\

Log Port Log message port.

P1 SERIALL (Lower) The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.9 Standard XScale Boards

Please note that we are supporting many XScale based boards. The boards listed here are included in the standard
delivery and maintained within the shipped versions.

14.9.1 Phytec phyCORE-PXA270 Board

it LEAATS

il

CPU Marvel PXA270

BOARD_SEL Makefile board selection number.

14 To be used as parameter when calling the makefile from Eclipse or from a shell.
(Example: gnu_make BOARD_SEL = 14)
Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\phyCorePXA270\

Log Port Log message port.

FF-UART The getting started examples are sending some specific example log messages to

a selected UART of the board. Also log daemon message are sent to this port.
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14.9.2 CompulLab SBC-X270 Board

CPU Marvel PXA270
BOARD_SEL Makefile board selection number.
18 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 18)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\cm-x270\

Log Port Log message port.

UART The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.

SCIOPTA - Real-Time Kernel
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14.9.3 Toradex Colibri PXA320

CPU Marvel PXA320
BOARD_SEL Makefile board selection number.
23 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 23)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\ColibriPX A320\

Log Port Log message port.

UART The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.10 Standard Cortex-M3 Boards

Please note that we are supporting many Cortex-M3 based boards. The boards listed here are included in the stand-
ard delivery and maintained within the shipped versions.

14.10.1 Olimex STM32-P103 Board

CPU STMuicroelectronics STM32F103RBT6
BOARD_SEL Makefile board selection number.
25 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 25)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\stm32-p103\

Log Port Log message port.

RS232 2 The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.

SCIOPTA - Real-Time Kernel
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14.10.2 STMicroelectronics STM3210E-EVAL Evaluation Board

CPU STMicroelectronics STM32F103Z

BOARD_SEL Makefile board selection number.

28 To be used as parameter when calling the makefile from Eclipse or from a shell.
(Example: gnu_make BOARD_SEL = 28)
Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\stm3210e-eval\

Log Port Log message port.

USART_2 The getting started examples are sending some specific example log messages to

a selected UART of the board. Also log daemon message are sent to this port.
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14.10.3 Texas Instruments Stellaris LM3S6965 Board
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CPU Texas Instruments Stellaris LM3S6965

BOARD_SEL Makefile board selection number.

26 To be used as parameter when calling the makefile from Eclipse or from a shell.
(Example: gnu_make BOARD_SEL = 26)
Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\ek-Im3s6965\

Log Port Log message port.

None The getting started examples are sending some specific example log messages to

a selected UART of the board. Also log daemon message are sent to this port.

14-20
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14.11 Standard Cortex-R4F Boards

Please note that we are supporting many Cortex-R4 based boards. The boards listed here are included in the stand-
ard delivery and maintained within the shipped versions.

14.11.1 Texas Instruments TMS570PSFC66-EVAL Board

CPU Texas Instruments TMS570PSFC66
BOARD_SEL Makefile board selection number.
XX To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = xx)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\tms570psfc66-eval\

No makefile yet available (all project with IAR Embedded Workbench)

Log Port Log message port.

UARTO (via USB) The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.

SCIOPTA - Real-Time Kernel
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14.12 Standard MPC55xx Boards

Please note that we are supporting many MPC55xx based boards. The boards listed here are included in the stand-
ard delivery and maintained within the shipped versions.

14.12.1 Motorola MPC5554DEMO Board
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CPU Freescale MPC5554

BOARD_SEL Makefile board selection number.

9 To be used as parameter when calling the makefile from Eclipse or from a shell.
(Example: gnu_make BOARD_SEL =9)
Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\mpc5554demo\

Log Port Log message port.

COM-1 The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.

SCIOPTA - Real-Time Kernel
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14.12.2 Phytec phyCORE-MPC5554 Board
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CPU Freescale MPC5554
BOARD_SEL Makefile board selection number.
9 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 9)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\phyCoreMPC5554\

Log Port Log message port.

P1 (Lower) The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.12.3 Freescale MPC5567EVB Board

CPU Freescale MPC5567
BOARD_SEL Makefile board selection number.
12 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =12)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\mpc5567evb\

Log Port Log message port.

XXX The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.13 Standard MPC5200 Boards

Please note that we are supporting many MPC5200 based boards. The boards listed here are included in the stand-
ard delivery and maintained within the shipped versions.

Phytec phyCORE-MPC5200B Tiny Board

tec Messtechmk

PCB- 1179.6

CPU Freescale MPC5200B
BOARD_SEL Makefile board selection number.
5 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =5)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\phyCoreMPC5200B-tiny\

Log Port Log message port.

P1 (Lower) The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.13.1 Freescale Lite5200 Board
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CPU Freescale MPC5200B
BOARD_SEL Makefile board selection number.
2 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =2)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\lite5200\

Log Port Log message port.

RS232 The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.14 Standard PPC400 Boards
Please note that we are supporting many PPC400 based boards. The boards listed here are included in the standard

delivery and maintained within the shipped versions.

14.14.1 AMCC Yosemite 440EP Evaluation Board
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CPU AMCC 440EP
BOARD_SEL Makefile board selection number.
8 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 8)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\yosemite440ep\

Log Port Log message port.

UARTO The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.15 Standard ColdFire Boards

Please note that we are supporting many ColdFire based boards. The boards listed here are included in the standard
delivery and maintained within the shipped versions.

14.15.1 Freescale M5272C3 Evaluation Board
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CPU Freescale ColdFire MCF5272
BOARD_SEL Makefile board selection number.
0 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =0)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\m5272c3\

Log Port Log message port.

TERMINAL The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.15.2 Freescale M5282EVB Evaluation Board
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CPU Freescale ColdFire MCF5282

BOARD_SEL Makefile board selection number.

1 To be used as parameter when calling the makefile from Eclipse or from a shell.
(Example: gnu_make BOARD_SEL =1)
Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\m5282evb\

Log Port Log message port.

TERMINAL The getting started examples are sending some specific example log messages to

a selected UART of the board. Also log daemon message are sent to this port.
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14.15.3 Phytec phyCORE-MCF5485 Board
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CPU Freescale ColdFire MCF5485
BOARD_SEL Makefile board selection number.
3 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = 3)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\phyCore5485\

Log Port Log message port.

P1 (Lower) The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.15.4 COBRA5329 Board

CPU Freescale ColdFire MCF5329
BOARD_SEL Makefile board selection number.
XX To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL = xx)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\cobra5329\

No makefile yet available (all project with iSYSTEM winIDEA)

Log Port Log message port.

UARTO The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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14.15.5 M52233DEMO Evaluation Board

CPU Freescale ColdFire MCF52233
BOARD_SEL Makefile board selection number.
5 To be used as parameter when calling the makefile from Eclipse or from a shell.

(Example: gnu_make BOARD_SEL =5)

Makefile location for kernel example (hello):
<install_folder>\sciopta\<version>\exp\krn\arm\hello\M52233DEMO\

Log Port Log message port.

COM The getting started examples are sending some specific example log messages to
a selected UART of the board. Also log daemon message are sent to this port.
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15 Building SCIOPTA Systems

15.1 Introduction

In a new project you have first to determine the specification of the system. As you are designing a real-time sys-
tem, speed requirements needs to be considered carefully including worst case scenarios. Defining function blocks,
environment and interface modules will be another important part for system specification.

Systems design includes defining the modules, processes and messages. SCIOPTA is a message based real-time
operating system therefore specific care needs to be taken to follow the design rules for such systems. Data should
always be maintained in SCIOPTA messages and shared resources should be encapsulated within SCIOPTA proc-
esses.

To design SCIOPTA systems, modules and processes, to handle interprocess communication and to understand the
included software of the SCIOPTA delivery you need to have detailed knowledge of the SCIOPTA application pro-
gramming interface (API). The SCIOPTA API consist of a number of system calls to the SCIOPTA kernel to let
the SCIOPTA kernel execute the needed functions.

The SCIOPTA kernel has over 80 system calls. Some of these calls are very specific and are only used in particular
situations. Thus many system calls are only needed if you are designing dynamic applications for creating and kill-
ing SCIOPTA objects. Other calls are exclusively foreseen to be used in CONNECTOR processes which are need-
ed in distributed applications.

One of the strength of SCIOPTA is that it is easy-to-use. A large part of a typical SCIOPTA application can be
written by using the system calls which are handling the interprocess communication: sc_msgAlloc, sc_msgTX,
sc_msgRx and sc_msgFree. These four system calls together with sc_msgOwnerGet which returns the owner of
a message and sc_sleep which is used to suspend a process for a defined time, are often sufficient to write whole
SCIOPTA applications.

Please consult the SCIOPTA - Kernel, Reference Manual for detailed description of the SCIOPTA system calls.
The SCIOPTA building procedure consists of the following steps:

« Configuring the system with the SCONF configuration tool (sconf.exe see chapter 16 “SCONF Kernel Con-
figuration” on page 16-1). The SCONF tool generates the C file sconf.c (system defines and start) and the in-
clude files sciopta.cnf (not for ARM architecture) and sconf.h.

« Locate the include files and define the include paths.

* Assemble the kernel.

» Locate and get all assembler source files and assemble it.

* Locate and get all C/C++ source files and compile them.

« Design the linker script to map your system into the target memory.

» Select and define the correct libraries for the SCIOPTA Generic Device Driver (gdd) and Utilities (util) func-
tions.

e Link the system.

The Getting Started project (see chapter 3 “Getting Started” on page 3-1) is a good example for the needed files of
a SCIOPTA application. This example project as a good starting point for your system design.

SCIOPTA - Real-Time Kernel
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15.2  Configuration

The kernel of a SCIOPTA system needs to be configured before you can generated the whole system.

In the SCIOPTA configuration utility SCONF (sconf.exe) you will define the parameters for SCIOPTA systems
such as name of systems, static modules, processes and pools etc. Configure the system with the SCONF config-
uration tool (see chapter 16 “SCONF Kernel Configuration” on page 16-1).

The SCONF tool generates the C file sconf.c (system defines and startup) and the include files sciopta.cnf (not
for ARM architecture) and sconf.h.

15.3 Include Files

15.3.1 Include Files Search Directories

Please make sure that the environment variable SCIOPTA_HOME is defined as explained in chapter 2.4.6
“SCIOPTA_HOME Environment Variable” on page 2-4.

Define the following entries the include files search directories field of your IDE:

%(SCIOPTA_HOME)\include
%(SCIOPTA_HOME)\include\sciopta\<arch>

Depending on the CPU and board you are using:

%(SCIOPTA_HOME)\bsp\<arch>\include
%(SCIOPTA_HOME)\bsp\<arch>\<cpu>\include
%(SCIOPTA_HOME)\bsp\<arch>\<cpu>\<board>\include

15.3.2 Main Include File sciopta.h

The file sciopta.h contains some main definitions and the SCIOPTA Application Programming Interface. Each
module or file which is using SCIOPTA system calls and definitions must include this file. The file sciopta.h in-
cludes all specific API header files.

sciopta.h Main SCIOPTA include file.
File location: <installation_folder>\sciopta\<version>\include\

15.3.3 Configuration Definitions sconf.h

Files or modules which are SCIOPTA configuration dependent need to include first the file sconf.h and then the
file sciopta.h.

The file sconf.h needs to be included if for instance you want to know the maximum number of modules allowed
in a system. This information is stored in SC_MAX_MODULES in the file sconf.h.

Please remember that sconf.h is automatically generated by the SCONF configuration tool and placed at a con-
venient location in your project folder.

SCIOPTA - Real-Time Kernel
15-2 Manual Version 4.1 User’s Manual



¢

15 Building SCIOPTA Systems SCIOPTA

0

15.3.4 Main Data Types types.h

These types are introduced to allow portability between various SCIOPTA implementations.
The main data types are defined in the file types.h. These types are not target processor dependent.

types.h Processor independent data types.
File location: <installation_folder>\sciopta\<version>\include\ossys\

15.3.5 Architecture Dependent Data Types types.h

The architecture specific data types are defined in the file types.h.

types.h Architecture dependent data types.
File location: <installation_folder>\sciopta\<version>\include\sciopta\<arch>\arch\

15.3.6 Global System Definitions defines.h

System wide definitions are defined in the file defines.h. Among other global definitions, the base addresses of the
IDs of the SCIOPTA system messages are defined in this file. Please consult this file for managing and organizing
the message 1Ds of your application.

defines.h System wide constant definitions.
File location: <installation_folder>\sciopta\<version>\include\ossys\

15.3.7 Board Configuration

It is good design practice to include specific board configurations, defines and settings in a file. In the SCIOPTA
board support package deliveries such example files (config.h) are available.

config.h Board configuration defines.
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\

SCIOPTA - Real-Time Kernel
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15.4  Assembling the Kernel

The SCIOPTA kernels for ARM, PowerPC and ColdFire architectures are provided in assembler source files and
therefore compiler manufacturer specific. The kernels can be found in the library directory of the SCIOPTA deliv-

ery.

The kernel for the SCIOPTA SCSIM Simulator is in included in a library and does not need to be assembled or
compiled.

15.4.1 Kernels for ARM Architectures

Architecture (<arch>): arm (see chapter 1.3.1 “Architectures” on page 1-3).

sciopta.S Kernel source file for GNU GCC
sciopta.s79 Kernel source file for IAR Ver. 4.x
sciopta_iar.s  Kernel source file for IAR Ver. 5.x
sciopta_ads.s  Kernel source file for ARM RealView

File location: <install_folder>\sciopta\<version>\lib\arm\krn\

15.4.2 Kernels for PowerPC Architectures

Architecture (<arch>): ppc (see chapter 1.3.1 “Architectures” on page 1-3).

sciopta.S Kernel source file for GNU GCC and Windriver
sciopta_mmu.S Kernel source file for GNU GCC and Windriver including MMU support
sciopta_vle.S  Kernel source file for GNU GCC and Windriver including PowerPC VLE code support

File location: <install_folder>\sciopta\<version>\lib\ppc\krn\

15.4.3 Kernels for ColdFire Architectures

Architecture (<arch>): coldfire (see chapter 1.3.1 “Architectures” on page 1-3).

sciopta.S Kernel source file for GNU GCC
sciopta.s68 Kernel source file for IAR

File location: <install_folder>\sciopta\<version>\lib\coldfire\krn\

15.4.4 Kernel for SCIOPTA SCSIM Simulator

Architecture (<arch>): win32 (see chapter 1.3.1 “Architectures” on page 1-3).

The simulator kernel is included in the SCIOPTA SCSIM Simulator Kernel Library.
Please consult chapter 15.12 “SCIOPTA SCSIM Simulator Kernel Library” on page 15-26.

SCIOPTA - Real-Time Kernel
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Usually there are not many assembler source file in a project. Sometimes system files from the board support pack-

ages might be needed.

15.5.1 ARM Architecture Assembler Source Files

cortexm3_cstartup.<ext> C startup code for Cortex-M3.
cortexm3_exception.<ext>Exception handler for Cortex-Ma3.

cortexm3_vector.<ext>
cstartup.<ext>
dcc.<ext>
exception.<ext>
memcopy.<ext>
user_swi_handler.<ext>

File extensions <ext>:

Vector table for Cortex-M3.

C startup code for ARM.

UART using DCC for ARM.

Global exception handler for ARM.
Memcopy routines for ARM.

User SWI handler (called from kernel).

S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\arm\src\gnu\

s79  1AR Version 4.x
File location: <install_folder>\sciopta\<version>\bsp\arm\src\iar\

S IAR Version 5.x
File location: <install_folder>\sciopta\<version>\bsp\arm\src\iar\

S ARM RealView
File location: <install_folder>\sciopta\<version>\bsp\arm\src\arm\

Please Note: There is no file C startup file for IAR needed.

15.5.2 PowerPC Architecture Assembler Source Files

atomic.<ext>
cstartup.<ext>
cstartup_vle.<ext>
md5.<ext>

File extensions <ext>:

Routine to atomically increment a variable.

C startup code for PowerPC.

C startup code for PowerPC with VLE code support.
MD5 Sum file for PowerPC.

S GNU GCC and Windriver
File location: <install_folder>\sciopta\<version>\bsp\ppc\src\

15.5.3 ColdFire Architecture Assembler Source Files

chksum_asm.<ext>
cstartup.<ext>

File extensions <ext>:

sc_miscChksum - IP checksum.
C startup code for ColdFire.

S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\coldfire\src\

SCIOPTA - Real-Time Kernel
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15.5.4 ARM CPU Family Assembler Source Files

Typical files for ARM architecture and specific CPU families.

irq_handler.<ext> Interrupt wrapper.

irq_handler_mmu.<ext> Interrupt wrapper including MMU support.
serial_irg.<ext> Interrupt wrapper for serial interrupts.
sys_irg.<ext> Interrupt wrapper for system interrupts.
systick_irg.<ext> Interrupt wrapper for systick.

eintx_irg.<ext> Interrupt wrapper for eint0..3 for LPC2000.
softint_irg.<ext> Interrupt wrapper for SOFTINT for LPC2000.
spi_irq.<ext> Interrupt wrapper for spi0 and spil for LPC2000.
timer_irg.<ext> Interrupt wrapper for timer0/1 for LPC2000.
memcopy.<ext> Memcopy routines.

File extensions <ext>: S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\gnu\

s79  1AR Version 4.x
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\iar\

S IAR Version 5.x
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\iar\

S ARM RealView
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\src\arm\

Please Note: Not all files are needed for all CPU families. Please consult the examples in the SCIOPTA deliv-
eries, the sources and the project requirements to include the needed files.

1555 PowerPC CPU Family Assembler Source Files

Typical files for PowerPC architecture and specific CPU families.

exception.<ext> PowerPC kernel - exception handling.

core.<ext> Some helper function to access SPFRs.

systick.<ext> System tick interrupt handler.

systick_vle.<ext> System tick interrupt handler including PowerPC VLE code support.

File extensions <ext>: S GNU GCC and Windriver
File location: <install_folder>\sciopta\<version>\bsp\ppc\<cpu>\src\

Please Note: Not all files are needed for all CPU families. Please consult the examples in the SCIOPTA deliv-
eries, the sources and the project requirements to include the needed files.

SCIOPTA - Real-Time Kernel
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15.5.6 ColdFire CPU Family Assembler Source Files

Typical files for ColdFire architecture and specific CPU families.

vectors.<ext>
cache.<ext>

File extensions <ext>:

Vector table.
Cache flush routines.

S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\coldfire\<cpu>\src\

s68 IAR
File location: <install_folder>\sciopta\<version>\bsp\coldfire\<cpu>\src\iar\

Please Note: Not all files are needed for all CPU families. Please consult the examples in the SCIOPTA deliv-
eries, the sources and the project requirements to include the needed files.
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15.5.7 ARM Boards Assembler Source Files

Typical files for ARM architecture and specific boards.

resethook.<ext> Resethook early startup functions.
led.<ext> LED access functions.

File extensions <ext>: S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\<board>\src\gnu\

s79  IAR Version 4.x
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\<board>\src\iar\

S IAR Version 5.x
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\<board>\src\iar\

S ARM RealView
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\<board>\src\arm\

Please Note: Not all files are needed for all boards. Please consult the examples in the SCIOPTA deliveries,
the sources and the project requirements to include the needed files.

15.5.8 PowerPC Boards Assembler Source Files

Typical files for PowerPC architecture and specific boards.

resethook.<ext> Resethook early startup functions.
led.<ext> LED access functions.

File extensions <ext>: S GNU GCC and Windriver
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\<board>\src\

Please Note: Not all files are needed for all boards. Please consult the examples in the SCIOPTA deliveries,
the sources and the project requirements to include the needed files.

15.5.9 ColdFire Boards Assembler Source Files

Typical files for ColdFire architecture and specific boards.

resethook.<ext> Resethook early startup functions.
led.<ext> LED access functions.

File extensions <ext>: S GNU GCC
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\<board>\src\

s68 IAR
File location: <install_folder>\sciopta\<version>\bsp\arm\<cpu>\<board>\src\

Please Note: Not all files are needed for all boards. Please consult the examples in the SCIOPTA deliveries,
the sources and the project requirements to include the needed files.
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15.6 Compiling the C/C++ Source Files

15.6.1 CPU Families C/C++ Source Files

Typical CPU family files:

druid_uart.c Druid UART driver.

simple_uart.c Simple polling UART function for printf debugging or logging.
serial.c Serial driver.

<driver_name>.c CPU family specific device drivers.

File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\src\

15.6.2 Chip Driver C/C++ Source Files

Typical chip and device files:

<driver_name>.c Specific device drivers for controllers and devices which are not board specific.
File location: <install_folder>\sciopta\<version>\bsp\common\src\

15.6.3 Boards C/C++ Source Files

Typical board files:

resethook.c C written resethook.
<driver_name>.c Board specific device drivers.
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\src\

15.6.4 Configuration C/C++ Files

Typical system configuration and initialization file:

system.c System configuration file including the start_hook the system module start function and
other setup code.
File example location:
<install_folder>\sciopta\<version>\exp\<arch>\<example>\<board\

Typical user modules system configuration and initialization files:

<module_name>.c User module start function and other user module setup code.
File example location:
<install_folder>\sciopta\<version>\exp\<arch>\<example>\<board\

15.6.5 User Application C/C++ Files

User application files:

<application>.c User application files containing processes and other application functions.
<application>.msg User application files containing message declarations and definitions.
File example location: <project_folder>

SCIOPTA - Real-Time Kernel
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15.7 Linker Scripts

15.7.1 Introduction

A linker script is controlling the link in the build process. The linker script is written in a specific linker command
language. The linker script and linker command language are compiler specific.

The linker script describes how the defined memory sections in the link input files are mapped into the output file
which will be loaded in the target system. Therefore the linker script controls the memory layout in the output file.

SCIOPTA uses the linker scripts to define and map SCIOPTA modules into the global memory map.

15.7.2 GCC Linker Scripts

You can find examples of linker scripts in the SCIOPTA examples and getting started projects. In these examples
there is usually a main linker script which includes a second linker script. The main linker scripts are board depend-
ent.

<board_name>.Id Board specific linker script for GNU GCC.

File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\
Usually the main linker scripts includes another standard linker script:
module.ld Module linker script for GNU GCC.

File location: <install_folder>\sciopta\<version>\bsp\<arch>\include\

Study these linker script files to get full information how to locate a SCIOPTA system in the embedded memory
space.

15.7.2.1 Memory Regions

The main linker script contains the allocation of all available memory and definition of the memory regions includ-
ing the regions for all modules. Sections are assigned to SCIOPTA specific memory regions. The region name has
no meaning outside of the linker script. Region names are stored in a separate name space, and will not conflict
with symbol names, file names, or section names. Each memory region must have a distinct name.

The following regions are typically defined by the user:

rom destination for read-only data

sram internal SRAM

system_mod Memory region for the system module

<module_name>_mod | Memory region for other modules (with name: <module_name>).

SCIOPTA - Real-Time Kernel
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15.7.2.2 Module Sizes

The sizes used by SCIOPTA of each module must be defined by the user in the linker script. This size determines
the memory which will be used by SCIOPTA for message pools, PCBs and other system data structures.

The name of the size is usually defined as follows: <module_name>_size
The module name for the system module is system.

Typical definitions (for modules system, dev, ips and user) might look as follows:

system_size = 0x4000;
dev_size = 0x4000;
ips_size = 0x4000;
user_size = 0x4000;

size calculation:

size_mod = p * 256 + stack + pools + mch + textsize

where:

p Number of static processes

stack Sum of stack sizes of all static processes

pools Sum of sizes of all message pools

mch module control block = 200 bytes

textsize Size of the memory which is initialized by the C-Startup function (cstartup.S)

Please consult the configuration chapter (SCONF utility) of the SCIOPTA Kernel, User’s Guide for information
about friend and hook settings.
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15.7.2.3 Specific Module Values

For each module four values are calculated in the linker script:

<module_name>_start Start address of module RAM
<module_name>_initsize |Size of initialized RAM

<module_name>_size Complete size of the module

<module_name>_mod A structure which contains the above three addresses.

The SCIOPTA configuration utility SCONF is using these definitions to pass the module addresses to the kernel.
Example in the linker script:

-module_init :

{
system _mod = .;
LONG(system_start);
LONG(system_size);
LONG(system_initsize);
dev_mod = _;
LONG(dev_start);
LONG(dev_size);
LONG(dev_initsize);
ips_mod = .;
LONG(ips_start);
LONG(ips_size);
LONG(ips_initsize);
user_mod = _;
LONG(user_start);
LONG(user_size);
LONG(user_initsize);

} > rom
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15.7.2.4 GCC Data Memory Map
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Figure 15-1: SCIOPTA Memory Map
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15.7.3 Windriver Linker Scripts

You can find examples of Windriver C/C++ Compiler Package linker scripts in the SCIOPTA examples and get-
ting started projects. In these examples there is usually a main linker script which includes a second linker script.
The main linker scripts are board dependent.

<board_name>.dld Board specific linker script for Windriver.
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\

Usually the main linker scripts includes another standard linker script:

module.dld Module linker script for Windriver.
File location: <install_folder>\sciopta\<version>\bsp\<arch>\include\

Study these linker script files to get full information how to locate a SCIOPTA system in the embedded memory
space.
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15.7.4 1AR Embedded Workbench Linker Scripts

You can find examples of IAR Embedded Workbench linker scripts in the SCIOPTA examples and getting started
projects.

<board_name>.xcl Board specific Linker script for IAR4.
<board_name>.icf Board specific Linker script for IARS.
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\

For IAR you need to define the free RAM of the modules in a separate file. In this area there are no initialized data.
Module Control Block (ModuleCB), Process Control Blocks (PCBs), Stacks and Message Pools are placed in this
free RAM:

map.c Module mapping definitions for IAR.
File location: <installation_folder>\sciopta\<version>\exp\krn\arm\<example>\<board>\

Study these linker script files to get full information how to locate a SCIOPTA system in the embedded memory
space.
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15.7.5 ARM RealView Linker Scripts

You can find examples of ARM RealView linker scripts in the SCIOPTA examples and getting started projects.
<board_name>.sct Board specific Linker script for ARM RealView.
File location: <install_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\

Study these linker script files to get full information how to locate a SCIOPTA system in the embedded memory
space.
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15.7.6 WIN32 Linker Script

The linking process and memory mapping is fully controlled and defined by the Microsoft® Visual C++ IDE.

15.7.6.1 Module Data RAM

In SCIOPTA system running in a real target CPU the module RAM memory map is defined in the linker scripts.

In the SCIOPTA SCSIM Simulator you need to declare the module RAM by a character array of the size of the
module.

For the system module the declaration looks as follows:

/* define module ram */
static char system_module[0x20000];
sc_module_addr_t system_mod = {
system_module,
sizeof(system_module),
0
}:
In the delivered SCIOPTA examples the module data RAM declaration is usually included in the file system.c.

system.c SCIOPTA SCSIM Simulator setup.
File location: <installation_folder>\sciopta\<version>\exp\krn\win32\hello\
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15.8 GNU GCC Kernel Libraries

For the SCIOPTA generic device driver (gdd) functions, the shell functions (sh) and the SCIOPTA utilities (util)
some prebuilt libraries are included in the delivery

Please consult the SCIOPTA - Device Driver, User’s and Reference Manual for more information about generic
device driver (gdd) functions.

The file name of the libraries have the following format:

libgdd_xt.a
libsh_xt.a
libutil_xt.a

File location: <installation_folder>\sciopta\<version>\lib\<arch>\gnu\

File location ARM7/9/XScale:
<installation_folder>\sciopta\<version>\lib\arm\gnu\

File location for ARMv6 (ARM11):
<installation_folder>\sciopta\<version>\lib\arm\gnu_v6\

File location for ARMvV6F (ARM11) and FPU support:
<installation_folder>\sciopta\<version>\lib\arm\gnu_v6f\

File location for ARMv7M (Cortex-M3):
<installation_folder>\sciopta\<version>\lib\arm\gnu_cm3\

File location for ARMV7RA (Cortex-R4/A8/A9):
<installation_folder>\sciopta\<version>\lib\arm\gnu_v7ra\

File location for ARMV7RAF (Cortex-R4/A8/A9) and FPU support:
<installation_folder>\sciopta\<version>\lib\arm\gnu_v7raf\

15.8.1 Library Versions

X Compiler optimization level
0 No Optimization.

1 Optimization for size.

2 Optimization for speed.

t Trap interface.

If the SCIOPTA Trap Interface is used, the libraries containing the letter “t” after the Optimization letter x
must be included.
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15.8.2 Building Kernel Libraries for GCC

The example makefiles and project files are supposing to use libraries for the generic device driver (gdd) and utility
(util) modules. As described above, there are some libraries delivered for specific compiler settings. We have in-
cluded source files and makefiles which allows you to build the libraries yourself. If you want to change compiler
switches or other system settings you need to modify the makefiles.

Procedures to generate the libraries

* Open a Command Prompt window.

» For Generic Device Driver libraries (gdd):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\gdd\
» Execute the makefile for each architecture:
arm: gnu-make -f Makefile.arm gdd
gnu-make -f Makefile.cm3 gdd (Cortex-M3)
gnu-make -f Makefile.tarm gdd (trap interface)
gnu-make -f Makefile.armv6 gdd (ARM11)
gnu-make -f Makefile.armvéf gdd (ARM11 and FPU)
gnu-make -f Makefile.armv7rafb gdd (Cortex-R4, FPU and big endian)
ppc: gnu-make -f Makefile.ppc gdd
coldfire: gnu-make -f Makefile.coldfire gdd

« For Utilities and Shell libraries (util):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\util\
» Execute the makefile for each architecture:
arm: gnu-make -f Makefile.arm util
gnu-make -f Makefile.cm3 util (Cortex-M3)
gnu-make -f Makefile.tarm util (trap interface)
gnu-make -f Makefile.armv6 util (ARM11)
gnu-make -f Makefile.armv6f util (ARM11 and FPU)
gnu-make -f Makefile.armv7rafb util (Cortex-R4, FPU and big endian)
ppc: gnu-make -f Makefile.ppc util
coldfire: gnu-make -f Makefile.coldfire util

« The libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\<arch>\gnu\

* For ARM Cortex-M3 the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\gnu_cm3\

* For ARML11 the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\gnu_v6\

e For ARM11 and FPU the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\gnu_v6f\

e For ARM Cortex-R4 the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\gnu_v7ra\

e For ARM Cortex-R4 and FPU the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\gnu_v7raf\
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15.9 Windriver Kernel Libraries

For the SCIOPTA generic device driver (gdd) functions, the shell functions (sh) and the SCIOPTA utilities (util)
some prebuilt libraries are included in the delivery.

Please consult the SCIOPTA - Device Driver, User’s and Reference Manual for more information about generic
device driver (gdd) functions.

The file name of the libraries have the following format:

libgdd_xt.a

libsh_xt.a

libutil_xt.a

File location: <installation_folder>\sciopta\<version>\lib\<arch>\diab\

File location for Windriver PowerPC VLE code:
<installation_folder>\sciopta\<version>\lib\ppc\diab_vle\

15.9.1 Library Versions

X Compiler optimization level
0 No Optimization.

1 Optimization for size.

2 Optimization for speed.

t Trap interface.

If the SCIOPTA Trap Interface is used, the libraries containing the letter “t” after the Optimization letter x
must be included.
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15.9.2 Building Kernel Libraries for Windriver

The example makefiles and project files are supposing to use libraries for the generic device driver (gdd) and utility
(util) modules. As described above, there are some libraries delivered for specific compiler settings. We have in-
cluded source files and makefiles which allows you to build the libraries yourself. If you want to change compiler
switches or other system settings you need to modify the makefiles.

Procedures to generate the libraries

* Open a Command Prompt window.

» For Generic Device Driver libraries (gdd):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\gdd\
» Execute the makefile for each architecture:
ppc: gnu-make -f Makefile.ppcdiab gdd
gnu-make -f Makefile.ppcdiabv gdd (PowerPC VLE Code)

« For Utilities and Shell libraries (util):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\util\
» Execute the makefile for each architecture:
ppc: gnu-make -f Makefile.ppcdiab util
gnu-make -f Makefile.ppcdiabv util (PowerPC VLE Code)

« The libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\<arch>\diab\

» The libraries for PowerPC VLE Code will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\ppc\diab_vle\
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15.10 IAR Kernel Libraries

For the SCIOPTA generic device driver (gdd) functions, the shell functions (sh) and the SCIOPTA utilities (util)
some prebuilt libraries are included in the delivery

Please consult the SCIOPTA - Device Driver, User’s and Reference Manual for more information about generic
device driver (gdd) functions.

The file name of the ARM libraries have the following format:

gdd xtb.a
sh_xtb.a
util_xtb.a

File location ARM7/9/XScale:
<installation_folder>\sciopta\<version>\lib\arm\iar\

File location for ARMv6 (ARM11):
<installation_folder>\sciopta\<version>\lib\arm\iar_v6\

File location for ARMvV6F (ARM11) and FPU support:
<installation_folder>\sciopta\<version>\lib\arm\iar_v6f\

File location for ARMv7M (Cortex-M3):
<installation_folder>\sciopta\<version>\lib\arm\iar_cma3\

File location for ARMV7RA (Cortex-R4/A8/A9):
<installation_folder>\sciopta\<version>\lib\arm\iar_v7ra\

File location for ARMV7RAF (Cortex-R4/A8/A9) and FPU support:
<installation_folder>\sciopta\<version>\lib\arm\iar_v7raf\

The file name of the ColdFire libraries have the following format:
gdd_xt.r68

sh_xt.r68

util_xt.ré8

File location: <installation_folder>\sciopta\<version>\lib\coldfire\iar\

15.10.1 Library Versions

X Compiler optimization level
0 No Optimization.

1 Optimization for size.

2 Optimization for speed.

t Trap interface.

If the SCIOPTA Trap Interface is used, the libraries containing the letter “t” after the Optimization letter x
must be included.

b Big endian.

Libraries containing the letter “b” are compiled for “big endian”.
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15.10.2 Building Kernel Libraries for IAR

The example makefiles and project files are supposing to use libraries for the generic device driver (gdd) and utility
(util) modules. As described above, there are some libraries delivered for specific compiler settings. We have in-
cluded source files and makefiles which allows you to build the libraries yourself. If you want to change compiler
switches or other system settings you need to modify the makefiles.

Procedures to generate the libraries

* Open a Command Prompt window.

» For Generic Device Driver libraries (gdd):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\gdd\
» Execute the makefile for each architecture:
arm: gnu-make -f Makefile.tarmiar gdd (thumb)
gnu-make -f Makefile.cm3iar gdd (Cortex-M3)
gnu-make -f Makefile.armv6iar gdd (ARM11)
gnu-make -f Makefile.armvé6fiar gdd (ARM11 and FPU)
gnu-make -f Makefile.armv7rafbiar gdd (Cortex-R4, FPU and big endian)
coldfire: gnu-make -f Makefile.cfiar gdd

« For Utilities and Shell libraries (util):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\util\
» Execute the makefile for each architecture:
arm: gnu-make -f Makefile.tarmiar util (thumb)
gnu-make -f Makefile.cm3iar util (Cortex-M3)
gnu-make -f Makefile.armv6iar util (ARM11)
gnu-make -f Makefile.armvé6fiar util (ARM11 and FPU)
gnu-make -f Makefile.armv7rafbiar util (Cortex-R4, FPU and big endian)
coldfire: gnu-make -f Makefile.cfiar util

« The libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\<arch>\iar\

* For ARM Cortex-M3 the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\iar_cm3\

* For ARML11 the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\iar_v6\

e For ARM11 and FPU the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\iar_v6f\

« For ARM Cortex-R4 the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\iar_v7ra\

e For ARM Cortex-R4 and FPU the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\iar_v7raf\
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15.11 ARM RealView Kernel Libraries

For the SCIOPTA generic device driver (gdd) functions, the shell functions (sh) and the SCIOPTA utilities (util)
some prebuilt libraries are included in the delivery

Please consult the SCIOPTA - Device Driver, User’s and Reference Manual for more information about generic
device driver (gdd) functions.

The file name of the ARM libraries have the following format:

gdd_xt.|
sh_xt.l
util_xt.1

File location ARM7/9/XScale:
<installation_folder>\sciopta\<version>\lib\arm\rv40\

File location for ARMv7M (Cortex-M3):
<installation_folder>\sciopta\<version>\lib\arm\rv40_cm3\

15.11.1 Library Versions

X Compiler optimization level
0 No Optimization.

1 Optimization for size.

2 Optimization for speed.

t Trap interface.

If the SCIOPTA Trap Interface is used, the libraries containing the letter “t” after the Optimization letter x
must be included.

SCIOPTA - Real-Time Kernel
15-24 Manual Version 4.1 User’s Manual



¢

15 Building SCIOPTA Systems SCIOPTA

0

15.11.2 Building Kernel Libraries for ARM RealView

The example makefiles and project files are supposing to use libraries for the generic device driver (gdd) and utility
(util) modules. As described above, there are some libraries delivered for specific compiler settings. We have in-
cluded source files and makefiles which allows you to build the libraries yourself. If you want to change compiler
switches or other system settings you need to modify the makefiles.

Procedures to generate the libraries

* Open a Command Prompt window.

» For Generic Device Driver libraries (gdd):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\gdd\
» Execute the makefile for each architecture:
arm: gnu-make -f Makefile.armads gdd
gnu-make -f Makefile.tarmads gdd (thumb)
gnu-make -f Makefile.cm3rvcs gdd (Cortex-M3)

« For Utilities and Shell libraries (util):
« Navigate to the route source directory: <installation_folder>\sciopta\<version>\util\
» Execute the makefile for each architecture:
arm: gnu-make -f Makefile.armads util
gnu-make -f Makefile.tarmads util (thumb)
gnu-make -f Makefile.cm3rvcs util (Cortex-M3)

e The libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\rv31\

* For ARM Cortex-M3 the libraries will be installed in the directory:
<installation_folder>\sciopta\<version>\lib\arm\rv31_cma3\
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15.12 SCIOPTA SCSIM Simulator Kernel Library

For the SCIOPTA SCSIM Simulator the whole kernel including the generic device driver system, the utilities and
the shell are placed in the library scwin32.lib.

The library scwin32.lib contains the following modules:

SCIOPTA Simulator Kernel
SCIOPTA utilities

SCIOPTA generic device driver
SCIOPTA shell files

The library for the Microsoft® Visual C++ 2005 Version 8.0 environment can be found at:
File location: <install_folder>\sciopta\<version>\lib\scsim\win32\vs80\

The scwin32.lib library needs to be linked to the SCIOPTA Windows project.

Please note:

Check the workspace settings of the SCIOPTA WIN32 Kernel Simulator getting started project for examples of
library settings. Please consult chapter 3.6 “Getting Started SCIOPTA SCSIM Simulator” on page 3-9.
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15.13 Linking the System

Now you are ready to link the generated object files from the assembler and C/C++ source files.

Make sure that you include the correct gdd and util libraries for your project and the correct linker script for you
target environment.
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15.14 Integrated Development Environments

15.14.1 Eclipse and GNU GCC

The Eclipse IDE for C/C++ Developers project provides a fully functional C and C++ Integrated Development
Environment (IDE).

Please consult http://www.eclipse.org/ for more information about Eclipse. You can download Eclipse IDE for C/
C++ Developers from the download page of this site.

Please consult http://www.eclipse.org/cdt for more information about Eclipse CDT (C/C++ Development Tools)
project.

For all delivered SCIOPTA examples for the ARM, PowerPC and ColdFire architectures there are Makefiles in-
cluded. Eclipse is easy to configure for working with external makefiles. Please consult chapter 3 “Getting Started”
on page 3-1 for a detailed description how to setup Eclipse to build SCIOPTA systems.

The Eclipse IDE requires that a Java Run-Time Environment (JRE) be installed on your machine to run. Please
consult the Eclipse Web Site to check if your JRE supports your Eclipse environment. JRE can be downloaded
from the SUN or IBM Web Sites.

15.14.1.1Tools

The following tools re needed to build a SCIOPT project with Eclipse and GNU GCC.
» Compiler package:
For ARM CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ARM Version Q1 20009.
Acrchitecture (arch): arm

For PowerPC  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for Power PC Version 4.2.
Acrchitecture (arch): ppc

For ColdFire  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ColdFire Version 4.3.
Acrchitecture (arch): coldfire

These packages can be found on the SCIOPTA CD.
» Eclipse IDE for C/C++ Developers. You can download Eclipse from here http://www.eclipse.org/.

» SCIOPTA - Kernel for your selected architecture.

15.14.1.2Environment Variables

The following environment variables need to be defined:

e Check that the environment variable SCIOPTA_HOME is defined as described in chapter 2.4.6
“SCIOPTA_HOME Environment Variable” on page 2-4.

» Be sure that the GNU GCC compiler bin directory is included in the PATH environment variable as described
in chapter 2.4.9 “GNU Tool Chain Installation” on page 2-5.

» Besure that the SCIOPTA \win32\bin directory is included in the PATH environment variable as described in
chapter 2.4.7 “Setting SCIOPTA Path Environment Variable” on page 2-4.
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15.14.1.3Eclipse Project Files

We are using “makefile projects” (contrary to “managed make projects”) in Eclipse. For all delivered SCIOPTA
examples for the ARM, PowerPC and ColdFire architectures there are makefiles included. Eclipse is easy to con-
figure for working with external makefiles.

You will find typical makefiles for SCIOPTA in the example deliveries.

Makefile Makefile for GNU GCC
File location: <installation_folder>\sciopta\<version>\exp\krn\<arch>\<example>\

Usually these example makefiles include a board specific makefile called board.mk located here:
board.mk Board dependent makefiles.

File location: <installation_folder>\sciopta\<version>\exp\krn\<arch>\<example>\<board>

15.14.1.4Project Settings in Eclipse

You just need to define the make call in the “Build command”.

» Click on the project in the Project Explorer window to make sure that the project is highlighted.
» Open the Properties window (menu: File -> Properties or Alt+Enter button).
» Click on “C/C++ Build.

» Deselect “Use default build command” in the Builder Settings Tab. Now you can enter a customized Build
command.

« Enter the following Build command: gnu-make
Enter make options according to you project need
» Click the OK button.
Now you can build the project from the menu (Project > Build Project) or by clicking on the Build button.

15.14.1.5Debugger Board Setup Files

Board setup files for Lauterbach Trace32 and iSYSTEM winIDEA can be found in the SCIOPTA delivery.

<file_name>.cmm Lauterbach Trace32 board setup file.
<file_name>.ini iISYSTEM winIDEA board setup file.

The file_name is often the board name <board>.

File location: <installation_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\
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15.14.2 iSYSTEM® winIDEA

The program winIDEA is the IDE for all iISYSTEMS emulators. It is the a Integrated Development Environment,
which contains all the necessary tools in one shell. winIDEA consists of a project manager, a 3rd party tools inte-
grator, a multi-file C source editor and a high-level source debugger.

Please consult http://www.isystem.com/ for more information about the iSYSTEM emulator/debugger.

15.14.2.1Tools

The following tools are needed to build a SCIOPT project with iISYSTEM and GNU GCC.
*  GNU GCC Compiler package:

For ARM CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ARM Version Q1 2009.
Architecture (arch): arm

For PowerPC  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for Power PC Version 4.2.
Acrchitecture (arch): ppc

For ColdFire  CodeSourcery GNU C & C++ Sourcery G++ Lite Edition for ColdFire Version 4.3.
Acrchitecture (arch): coldfire

These packages can be found on the SCIOPTA CD.
e ISYSTEM debugger including winIDEA software.
e SCIOPTA - Kernel for your selected architecture.

15.14.2.2Environment Variables

The following environment variables need to be defined:

e SCIOPTA_HOME needs to point to the SCIOPTA delivery. Please consult chapter 2.4.6 “SCIOPTA_HOME
Environment Variable” on page 2-4 for more information.

* Include the GNU GCC compiler bin directory in the PATH environment variable as described in chapter 2.4.9
“GNU Tool Chain Installation” on page 2-5.

SCIOPTA - Real-Time Kernel
15-30 Manual Version 4.1 User’s Manual



¢

15 Building SCIOPTA Systems SCIOPTA

0

15.14.2.3winIDEA Project Files

You will find typical winIDEA project files for SCIOPTA in the example deliveries.

<file_name>.xjrf iISYSTEM winIDEA project file
<file_name>.xqrf iISYSTEM winIDEA project file

File location: <installation_folder>\sciopta\<version>\exp\krn\<arch>\<example>\<board>

15.14.2.4winIDEA Project Settings

Selecting Projects > Settings... from the menu (or press Alt+F7) opens the Project Settings window.
After expanding the C/C++ Build entry you can select Settings to open the project specific settings window.

Please consult the delivered example winIDEA project for detailed information about compiler, assembler and
linker calls, options and settings.

15.14.2.5winIDEA Board Setup Files

Board setup files for winIDEA can be found in the SCIOPTA delivery.

<file_name>.ini iISYSTEM winIDEA board setup file.
The file_name is often the board name <board>.

File location: <installation_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\
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15.14.3 IAR Embedded Workbench

IAR Embedded Workbench is a set of development tools for building and debugging embedded system applica-
tions using assembler, C and C++. It provides a completely integrated development environment that includes a
project manager, editor, build tools and the C-SPY debugger.

Please consult http://www.iar.com/ for more information about the IAR Embedded Workbench.

15.14.3.1Tools

The following tools re needed to build a SCIOPT project with IAR Embedded Workbench.

* For ARM: IAR Embedded Workbench for ARM including the following main components:

* |AR Assembler for ARM

¢ 1AR C/C++ Compiler for ARM
* |AR Embedded Workbench IDE
* AR XLINK

e For ColdFire: IAR Embedded Workbench for Coldfire including the following main components:

* 1AR Assembler for Coldfire

e |AR C/C++ Compiler for Coldfire
* 1AR Embedded Workbench IDE
* |AR XLINK

» SCIOPTA - Real-Time Kernel for your selected architecture.

15.14.3.2Environment Variables

The following environment variables need to be defined:

e SCIOPTA_HOME needs to point to the SCIOPTA delivery. Please consult chapter 2.4.6 “SCIOPTA_HOME
Environment Variable” on page 2-4 for more information.

* Include the SCIOPTA bin directory in the PATH environment variable as described in chapter 2.4.7 “Setting
SCIOPTA Path Environment Variable” on page 2-4. This will give access to the sconf.exe utility. Some
IAREW examples might call sconf.exe directly from the workbench to do the SCIOPTA configuration.
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15.14.3.31AR EW Project Files

You will find typical IAR EW project files for SCIOPTA in the example deliveries.

<file_name>.ewd IAR EW project file
<file_name>.ewp IAR EW project file
<file_name>.eww IAR EW project file

The file_name is often the board name <board>.

File location: <installation_folder>\sciopta\<version>\exp\krn\<arch>\<example>\<board>

15.14.3.41AR EW Project Settings

Selecting Projects > Options... from the menu (or press Alt+F7) opens the Options window.

¢

SCIOPTA

0

Please consult the delivered example IAR EW project for detailed information about compiler, assembler and link-

er calls, options and settings.

15.14.3.51AR C-SPY Board Setup File

C-SPY is the name of the IAR Embedded Workbench debugger. Board setup file for C-SPY can be found in the

SCIOPTA delivery.

<file_name>.mac IAR EW C-SPY board setup file.
The file_name is often the board name <board>.

File location: <installation_folder>\sciopta\<version>\bsp\<arch>\<cpu>\<board>\include\
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15.14.4 Microsoft® Visual C++

For SCIOPTA SCSIM Simulator we are using the Microsoft® Visual C++ environment.

Microsoft Visual C++ (often abbreviated as MSVC) is a commercial integrated development environment (IDE)
product engineered by Microsoft for the C, C++, and C++/CLI programming languages. It has tools for developing
and debugging C++ code, especially code written for the Microsoft Windows API.

Visual C++ 2005 (known also as Visual C++ 8.0), which included MFC 8.0, was released in November 2005. This
version supports .NET 2.0 and dropped managed C++ for C++/CLI. It also introduced OpenMP. With Visual C++
2005, Microsoft also introduced Team Foundation Server. Visual C++ 8.0 has problems compiling MFC AppWiz-
ard projects that were created using Visual Studio 6.0, so maintenance of legacy projects can be continued with the
original IDE if rewriting was not feasible.

15.14.4.1Tools

You will need

* Microsoft® Visual C++ 2005 Version 8.0
» SCIOPTA SCSIM Simulator for Windows for your selected architecture.

15.14.4.2Environment Variables

The following environment variables need to be defined:

» SCIOPTA_HOME needs to point to the SCIOPTA delivery. Please consult chapter 2.4.6 “SCIOPTA_HOME
Environment Variable” on page 2-4 for more information.

15.14.4.3Microsoft® Visual C++ Project Files Location

You will find typical IAR EW project files for SCIOPTA in the example deliveries.

<example>.dsw Microsoft® Visual C++ Workspace File.
<example>.dsp Microsoft® Developer Studio Project.
<example>.vcproj Microsoft® Visual C++ Project File
<example>.sin Microsoft® Visual C++ Solution File

File location: <installation_folder>\sciopta\<version>\exp\krn\win32\<example>\

15.14.4.4Microsoft® Visual C++ Project Settings

Please consult the delivered example Microsoft® Visual C++ project for detailed information about compiler, as-
sembler and linker calls, options and settings.
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16 SCONF Kernel Configuration

16.1 Introduction

The kernel of a SCIOPTA system needs to be configured before you can generated the whole system. In the SCI-
OPTA configuration utility SCONF (sconf.exe) you will define the parameters for SCIOPTA systems such as
name of systems, static modules, processes and pools etc.

The SCONF program is a graphical tool which will save all settings in an external XML file. If the setting are sat-
isfactory for your system SCONF will generate three source files containing the configured part of the kernel.
These files must be included when the SCIOPTA system is generated.

A SCIOPTA project can contain different SCIOPTA Systems which can also be in different CPUs. For each SCI-
OPTA System defined in SCONF a set of source files will be generated.

16.2  Starting SCONF

The SCIOPTA configuration utility SCONF (config.exe) can be launched from the SCONF short cut of the Win-
dows Start menu or the windows workspace. After starting the welcome screen will appear. The latest saved project
will be loaded or an empty screen if the tool was launched for the first time.

%4 Sciopta System Configuration C:/P/multi.xml - |E||1|
Fil= Edit Help

Nea

-3 TS

Figure 16-1: SCIOPTA Configuration Utility Start Screen
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16.3  Preference File sc_config.cfg
The SCIOPTA Configuration Utility SCONF is storing some preference setting in the file sc_config.cfg.
Actually there are only three settings which are stored and maintained in this file:

1. Project name of the last saved project.
2. Location of the last saved project file.
3. Warning state (enabled/disabled).

The sc_config.cfg file is located in the home directory of the user. The location cannot be modified.
Every time SCONF is started the file sc_config.cfg is scanned and the latest saved project is entered.

At every project save the file sc_config.cfg is updated.

16.4  Project File

The project can be saved in an external XML file <project_name>.xml. All configuration settings of the project
are stored in this file.
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16.5 SCONF Windows

To configure a SCIOPTA system with SCONF you will work mainly in two windows.

= Sciopta System Configuration Chyscd'Manuals'22_dummy®.arm'misc bes.xml

File Edit ArmSystem Help

4

SCIOPTA

0

=101 x]

==

Configuration Tree Structure |

sc@m TCS
B4 TCS
=3 TCS
§ besdinit

Lh keyboard
@ hotplug

- 4 spzcontral
# dizplay
% zyzpool
- # Chamber_2,
342 init

lhl sengor
@ aven

- 3k driver
- 3% controller

- 4k reference

5 &_pool

Arm Settings Buid Directory: ||
General I Hooks | Debug I
Systerm Mame ITCS—
CPU Type Er|
Caompiler GMHU i
M arimurn Buffer Sizes m
I airnurn Modules |4

M aximum Connectors ID
A aximum Int. Yectors |32

Kemel Stack Size

Interrupt Stack Size

512

|512 ¥ unified IRD stack

Max. interrupt nesting ID

Inter-Module

I never copy ¥ l

v Asynchronous Timeout

I~ Trap Interface

\

\ Apply

Cancel |

\

Browser Window

16.5.1 Parameter Window

Parame\ter Window

Figure 16-2: SCONF Windows

For every level in the browser window (process level, module level, system level and project level) the layout of
the parameter window change and you can enter the configuration parameter for the specific item of that level (e.g.
parameters for a specific process). To open a specific parameter window just click on the item in the browser win-

dow.
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16.5.2 Browser Window

The browser window allows you to browse through a whole SCIOPTA project and select specific items to config-
ure.

Configuration Tree Stucture Project
SE.EPTH s Level System

E# TCS < Level Module
A =-HETCS - Level
A it ]
Lh kepbioard
@ hatplug Process
ﬁ- gyscontrol Level

ﬁ dizplay

% gyzponl
A

Process
Level

Module
Level

System
Level

Project
Level

Figure 16-3: Browser Windows

The browser shows four configuration levels and every level can expand into a next lower level. To activate a level

you just need to point and click on it. On the right parameter window the configuration settings for this level can
be viewed and modified.

» The uppermost level is the Project Level where all project configurations will be done. The project name can
be defined and you can create new systems for the project.

« Inthe System Level you are configuring the system for one CPU. You can create the static modules for the
system and configure system specific settings.

* In SCIOPTA you can group processes into modules. On the Module Level you can configure the module pa-
rameters and create static processes and message pools.

e The parameters of processes and message pools can be configured in the Process Level.
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16.6 Creating a New Project

To create a new project select the New button in the tool bar:

I ¥ &, = =
Project
Button

You also can create a new project from the file menu or by the Ctrl+N keystroke:

&g Sciopta System Configuration
3
[ Open... “Chl+o
K save Chrl4+5 I
Save As
Ezxit
|

16.7 Configure the Project

You can define and modify the project name. Click on the project name on the right side of the SCIOPTA logo and
enter the project name in the parameter window.

X8 Sciopta System Configuration C:/P/tcs.xml

File Edit Project Help
1D = ol

& Shructure

Project Hame IS ciopta

Enter the project name

Click on the Apply button to accept the name of the project.
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16.8 Creating Systems

From the project level you can create new systems. Move the mouse pointer over the project and right-click the
mouse.

= Sciopta System Configuration C\scdManuals'.22

File Edit Project Help

Me = w

Configuration Tree Stucture

Sciopta

l—

Creake PowetPC System

Create PPC IEC&1S08 System

Create xd6 System
Create Coldfire System

Create windZ System

Creake HC12 System
Creake M16C System
Creake SCAPT Syskermn

Create Tiny ARM Syskem

Creake Tiny MSP430 System

[
A pop-up menu appears and allows you to select a system out of all SCIOPTA supported target CPUs.

The same selection can be made by selecting the Project menu from the menu bar.

SCONF asks you to enter a directory where the generated files will be stored:

Choose the directory where the generated files
{=conf.h,sciopta.cnf and sconf,c) will be skored

O\ P pridins

=Y =]
..... J 'ﬁ'RM

----- {) prjon1

----- i) prionz

----- {3 prjons

----- I priong

----- 0 [elglals

----- {3 prio0&

----- i prjooz

----- i) prio0g

----- {5 pring LI

[8]4 I Cancel I
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A new system for your selected CPU with the default name New System 1, the system module (module id 0) with
the same name as the new target and a init process will be created.

=4 Sciopta System Configuration C:\scdManuals2Z_dummy'arm’mischbcs.xml*

File Edit ArmSystem Help

=101

M w

Configuration Tree Stucture I
=cp TCS
- 2 NewSysterml
= #E NewSystemt %
g it

A

Settings

General I Hooks I Debug |
SystemMarme  [NewSysteml |
CPU Type [armesT =]
Compiler GHU =
Maximum Buffer Sizes m
Mazimurn Modules I-’i
M aximurn Cannectors IEI
Maximum Int. Vectars — |128
Kernel Stack Size B2
Interupt Stack Size |512 [~ unified IRG stack,
b &x. interupt nesting IIJ—
Inter-td odule friends i

v Azpnchronous Timeout

T 1ap Interface

Build Directary: |:d\Manuals\ZZ_dummy\arm\misd EI

Apply

Lance| |

4

You can create up to 128 systems inside a SCIOPTA project. The targets do not need to be of the same processor
(CPU) type. You can mix any types or use the same types to configure a distributed system within the same SCI-

OPTA project.

You are now ready to configure the individual targets.
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Configuring Target Systems

After selecting a system with your mouse, the corresponding parameter window on the right side will show the
parameters for the selected target CPU system.

The system configuration for ARM, ColdFire and SCIOPTA SCSIM Simulator (win32) target systems is divided
into 3 tabs: General, Hooks and Debug while the system configuration for PowerPC target systems is divided into
4 tabs: General, Timer/Interrupt, Hooks and Debug.

16.9.1 General System Configuration Tab
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Apply Lancel
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16.9.1.1 General Tab Parameters

System Name

Name of the target system.

CPU Type

Enter the name of your system. Please note that the system module (module 0) in
this system will get the same name.

CPU family for the selected architecture.

Compiler

C/C++ Compiler selection.

Maximum Buffer Sizes

For PowerPC the “GNU” selection is also valid for Windriver.

Maximum number of message buffer sizes.

4,80r16

Maximum Modules

If a process allocates a message there is also the size to be given. The user just
gives the number of bytes needed. SCIOPTA is not returning the exact amount of
bytes requested but will select one of a list of buffer sizes which is large enough to
contain the requested number. This list can contain 4, 8 or 16 sizes which is con-
figured here in the maximum buffer sizes entry. See 7 “Pools” on page 7-1.

For the SCIOPTA SCSIM Simulator (win32) only 8 can be selected.

Maximum number of SCIOPTA modules in the system.

Maximum CONNECTORS

Here you can define a maximum number of modules which can be created in this
system. The maximum value is 127 modules. It is important that you give here a
realistic value of maximum number of modules for your system as SCIOPTA is
initializing some memory statically at system start for the number of modules giv-
en here. See also 4 “Modules” on page 4-1.

Maximum number of CONNECTOR processes in the system.

Maximum Int. Vectors

CONNECTORS are specific SCIOPTA processes and responsible for linking a
number of SCIOPTA systems. The maximum number of connectors in a system
may not exceed 127 which correspond to the maximum number of systems. See
also chapter 12.9 “Distributed Systems” on page 12-7.

Maximum number of interrupt vectors.

This entry is only available for ARM and PowerPC.
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Kernel Stack Size

Size of the global kernel stack.

Interrupt Stack Size

Currently not used. Entered values are not considered.

Size of the global interrupt stack.

Max interrupt nesting

Only used in ARM architecture when “unified IRQ stack” checkbox is selected.
The stack size given must be big enough to hold the stacks of the interrupt proc-
esses with the biggest stack needs taken in account the interrupt nesting.

For all other architectures currently not used. Entered values are not considered.

Maximum nesting level.

Only used in ARM architecture.

0 No nesting

<number> Maximum nesting level of interrupt processes in the system.

Inter-Module Defines if messages between modules are copied or not.

never copy Messages between modules are never copied.

always copy Messages between modules are always copied.

friends The message copy behaviour is defined by the friendship setting between the mod-

Asynchronous Timeout

ules. Please consult chapter 4.6 “SCIOPTA Module Friend Concept” on page 4-2
for more information.

This entry is not available for SCIOPTA SCSIM Simulator (win32) as it is always
set to “friends”.

Enables the time-out server.

Trap Interface

See chapter 9.4 “Timeout Server” on page 9-3.
This entry is not available for SCIOPTA SCSIM Simulator (win32) as it is always
included in the simulator.

Enables the trap interface.

See chapter 12.8 “Trap Interface” on page 12-6.
This entry is not available for SCIOPTA SCSIM Simulator (win32).
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16.9.2 Timer and Interrupt Configuration Tab

This tab is only available for PowerPC.

PowerFC Settings Build Directory: |, &

General | Tirner / Inbermipt IHooks | Debug I

Timer

Source I Decrementer "l
Tick inus |1DDD
Frequency in Hz |1DDDD

Apply LCancel

16.9.2.1 Timer and Interrupt Tab Parameters

Source Source for the SCIOPTA system tick.
The SCIOPTA real-time kernel uses an internal tick timer to manage and control all timing
tasks. Here you can select which timer you want to use to generate the tick.

Decrementer The Decrementer Timer of the CPU is used as system tick.

None Another timer will be used as system tick. You need to write your own tick function (usually
a user interrupt service routine) which will call sc_tick explicitly.

Tick in us Enter here the tick interval in micro seconds.

Frequency in Hz

The value can only be entered if you have not selected none as the timer source.

System clock frequency.

You need to enter the clock frequency of the processor which is used by the timer source. The
value can only be entered if you have not selected none as the timer source.
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16.9.3 Hooks Configuration Tab

Win3z Seﬂings Build Directory: I El
General | Hooks I Debug |
|
¥ Process Hoo . . =
—| Coldfire Settings Build Directon:  |. EI
| Create General | Hooks IDebug I
I | il |
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I il [
Process H
[~ Swa I . o =
r ——| Arm Settings Buid Ditectary: |- El
v LCreat
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¥ [V Process Hooks ¥ Message Hooks W PoolHooks W Emor Hook
v Swap
[~ MU ¥ Create v MsaRx v Create
[ Kil I hsalx [ Kil
V¥ Swap
I~ MU

Apply | Lancel |

Hooks are user written functions which are called by the kernel at different locations. They are only called if the
user defined them at configuration. User hooks are used for a number of different purposes and are system depend-
ent.

You can enable the hooks separately by selecting the corresponding check box or all hooks belonging to a group
all together.

In the SCIOPTA SCSIM Simulator (win32) only whole hook groups can be enabled.

Please consult chapter 12.2 “Hooks” on page 12-1 for more information about SCIOPTA hooks.

For ARM and PowerPC you can select an MMU checkbox. You must select this checkbox if you want to enable
the MMU functions in the kernel.

SCIOPTA - Real-Time Kernel
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16.9.4 Debug Configuration Tab

win32 Settings Build Direstory: |, =]
General | Hooksz | Debug |
—Debug — Glabistic——— |
W Message Ch| (g dfire Settings Build Directory: | §|

¥ Stack Check
General I Hooks | Debug |
¥ Process Parz |

¥ Message Par —Debug | |—Stat|st|c. |
v Mess. ;
¥ Poal Paramel = Stack FowwerPC Se‘[‘hngg Build Directorny: I El
' Cline ¥ Proce General | Timer & Intermapt I Hooks | Debug |
¥ Mezz —Debug Shatigtic
v Meszage Check ¥ Process
¥ Pool
¥ CLing I~ Stack Check
[ Process Pare |~ Settings Build Ditectory:  |. &

¥ Message Pa General I Hooks | Debug |

¥ Pool Parame —Debug———————— —Sitatistic
¥ C-Line v Message Check ¥ Process
¥ Stack Check v Meszage

¥ Process Parameter Check,

¥ Meszage Parameter Check
¥ Pool Parameter Check
[¥ C-Line

Aipply Cancel
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16.9.4.1 Debug Tab Parameter

Message Check Enables the message check functions in the kernel.
Some test functions on messages will be included in the kernel.
Stack Check Enables the stack check functions.

Process Parameter Check

This checkbox is only available for ARM.

Enables process parameter checks.

Message Parameter Check

Parameter check of the process system calls will be included in the kernel.

Enables message parameter checks.

Pool Parameter Check

Parameter check of the message system calls will be included in the kernel.

Enables pool parameter checks.

C-Line

Parameter check of the pool system calls will be included in the kernel.

Enables C-line informations.

Process Statistics

If you are selecting this check box the kernel will include line number information
which can be used by the SCIOPTA DRUID Debug System or an error hook. Line
number and file of the last system call is recorded in the per process data.

Includes process statistics.

Message Statistics

The kernel will maintain a process statistics data field where information such as
number of process swaps can be read.

Includes message statistics.

The kernel will maintain a message statistics data field in the pool control block
where information such as number of message allocation can be read.

Applying Target Configuration

Click on the Apply button to accept the target configuration settings. &pply |
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16.10 Creating Modules

From the system level you can create new modules. Move the mouse pointer over the system and right-click the
mouse.

e Sciopta System Configuration D:\PARM'kcs.

File Edit ArmSystem Help

M= = w

Configuration Tree Stuchure |
AT
Delete Syskem ,!

Build System

g init

Change Build Direckary
TT T

A pop-up menu appears and allows you to create a new module.
The same selection can be made by selecting the Target System from the menu bar.

A new module for your selected target with a default name and an init process in the module will be created.

& Sciopta System Configuration D:\P%AR
File Edit Module Help

M= w

Configuration Tree Stucture I
=clgF1a Sciopta
= - 2 MewSustem

: 3 init
=8 2 Newhodulsl
9 init

You can create up to 127 modules.

You are now ready to configure the individual modules.

SCIOPTA - Real-Time Kernel
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16.11 Configuring Modules

After selecting a module with your mouse, the corresponding parameter window on the right side will show the
module parameters.

[ Load Moduls

Moduls Name |Chamber_g,

M azimum Processes I‘I E
A azirum Pools |2

Pricity 1] =
¥ Symbolic Yalues

Start Address IChamber_A_mod. shart
temony Size IChamber_.t‘-\_mod. zize
Init. Size IChamber_.t‘-\_mod. initzize
Apply LCance|
16.11.1 Parameter
Load Module Module is a load module.

Check this box if the module will be loaded at run-time into the system. This check
box is not available for the system module.

Module Name Name of the module.

Enter the name of the module. If you have selected the system module (the first mod-
ule or the module with the id 0) you cannot give or modify the name as it will have the
same name as the target system.

Maximum Processes Maximum number of processes in the module.

The kernel will not allow to create more processes inside the module than stated here.
The maximum value is 16383.

SCIOPTA - Real-Time Kernel
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Maximum Pools

Maximum number of message pools.

Priority

Enter the maximum number of pools in the module. The kernel will not allow to create
more pools inside the module than stated here. The maximum value is 128.

Module priority.

Symbolic Values

Enter the priority of the module.

Each module has a priority which can range between 0 (highest) to 31 (lowest) prior-
ity. See also chapter 4.3 “Module Priority” on page 4-1.

Module memory map defined by the linker script.

Start Address

You need to select this checkbox if you want to specify labels instead of absolute val-
ues for the module addresses and module size (start address, memory size and init
size).

The following labels will be used by the linker script and resolved at link time:
<module_name>_mod

<module_name>_size

<module_name>_initsize)

See chapter 15.7.2.3 “Specific Module Values” on page 15-12.

Therefore all memory allocation for all modules is controlled by the linker script.

Module start address.

Memory Size

If Symbolic Values is not selected the module start address can be defined here. You
need to be very carefully when entering an absolute address here and need to check
with the linker script to avoid overlapping.

Size of the module.

Init Size

If Symbolic Values is not selected the module size can be defined here.
Please consult chapter 15.7.2.2 “Module Sizes” on page 15-11 for more information
about module size calculation.

Size of initialized module memory.

If Symbolic Values is not selected the size of the module memory which is initialized
by the C-startup function (cstartup.S) can be defined here. You need to be very care-
fully when entering an absolute address here and need to check with the linker script
to avoid overlapping.

Applying Module Configuration

Click on the Apply button to accept the module configuration settings. &pply |
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16.12 Creating Processes and Pools

From the module level you can create new processes and pools. Move the mouse pointer over the module and right-
click the mouse.

=4 Sciopta System Configuration C:'scdManuals'Z22_dummy®.arm'misc’H

File Edit Modulz Help

IMe = w
Configuration Tree Structure I
scﬁpm TCS
E-# TCS I~ Load Modul
|ii‘w‘ﬁte Pool LIz Mame ITCS
Poewgin
----\hke_l,lboan Create Interrupt Process imum Processes I-I G
: Create Timer Process .
@ hatplug - imum Pools |2
ﬁ- spsCants Create Priovity Process
'* display Create ProcDasmon y ID
# @ syspocl Create KernelDaemon bolic Values
[=- 34 Chamber_a
9; it Delete Module t Address Is_pst:
-y s temory Size Is_l,lstr
@ aven it G
* diiver nit. Size ahzh
- B cubrallar

A pop-up menu appears and allows you to create pools, interrupt processes, timer processes, prioritized processes
and if it is the system module also the process daemon and the kernel daemon.

Please Note

The Process Daemon (ProcDaemon) and Kernel Daemon (KernelDaemon) can only be created in the system mod-
ule.

The same selection can be made by selecting the Module menu from the menu bar.

SCIOPTA - Real-Time Kernel
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16.13 Configuring the Init Process

After selecting the init process with your mouse the parameter window on the right side will show the configuration
parameters for the init process. There is always one init process per module and this process has the highest priority.
Only the stack size of the init process can be configured.

Please consult chapter 5.9 “Init Processes” on page 5-8 for more information about init processes.

Priarity Process Mame Iinit

Friority Process Function ITES_init

Stack Size [128

Y

Friority 1] =

Frocess State I zharted I

16.13.1 Parameter

Stack Size Init process stack size.

Enter a big enough stack size.

Applying Init Process Configuration

Click on the Apply button to accept the init process configuration settings. &pply |
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16.14 Interrupt Process Configuration

After selecting an interrupt process with your mouse the parameter window on the right side will show the config-
uration parameters for the interrupt process.

Please consult chapter 5.7 “Interrupt Processes” on page 5-5 for more information about interrupt processes.

=4 Sciopta System Configuration C\scd'Manuals,22_dummy'armimiscitcs.xml * _ Ol x|

File Edit InterruptProcess Help

M= W
Configuration Tree Structure
sc@m TCS
B- # TCS Interupt Process Name Ike_l,.lboald
=~ #ETCS
g il Interrupt Process Function Ike_l,.lboald
LA Stack Size 128 %
@ hotplug I—
- 40F syscontrol Vestar 12
- 3% display |ntermupt Frocess Tyupe I Sciopta ¥ I
% syzpoal \ -
Process Mode I S x I
= ¥ Chamber_&, Hpervisel
-7 init

-y seror
- Soven \
- 3% driver
- 43F controller \
- 5 reference
Interrupt Processes

% A_poal

Apply Lancel |

16.14.1 Parameter for All Architectures

Interrupt Process Name Interrupt process name.

Interrupt Process Function Interrupt process function entry.

Function name of the interrupt process function. This is the address where the cre-
ated process will start execution. More than one interrupt processes (names) can
have the same interrupt process function.

SCIOPTA - Real-Time Kernel
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Stack Size Interrupt process stack size.

Enter a big enough stack size of the created interrupt process in bytes.

Inthe ARM architecture, a value can only be entered when the “unified IRQ stack”
checkbox in the target system configuration window is not selected.

Vector Interrupt vector.

Enter the interrupt vector connected to the interrupt process.

16.14.2 Additional Parameters for PowerPC

Intemupt Process Manme Ike_l,lboard
Intemupt Process Function Ike_l,lboard

Stack Size 128
Wectar I‘I 2

Interrupt Process Type I Sciopta * I
Process Mode I Supervisor 'l

SPE usage I no SPE 'I
Processor Mode Selects interrupt processor mode.
Supervisor The process runs in CPU supervisor mode.
User The process runs in CPU user mode.
SPE Usage Selects if PowerPC Signal Processing Engine is used or not.
no SPE SPE not used.
SPE SPE is used.
SCIOPTA - Real-Time Kernel
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16.14.3 Additional Parameters for ColdFire

Intermupt Frocess Mame Ike}lboard
Intermupt Process Function Ike}lboard

Stack Size 128
Yectar |1 2

Intermupt Frozess Type I Sciopta 'l
Procesz Made I Supervizor 'I

FPU uzage I no FRU VI
FPU usage Selects if a Floating Point Unit exists and will be used.
no FPU No FPU in the system
FPU System includes an FPU

Applying the Interrupt Process Configuration

Click on the Apply button to accept the interrupt process configuration settings. &pply |
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16.15 Timer Process Configuration

After selecting a timer process with your mouse the parameter window on the right side will show the configuration
parameters for the timer process.

Please consult chapter 5.8 “Timer Processes” on page 5-7 for more information about timer processes.

e sciopta System Configuration Cyscd'Manuals' dummy',mpe5SHxmisc2’ bes.xml - |E||i|

File Edit TimerProcess Help

Rg=2=
Configuration Tree Structure I
scﬁpm TCS
B # TCS Tirmer Process Mame ISCT_hothug
E-#E TS
99‘(' init Timer Process Function ISET_hothug
| A\ SC)_keyboard Stack Size flozs
CT_hotplug
prwtml Periad [10 [tk =]
- 3 SCP_dizplay \ Iritial Delay f1 | tick =]
E| #""Ci;f;izl N Frocess State I started ‘l
- 358 init Frocess Mode I Supervisor ‘l
l}g SCI_sensor
@ SCT_oven
# SCP_driver
- 3% SCP_controller ~
- 5 SCP_reference
% &_poal
Timer Processes

Lpoply LCancel |

16.15.1 Parameter

Timer Process Name Timer process name.

Timer Process Function Timer process function entry.

Function name of the timer process function. This is the address where the created
process will start execution.

SCIOPTA - Real-Time Kernel
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Stack Size Timer process stack size.
Enter a big enough stack size of the created timer process in bytes.
In the ARM architecture, a value can only be entered when the “unified IRQ stack”
checkbox in the target system configuration window is not selected.
Period Timer process interval time.
Period of time between calls to the timer process in ticks or in milliseconds.
Initial Delay Initial shift delay time.

Process State

Initial delay before the first time call to the timer process in ticks or milliseconds.
To avoid tick overload due to timer processes having the same period.

Starting state of the timer process.

started
stopped

Processor Mode

The timer process will be started after creation.

The process is stopped after creation. Use the sc_procStart system call to start the
process.

Selects interrupt processor mode.

Supervisor
User

The process runs in CPU supervisor mode.

The process runs in CPU user mode.
This entry is only available for PowerPC.

Applying the Timer Process Configuration

Click on the Apply button to accept the timer process configuration settings. &pply |
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16.16 Prioritized Process Configuration

After selecting a prioritized process with your mouse the parameter window on the right side will show the con-
figuration parameters for the prioritized process.

Please consult chapter 5.6 “Prioritized Processes” on page 5-3 for more information about timer processes.

=4 Sciopta System Configuration C\scd'Manuals,2Z2_dummy'armimiscitcs.xml * _ O] x|

File Edit PriorityProcess Help

M= w
Configuration Tree Structure
=cpa TCS
E- # TCS Priority Process Name Is_l,lscontrol
- #ETCS
il Pricrity Process Function Is_l,lscontrol

-Aykeyboard Stack Size [12a

-3 hatpl

g I Pricrity I'I g 3:
Process State I started 'l

* dizplay

E| *"Ci:::’::roj Process Mode I Supervisor 'I
3 init N
""WSEI’TSD[ \
@ OvEn

- 4% driver
- 3 controller %
% &_pool §‘

/]

- 3 eference -

Prioritized Processes

Apply LCancel |

16.16.1 Parameter for All Architectures

Priority Process Name Process name.

Priority Process Function Process function entry.

Function name of the prioritized process function. This is the address where the
created process will start execution. More than one interrupt processes (names) can
have the same interrupt process function.

SCIOPTA - Real-Time Kernel
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Stack Size Process stack size.
Enter a big enough stack size of the created prioritized process in bytes.
Priority Priority of the process.

Process State

An error will be generated if the priority is higher than the module priority.

Starting state of the timer process.

started

stopped

Processor Mode

The process will be on READY state. It is ready to run and will be swapped-in if
it has the highest priority of all READY processes.

The process is stopped after creation. Use the sc_procStart system call to start the
process.

Selects interrupt processor mode.

Supervisor
User

The process runs in CPU supervisor mode.

The process runs in CPU user mode.
Not available in SCIOPTA SCSIM Simulator (win32).

16.16.2 Additional Parameters for PowerPC

Priority Process Name Is_l,lscontrol
Priority Process Function Is_l,lscontml

Stack Size I‘I 8
Pricrity I'I g 3:

Process State I started 'l
Process Mode I Supervisor 'l

SPE usage Im
SPE Usage Selects if PowerPC Signal Process Engine is used or not.
no SPE SPE not used.
SPE SPE is used.
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16.16.3 Additional Parameters for ColdFire

Frionty Process Mame Isysc:ontlol
Frionty Process Function IS_',JSCDnlID|

¢

SCIOPTA

0

Stack Size |123—
Friarity Iﬁ
Frocess State statted ¥
Frocess Mode Im
FFU usage I no FPU VI
FPU usage Selects if a Floating Point Unit exists and will be used.
no FPU No FPU in the system
FPU System includes an FPU

Applying the Priority Process Configuration

Click on the Apply button to accept the priority process configuration settings.

Apply |
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16.17 Pool Configuration

After selecting a pool with your mouse the parameter window on the right side will show the configuration param-
eters for the pool.

Please consult chapter 7 “Pools” on page 7-1 for more information about timer processes.

TR Sciopta System Configuration D:\Manuals',.dummy’,ppc400itcs.sml - |EI|5|
File Edit Pool Help
e Q@
Configuration Tree Stucture I
sc@m TCS
-3k Faol Mame Isyspool
E# ch_ . Fool Size |2DDD
w |n|t
- Wy kepboard Bulfer Size
D hoiplug 4 &8 16
- 3 spzcontrol
- 3t dislay 1 1024
N 8 2043
- 3 Chamber_& 15 4096
3 ik %2 8192
""%"SE”SD' 64 16384
4 Z\_'e” N 128 32768
o ""f’ . 56 E5536
A soniolE 512 131072
- 3 reference
. g f1_pool \
Pools
Apply Lancel
.
16.17.1 Parameter
Pool Name Name of the message pool.
Pool Size Size of the message pool.

See chapter 7.2 “Message Pool size” on page 7-1.
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Buffer Sizes Number of buffer sizes.

4,80r16 Define the different buffer sizes for your selection.
See chapter 7.3 “Pool Message Buffer Memory Manager” on page 7-2.

Applying the Pool Configuration

Click on the Apply button to accept the pool configuration settings. Apply |
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16.18 Build

The SCONF will generate the following files which need to be included into your SCIOPTA project.

sciopta.cnf  This is the configured part of the kernel which will be included when the SCIOPTA kernel (sciopta.s)
is assembled. For the ARM architecture this file is not needed and therefor not generated.

sconf.h This is a header file which contains some configuration settings. This file will be included by the
kernel during assembling. You need to include this into all your files which need configuration in-
formation.

sconf.c This is a C source file which contains the system initialization code. You need to compile this file in

the system building process.

16.18.1 Build System

To build the three files click on the system and right click the mouse. Select the menu Build System. The files
sciopta.cnf (not for ARM), sconf.h and sconf.c will be generated into your defined build directory.

2 Sciopka System Configuration D:%Man

File Edit PowerPc3ystem Help
Mea w

Caonfiguration Tree Stucture I

scﬁm TCS
E"- 52 Create Module
AT

B - Delete System

Change Build Direckory:

SCIOPTA - Real-Time Kernel
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16.18.2 Change Build Directory

When you are creating a new system, SCONF ask you to give the directory where the three generated files will be
stored. You can modify this build directory for each system individually by clicking to the system which you want
to build and right click the mouse.

S Sciopta System Configuration D:Man

File Edit PowerPcIystem Help
Mea w

Configuration Tree Stuchure I

sclgFta TCS
TL:!:; Create Maduls
- 48 | Delete System

Build System

_hange Build Direckory

Select the last item in the menu for changing the build directory.

The actual Build Directory is shown in the System Settings Window:

A Seﬁings Build Directony: | D:Avmyprojectzhprid04 EI

General IHooks | Debug |

You can change the Build Directory also from the
System Settings Window. Click on the Browse But-
ton and select the new directory.

You can change the Build Direc-

tory also from the System Set-

tings Window by entering directly

the Build Directory Path.

SCIOPTA - Real-Time Kernel
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16.18.3 Build All

If you have more than one system in your project, you can build all systems at once by clicking on the Build All
button.

Select the Build All button from the button bar to generate the set of three files for each system.

Build All

The files sciopta.cnf (not for ARM), sconf.h and sconf.c will be generated for every target into the defined build
directories of each target which exists in the project.

SCONF will prompt for generating the files for each system.
Please note:

You need to have different build directories for each system as the names of the three generated files are the
same for each system.

SCIOPTA - Real-Time Kernel
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16.19 Command Line Version

16.19.1 Introduction

The SCONF configuration utility can also be used from a command line.

This is useful if you want to modify or create the XML configuration file manually or if the XML configuration
file will be generated by a tool automatically and you want to integrate the configuration process in a makefile. The
best way to become familiar with the structure of the XML file is to use the graphic SCONF tool once and save
the XML file.

16.19.2 Syntax

By calling the SCONF utility with a -c switch, the command line version will be used automatically.

<install dir>\bin\win32\sconf.exe -c <XML File>

You need to give also the extension of the XML file.

SCIOPTA - Real-Time Kernel
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17 Manual Versions

17.1 Manual Version 4.1

» Chapter 1 The SCIOPTA System, Rewritten.

» Chapter 3.2 Example Description, Class Diagram replaced by Process-Message Diagram.
e Chapter 5.12.1 Unified Interrupt Stack for ARM, chapter added.

e Chapter 5.12.2 Interrupt Nesting for ARM Architecture.

« Figure 16.2 SCONF Window, picture update.

e Chapter 16.9.1 General System Configuration Tab, ARM Settings picture modified (including unified stack
and Max. interrupt nesting.

e Chapter 16.9.1.1 General Tab Parameters, unified stack and nesting added.

* Chapter 16.14.1 Parameter for All Architectures, interrupt stack size for ARM only available if not unified in-
terrupt stack.

e Chapter 16.15.1 Parameter, timer stack size for ARM only available if not unified interrupt stack.
» Chapter 16.18 Build, sciopta.cnf not needed for ARM architecture.

17.2 Manual Version 4.0

e SCIOPTA Manual system restructured and rewritten.
» Splitted into a Kernel Reference Manual and User’s Manual.

« No more target specific manuals. Target specific information are included in the Kernel Reference Manual and
User’s Manual.

17.3 Manual Version 3.2

» Chapter 2.4.9 GNU Tool Chain Installation, rewritten due to CodeSourcery GCC tool chain support.
e Chapter 3.2.1 Class Diagram, replaces old block diagram.
» Chapter 3.2.3.1 Equipment, CodeSourcery GCC tool chain now used.

» Chapter 6.6.4 sc_procKill, “The sc_procKill system calls returns before the cleaning work begins.” removed
from the last paragraph.

» Chapter 13.2.1 Tools, CodeSourcery GCC tool chain now used.
e Chapter 13.3.2 Tools, CodeSourcery GCC tool chain now used.
e Chapter 13.4.2 Tools, CodeSourcery GCC tool chain now used.

17.4 Manual Version 3.1

» Chapter 2.4.10 Eclipse C/C++ Development Tooling - CDT, rewritten.
» Chapter 3 Getting Started, rewritten.

e Chapter 4.15.2 Eclipse, rewritten.

» Chapter 5.2.5 Priorities, upper limit effective priority of 31 described.

SCIOPTA - Real-Time Kernel
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» Chapter 6, Application Programming Interface,
» Chapter 6.3.6 sc_msgRx and chapter 6.3.1 sc_msgAlloc, parameter tmo, value modified.

» Chapter 6.4.1 sc_poolCreate, parameter size, pool calculation value n better defined. Parameter name, “Valid
characters” modified to “Recommended characters”.

» Chapter 6.4.3 sc_poolldGet, return value “poolID of default pool” added.

» Chapter 6.5.6 sc_procPrioSet, paragraph: “If there are already existing processes at the same priority, the proc-
ess which has just moved to that priority will be put at the end of the list and swapped-out.” added.

e Chapter 6.6.1 sc_procPrioCreate, Parameter name, “Valid characters” modified to “Recommended charac-
ters”.

e Chapter 6.6.2 sc_procintCreate, “User” interrupt process type removed, Parameter name, “Valid characters”
modified to “Recommended characters”.

» Chapter 6.6.3 sc_procTimCreate, Parameter name, “Valid characters” modified to “Recommended charac-
ters”.

e Chapter 6.10.1 sc_moduleldGet, parameter name text: “...or zero for current module” appended at description
and return value for parameter name=NULL added. Return value SC_NOSUCH_MODULE modified to
SC_ILLEGAL_MID if Module name was not found.

e Chapter 6.11.1 sc_moduleCreate, parameter textsize renamed into initsize. Parameter name, “Valid characters”
modified to “Recommended characters”.

» Chapter 6.12.3 sc_moduleFriendGet, return value “1” modified to “!=".
e Chapter 6.13.2 sc_tick, last paragraph added.
e Chapter 6.15.2 sc_triggerWait, parameter tmo better described.

» Chapter 6.19.1 sc_miscErrorHookRegister, function and parameter newhook are of type pointer. Global and
Module error hook difference described.

» Chapter 6.19.2 sc_msgHookRegister, function and parameter newhook are of type pointer.

» Chapter 6.19.3 sc_poolHookRegister, function and parameter newhook are of type pointer. Global and Module
pool hook difference described.

» Chapter 6.19.4 sc_procHookRegister, function and parameter newhook are of type pointer. Global and Module
process hook difference described.

e Chapter 7.7.2.7 Example, system call sc_procldGet parameter corrected.

e Chapter 7.11.4 Error Hook Declaration Syntax, return value “!= 0" modified.

* Chapter 7.11.6 Error Hooks Return Behaviour, added.

» Chapter 9.10 i.MX27 System Functions and Drivers, added.

» Chapter 9.22 LOGIC i.MX27 LITEKIT, added.

» Chapter 13.3 Eclipse IDE and GNU GCC, rewritten.

e Chapter 15.3 Function Codes, code 0x0E, 0x0D, 0x3E, 0x3F, 0x57, O0x5C, 0x5D, Ox5E and 0x5F added.
e Chapter 15.4 Error Codes, code 0x016, 0x017 and 0x018 added.

» Chapter 16.9.3 Debug Configuration, Stack Check added to the list.

17.5 Manual Version 3.0

* Manual restructured and rewritten.

SCIOPTA - Real-Time Kernel
17-2 Manual Version 4.1 User’s Manual



¢

17 Manual Versions SCIOPTA

0

17.6 Manual Version 2.1

» Chapter 2.4 Installation Procedure Windows Hosts, now modified for customer specific deliveries.
e Chapter 2.4.5 SCIOPTA_HOME Environment Variable, UNIX Shell versions removed.

17.7 Manual Version 2.0

» The following manuals have been combinded in this new SCIOPTA ARM - Kernel, User’s Guide:
* SCIOPTA - Kernel, User’s Guide Version 1.8
* SCIOPTA - Kernel, Reference Manual Version 1.7
¢ SCIOPTA - ARM Target Manual

17.8 Former SCIOPTA - Kernel, User’s Guide Versions

17.8.1 Manual Version 1.8

» Back front page, Litronic AG became SCIOPTA Systems AG.

» Chapter 2.3.4.1 Prioritized Process, icon now correct.

e Chapter 2.3.4.2 Interrupt Process, last paragrpah added.

e Chapter 2.3.4.5 Supervisor Process, rewritten.

e Chapter 2.5.2 System Module, rewritten.

e Chapter 4.11.1 Start Sequence, added.

e Chapter 4.11.3 C Startup, rewritten.

e Chapter 4.11.5 INIT Process, added.

e Chapter 4.11.6 Module Start Function, added.

» Chapter 4.7.2.6 Example, in system call msg_alloc SC_ENDLESS _TMO replaced by SC_DEFAULT_POOL.

17.8.2 Manual Version 1.7

» Chapter 3.9.1 Configuring ARM Target Systems, Inter-Module settings added.
« Chapter 3.9.2 Configuring Coldfire Target Systems, Inter-Module settings added.
» Chapter 3.9.3 Configuring PowerPC Target Systems, Inter-Module settings added.

17.8.3 Manual Version 1.6

» Configuration chapter added (moved from the target manuals).

17.8.4 Manual Version 1.5

e Allunion sc_msg * changed to sc_msg_t to support SCIOPTA 16 Bit systems (NEAR pointer).
e All union sc_msg ** changed to sc_msgptr_t to support SCIOPTA 16 Bit systems (NEAR pointer).
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» Manual now splitted into a User’s Guide and Reference Manual.

17.8.5 Manual Version 1.4

» Chapter 4.7.3.2 Example, OS_INT_PROCESS changed into correct SC_INT_PROCESS.
» Chapter 2.3.4.4 Init Process, rewritten.

» Chapter 4.5 Processes, former chapters 4.5.6 Idle Process and 4.5.7 Supervisor Process removed.
e Chapter 4.5.1 Introduction, last paragraph about supervisor processes added.

e Chapter 4.5.5 Init Process, rewritten.

» Chapter 6.8 sc_miscErrorHookRegister, syntax corrected.

» Chapter 6.21 sc_mscAlloc, time-out parameter tmo better specified.

» Chapter 6.27 sc_msgRx, time-out parameter tmo better specified.

» Chapter 4.10.4 Error Hook Declaration Syntax, user =0 user error.

e Chapter 4.9 SCIOPTA Daemons, moved from chapter 2.9 and rewritten.

e Chapter 6.41 sc_procDaemonRegister, last paragraph of the description rewritten.

e Chapters 6.45 sc_procintCreate, 6.46 sc_procKill, 6.51 sc_procPrioCreate, 6.60 sc_procTimCreate and 6.62
sc_procUsrIntCreate, information about sc_kerneld are given.

» Chapter 4.10.5 Example, added.

17.8.6 Manual Version 1.3

» Chapter 6.26 sc_msgPoolldGet, return value SC_DEFAULT_POOL defined.

e Chapter 6.33 sc_poolCreate, pool size formula added.

e Chapter 2.4.4 Message Pool, maximum number of pools for compact kernel added.
e Chapter 4.8 SCIOPTA Memory Manager - Message Pools, added.

» Chapter 6.9 sc_moduleCreate, modul size calculation modified.

» Chapter 6.40 sc_procCreate, 6.45 sc_procIntCreate, 6.51 sc_procPrioCreate and 6.60 sc_procTim Create,
stacksize calculation modified.

17.8.7 Manual Version 1.2

e Top cover back side: Address of SCIOPTA France added.
» Chapter 2.6 Trigger, second paragraph: At process creation the value of the trigger is initialized to one.

» Chapter 2.6 Trigger, third paragraph: The sc_triggerWait() call decrements the value of the trigger and the
calling process will be blocked and swapped out if the value gets negative or equal zero.

» Chapter 2.7 Process Variables, second paragraph: The tag and the process variable have a fixed size large
enough to hold a pointer.

» Chapter 2.7 Process Variables, third paragraph: Last sentence rewritten.
» Chapter 4.5.3.1 Interrupt Process Declaration Syntax, irg_src is of type int added.
e Chapter 4.5.6 Idle Process, added.
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* Chapter 4.10.4 Error Hook Declaration Syntax, Parameter user : user 1= 0 (User error).

» System call sc_procRegisterDaemon changed to sc_DaemonRegister and sc_procUnregisterDaemon
changed to sc_procDaemonUnregister.

» System call sc_miscErrorHookRegister, return values better specified.

« System call sc_moduleCreate, parameter size value “code” added in Formula.

e System call sc_moduleNameGet, return value NULL added.

» System call sc_msgAcquire, condition modified.

» System Call sc_msgAlloc, SC_ DEFAULT_POOL better specified.

» Systme Call sc_msgHookRegister, description modified and return value better specified.
» System call sc_msgRx, parameters better specified.

» System call sc_poolHookRegister, return value better specified.

« System call sc_procHookRegister, return value better specified.

« System call sc_procldGet, last paragraph in Description added.

« System calls sc_procVarDel, sc_procVarGet and procVarSet, return value !=0 introduced.
» Chapter 7.3 Function Codes, errors 0x38 to 0x3d added.

» System call sc_procUnobserve added.

e Chapters 2.5.2 System Module and 4.3 Modules, the following sentence was removed: The system module runs
always on supervisor level and has all access rights.

« Chapter 2.5.3 Messages and Modules, third paragraph rewritten.
« Chapter 6.31 sc_msgTX, fifth paragraph rewritten.

17.8.8 Manual Version 1.1

» System call sc_modulelnfo has now a return parameter.

* New system call sc_procPathGet.

» System call sc_moduleCreate formula to calculate the size of the module (parameter size) added.
e Chapter 4.12 SCIOPTA Design Rules, moved at the end of chapter “System Design”.

« New chapter 4.6 Addressing Processes.

e Chapter 7 Kernel Error Codes, new sequence of sub chapters. Smaller font used.

» Chapter 4.10 Error Hook, completely rewritten.

* New chapter 4.11 System Start.

17.8.9 Manual Version 1.0

Initial version.
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17.9 Former SCIOPTA - Kernel, Reference Manual Versions

17.9.1 Manual Version 1.7

» Back front page, Litronic AG became SCIOPTA Systems AG.

» Chapter 3.24 sc_msgHookRegister, text: There can be one module message hook per module replaced by:
There can be one module message hook of each type (transmitt/receive) per module.

e Chapter 3.27 sc_msgRYX, flag parameter SC_MSGRX_NOT : text: An array of messages is given which will
be excluded from receive replaced by: An array of message ID’s is given which will be excluded from receive.

» Chapter 3.47 sc_procNameGet and chapter 3.49 sc_procPathGet, chapter “Return Value” rewritten.

17.9.2 Manual Version 1.6

» Chapter 3.27 sc_msgRx, tmo parameter, SC_TMO_NONE replaced by SC_NO_TMO. Parameter better spec-
ified.

» Chapter 3.27 sc_msgRx, wanted parameter, NULL replaced by SC_MSGRX_ALL.

e Chapter 3.7 sc_miscError, err parameter, bits 0, 1 and 2 documented.

e Chapter 3.44 sc_procldGet, if paramter path is NULL and parameter tmo is SC_NO_TMO this system call
returns the callers process ID.

17.9.3 Manual Version 1.5

» All union sc_msg * changed to sc_msg_t to support SCIOPTA 16 Bit systems (NEAR pointer).

» All union sc_msg ** changed to sc_msgptr_t to support SCIOPTA 16 Bit systems (NEAR pointer).
» Chapter 6, System Call Reference, page layout for all system calls modified.

» Chapter 6.81 sc_triggerWait, third paragraph rewritten.

e Chapters 6.9 sc_moduleCreate and 6.17 sc_moduleKill, information about sc_kerneld are given.

» Chapter 6.44 sc_procldGet, added text: this parameter is not allowed if asynchronous timeout is disabled at
system configuration (sconf).

» Manual split into a User’s Guide and a Reference Manual.

17.9.4 Manual Version 1.4

» Chapter 4.7.3.2 Example, OS_INT_PROCESS changed into correct SC_INT_PROCESS.

e Chapter 2.3.4.4 Init Process, rewritten.

» Chapter 4.5 Processes, former chapters 4.5.6 Idle Process and 4.5.7 Supervisor Process removed.
» Chapter 4.5.1 Introduction, last paragraph about supervisor processes added.

» Chapter 4.5.5 Init Process, rewritten.

» Chapter 6.8 sc_miscErrorHookRegister, syntax corrected.

» Chapter 6.21 sc_mscAlloc, time-out parameter tmo better specified.

e Chapter 6.27 sc_msgRx, time-out parameter tmo better specified.
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» Chapter 4.10.4 Error Hook Declaration Syntax, user !=0 user error.
» Chapter 4.9 SCIOPTA Daemons, moved from chapter 2.9 and rewritten.
» Chapter 6.41 sc_procDaemonRegister, last paragraph of the description rewritten.

« Chapters 6.45 sc_procintCreate, 6.46 sc_procKill, 6.51 sc_procPrioCreate, 6.60 sc_procTimCreate and 6.62
sc_procUsrIntCreate, information about sc_kerneld are given.

e Chapter 4.10.5 Example, added.

17.9.5 Manual Version 1.3

e Chapter 6.26 sc_msgPoolldGet, return value SC_DEFAULT_POOL defined.

» Chapter 6.33 sc_poolCreate, pool size formula added.

» Chapter 2.4.4 Message Pool, maximum number of pools for compact kernel added.
e Chapter 4.8 SCIOPTA Memory Manager - Message Pools, added.

e Chapter 6.9 sc_moduleCreate, modul size calculation modified.

« Chapter 6.40 sc_procCreate, 6.45 sc_procIntCreate, 6.51 sc_procPrioCreate and 6.60 sc_procTim Create,
stacksize calculation modified.

17.9.6 Manual Version 1.2

» Top cover back side: Address of SCIOPTA France added.
» Chapter 2.6 Trigger, second paragraph: At process creation the value of the trigger is initialized to one.

» Chapter 2.6 Trigger, third paragraph: The sc_triggerWait() call decrements the value of the trigger and the
calling process will be blocked and swapped out if the value gets negative or equal zero.

« Chapter 2.7 Process Variables, second paragraph: The tag and the process variable have a fixed size large
enough to hold a pointer.

» Chapter 2.7 Process Variables, third paragraph: Last sentence rewritten.

» Chapter 4.5.3.1 Interrupt Process Declaration Syntax, irg_src is of type int added.

» Chapter 4.5.6 Idle Process, added.

e Chapter 4.10.4 Error Hook Declaration Syntax, Parameter user : user 1= 0 (User error).

» System call sc_procRegisterDaemon changed to sc_DaemonRegister and sc_procUnregisterDaemon
changed to sc_procDaemonUnregister.

« System call sc_miscErrorHookRegister, return values better specified.

» System call sc_moduleCreate, parameter size value “code” added in Formula.

« System call sc_moduleNameGet, return value NULL added.

» System call sc_msgAcquire, condition modified.

» System Call sc_msgAlloc, SC_DEFAULT_POOL better specified.

» Systme Call sc_msgHookRegister, description modified and return value better specified.
e System call sc_msgRx, parameters better specified.

« System call sc_poolHookRegister, return value better specified.
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» System call sc_procHookRegister, return value better specified.

» System call sc_procldGet, last paragraph in Description added.

» System calls sc_procVarDel, sc_procVarGet and procVarSet, return value !=0 introduced.
» Chapter 7.3 Function Codes, errors 0x38 to 0x3d added.

» System call sc_procUnobserve added.

e Chapters 2.5.2 System Module and 4.3 Modules, the following sentence was removed: The system module runs
always on supervisor level and has all access rights.

» Chapter 2.5.3 Messages and Modules, third paragraph rewritten.
» Chapter 6.31 sc_msgTx, fifth paragraph rewritten.

17.9.7 Manual Version 1.1

» System call sc_modulelnfo has now a return parameter.

* New system call sc_procPathGet.

» System call sc_moduleCreate formula to calculate the size of the module (parameter size) added.
e Chapter 4.12 SCIOPTA Design Rules, moved at the end of chapter “System Design”.

* New chapter 4.6 Addressing Processes.

» Chapter 7 Kernel Error Codes, new sequence of sub chapters. Smaller font used.

» Chapter 4.10 Error Hook, completely rewritten.

* New chapter 4.11 System Start.

17.9.8 Manual Version 1.0

Initial version.

17.10 Former SCIOPTA ARM - Target Manual Versions

17.10.1 Manual Version 2.2

» Back front page, Litronic AG became SCIOPTA Systems AG.
» Chapter 2.2 The SCIOPTA ARM Delivery and chapter 2.4.1 Main Installation Window, tiny kernel added.
» Chapter 3 Getting Started, in the example folder, additional directories for boards have been introduced.

» Chapter 3 Getting Started, the Eclipse project files and the file copy_files.bat are now stored in the
“\phyCore2294” board sub-directory of the example folder.

e Chapter 3 Getting Started, the SCIOPTA SCONF configuration file is now called hello.xml (was
hello_phyCore2294.xml before).

» Chapter 5.8.3 Assembling with IAR Systems Embedded Workbench, added.
» Chapter 5.10.3 Compiling with IAR Systems Embedded Workbench, added.
» Chapter 5.12.3 Linking with IAR Systems Embedded Workbench, added.
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» Chapter 5.13.1.1 Memory Regions, last paragraph added.

» Chapter 5.13.1.2 Module Sizes, name is now <module_name>_size (was <module_name>_free before).
» Chapter 5.13.3 IAR Systems Embedded Workbench Linker Script, added.

e Chapter 5.14 Data Memory Map, redesigned and now one memory map for all environments.

e Chapter 5.14.4 1AR Systems Embedded Workbench®©, added.

» Chapter 6 Board Support Packages, file lists modified for SCIOPTA ARM version 1.7.2.5

e Chapter 6.3 ATMEL AT96SAM7S-EK Board, added.

e Chapter 6.4 ATMEL AT96SAM7X-EK Board, added.

» Chapter 6.5 IAR Systems STR711-SK Board, added.

17.10.2 Manual Version 2.1

e Chapter 1.1 About this Manual, SCIOPTA product list updated.

e Chapter 2.4.1 Main Installation Window, Third Party Products, new version for GNU Tool Chain (version 1.4)
and MSys Build Shell (version 1.0.10).

e Chapter 2.4.7 GNU Tool Chain Installation, new GCC Installation version 1.4 including new gcc version 3.4.4,
new binutils version 2.16.1 and new newlib version 1.13.1. The installer creates now two directories (and not
three).

e Chapter 2.4.8 MSY'S Build Shell, new version 1.0.10.

» Chapter 3, Getting Started: Equipment, new versions for GNU GCC and MSys.

» Chapter 3, Getting Started: List of copied files (after executed copy_files.bat) removed.
e Chapter 3.5.1 Description (Web Server), paragraph rewritten.

e Chapter 3.13.2.1 Equipment, serial cable connection correctly described.

» Chapter 3.13.2.2 Step-By-Step Tutorial, DRUID and DRUID server setup rewritten.

» Chapter 5.16 Integrated Development Environments, new chapter.

17.10.3 Manual Version 2.0

¢ Manual rewritten.

¢ Own manual version, moved to version 2.0

17.10.4 Manual Version 1.7.2

 Installation: all IPS Applications such as Web Server, TFTP etc. in one product.
» Getting started now for all products.

» Chapter 4, Configuration now moved into Kernel User’s Guide.

* New BSP added: Phytec phyCORE-LPC2294.

¢ Uninstallation now separately for every SCIOPTA product.

« Eclipse included in the SCIOPTA delivery.
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» New process SCP_proxy introduced in Getting Started - DHCP Client Example.
» IPS libraries now in three verisons (standard, small and full).

17.10.5 Manual Version 1.7.0

« All union sc_msg * changed to sc_msg_t to support SCIOPTA 16 Bit systems (NEAR pointer).

e All union sc_msg ** changed to sc_msgptr_t to support SCIOPTA 16 Bit systems (NEAR pointer).
e Allsdd_obj_t* changed to sdd_obj t NEARPTR to support SCIOPTA 16 Bit systems.

e Allsdd_netbuf_t * changed to sdd_netbuf t NEARPTR to support SCIOPTA 16 Bit systems.

» All sdd_objInfo_t * changed to sdd_objIinfo_t NEARPTR to support SCIOPTA 16 Bit systems.
» Allips_dev_t * changed to ips_dev_t NEARPTR to support SCIOPTA 16 Bit systems.

* Allipv4_arp_t* changed to ipv4_arp_t NEARPTR to support SCIOPTA 16 Bit systems.

« Allipv4_route_t * changed to ipv4_route_t NEARPTR to support SCIOPTA 16 Bit systems.

* |AR support added in the kernel.

*  Web server modifiied.

o TFTP server added (in addition to client).

» DHCP server added (in addition to client).

» DRUID System Level Debugger added.
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